Origin User Guide
# Table of Contents

1 Introduction...........................................................................................................1

2 Installing and Updating Origin ............................................................................3
   2.1 Notes for Upgrade Users ..................................................................................3
   2.2 Notes for Administrators of Multi-user Packages .........................................3
   2.3 Installing Origin ..............................................................................................3
   2.4 Selecting a User Files Folder ..........................................................................4
   2.5 Licensing Origin .............................................................................................5
   2.6 Registering Origin .........................................................................................5
   2.7 Maintenance ....................................................................................................6
   2.8 Updating your Current Version ....................................................................6
   2.9 Upgrading you Origin Version .....................................................................6
   2.10 Setting the Origin Display Language ..........................................................6
   2.11 System Transfers - Deactivating a License ...............................................7
   2.12 Uninstalling Origin .....................................................................................7

3 Origin Resources ..................................................................................................9
   3.1 Direct Support Resources for Origin ............................................................9
   3.2 Resources Installed with your Origin Software .............................................10
   3.3 Online Resources for Origin ........................................................................11

4 OriginPro .............................................................................................................13

5 What's New in 2016 ...............................................................................................17
   5.1 Ease of Use Features .....................................................................................17
   5.2 Graphing and Graph Customization ............................................................18
   5.3 Analysis .........................................................................................................19
   5.4 Statistics ........................................................................................................19
   5.5 Import and Export .........................................................................................19
   5.6 Batch Processing ...........................................................................................19
   5.7 Programming .................................................................................................20
   5.8 Apps for 2016 ...............................................................................................20

6 The Origin Interface ..............................................................................................21
   6.1 The Origin Workspace ..................................................................................21
   6.2 Numbers in Origin ........................................................................................32
   6.3 Topics for Further Reading .........................................................................34

7 Origin File Types ..................................................................................................35
   7.1 Roundup of Origin File Types .....................................................................35
   7.2 Topics for Further Reading .........................................................................36

8 Import Data ............................................................................................................37
   8.1 ASCII Import .................................................................................................38
   8.2 CSV Import ...................................................................................................40
   8.3 Binary Import ...............................................................................................40
### 8.4 Copy/Paste and Clipboard Data

8.5 Excel

8.6 Third Party Formats

8.7 Database

8.8 Digitizer

8.9 Re-Importing Data Files

8.10 Topics for Further Reading

---

### 9 Workbooks Worksheets Columns

9.1 Workbook, Worksheet and Column Basics

9.2 Workbook Templates

9.3 Simple Utilities for Filling Columns with Data

9.4 Setting Column Values

9.5 Processing Worksheet Data

9.6 Topics for Further Reading

---

### 10 Matrix Book Matrix Sheet Matrix Objects

10.1 Matrix Books, Matrix Sheets and Matrix Objects

10.2 Virtual Matrix

10.3 Matrix Templates

10.4 Simple Manipulation of Matrix Data

10.5 Setting Matrix Values

10.6 Converting Worksheets to Matrixes

10.7 Converting Matrixes to Worksheets

10.8 Profiling Matrix Data

10.9 Topics for Further Reading

---

### 11 Graphing

11.1 Creating a Graph

11.2 Plotting without Using Column Plot Designations

11.3 Manipulating Data Plots

11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and Printing

11.5 Origin Graph Types

11.6 Topics for Further Reading

---

### 12 Customizing Graphs

12.1 Introduction

12.2 Toolbars

12.3 Menus and Dialog Boxes

12.4 Customizing Page, Layer and Data Plots

12.5 Customizing Graph Axes

12.6 Graph Legends

12.7 Annotating Your Graph

12.8 Arranging Graphs and Layers

12.9 Templates and Themes

12.10 Topics for Further Reading
13 Graphical Exploration of Data ................................................................. 139
13.1 Zooming, Panning and Rescaling ......................................................... 140
13.2 Reading Coordinate Values .................................................................. 142
13.3 The Data Info Window ........................................................................... 143
13.4 The Data Reader Tool ........................................................................... 144
13.5 The Annotation Tool ............................................................................. 145
13.6 The Data Cursor Tool ........................................................................... 146
13.7 Gadgets ................................................................................................. 148
13.8 Topics for Further Reading .................................................................. 151
14 Gadgets ................................................................................................... 153
14.1 Origin Gadgets ...................................................................................... 153
14.2 Topics for Further Reading .................................................................. 157
15 Data Analysis ............................................................................................ 159
15.1 Introduction ........................................................................................... 159
15.2 Selecting Data ....................................................................................... 159
15.3 Data Masking ......................................................................................... 168
15.4 Drawing or Moving, or Deleting Data Points in the Graph .................. 170
15.5 Mathematics ......................................................................................... 171
15.6 Curve Fitting ......................................................................................... 173
15.7 Peak Analysis ......................................................................................... 176
15.8 Signal Processing ................................................................................. 177
15.9 Image Processing ................................................................................... 180
15.10 Topics for Further Reading ................................................................. 180
16 Statistics ................................................................................................... 181
16.1 Basic Statistics ...................................................................................... 181
16.2 Statistical Graphs ................................................................................... 184
16.3 Comparing One, Two or More Groups ............................................... 185
16.4 Advanced Statistics ............................................................................. 187
16.5 Topics for Further Reading ................................................................. 189
17 How to Handle Repetitive Tasks ............................................................... 191
17.1 Recalculation ......................................................................................... 191
17.2 Dialog Themes ...................................................................................... 192
17.3 Project and Workbook Templates ....................................................... 194
17.4 Batch Plotting ....................................................................................... 195
17.5 Batch Analysis ...................................................................................... 197
17.6 Repeating Analysis on Other Datasets or Data Plots ......................... 201
17.7 Repeating Analysis Using Data Filters ................................................. 201
17.8 Automating Tasks Using Programming .............................................. 203
17.9 Topics for Further Reading ................................................................. 203
18 Publishing and Export ............................................................................. 205
18.1 Copying and Pasting Graphs to Other Applications ............................ 205
18.2 Organizing Your Graphs for Presentation or Export ......................... 206
Origin User Guide

18.3  Exporting Graphs and Layout Pages to an Image File ............................................. 206
18.4  Sending Graphs to PowerPoint .............................................................................. 207
18.5  Slide Show of Graphs ........................................................................................... 208
18.6  Creating Movies ...................................................................................................... 208
18.7  Exporting Worksheets and Matrices ....................................................................... 209
18.8  Topics for Further Reading ..................................................................................... 210

19 Programming in Origin .............................................................................................. 211
19.1  LabTalk .................................................................................................................... 212
19.2  Python ...................................................................................................................... 213
19.3  R .............................................................................................................................. 213
19.4  Origin C ................................................................................................................... 214
19.5  X-Function ............................................................................................................. 214
19.6  Automation Server ................................................................................................. 215
19.7  LabVIEW ................................................................................................................ 215
19.8  Orglab ..................................................................................................................... 216

20 Customizing Origin .................................................................................................... 217
20.1  Customizing Default Settings ................................................................................ 217
20.2  Customizing Menus ............................................................................................... 219
20.3  Customizing Toolbars and Buttons ....................................................................... 220
20.4  Customizing the Status Bar .................................................................................. 221
20.5  Customizing the Origin Workspace ..................................................................... 221
20.6  Templates and Themes ......................................................................................... 222
20.7  Topics for Further Reading ................................................................................... 226

21 Sharing Origin Files .................................................................................................. 227
21.1  Drag and Drop Sharing ......................................................................................... 227
21.2  Sharing Files on Multiple Machines for Single Users ............................................. 228
21.3  Sharing Files with Other Users in a Network ......................................................... 228
21.4  Packaging Files ...................................................................................................... 228
21.5  The Origin Viewer ................................................................................................ 229
21.6  Topics for Further Reading ................................................................................... 229

22 Origin Toolbars ........................................................................................................ 231
22.1  Standard ................................................................................................................ 231
22.2  Edit ......................................................................................................................... 232
22.3  Graph ...................................................................................................................... 233
22.4  2D Graph ............................................................................................................... 233
22.5  Add Object to Graph ............................................................................................ 237
22.6  3D and Contour Graph ......................................................................................... 237
22.7  3D Rotation ............................................................................................................ 239
22.8  Worksheet Data ..................................................................................................... 239
22.9  Column ................................................................................................................... 240
22.10 Layout ................................................................................................................... 241
22.11 Mask ..................................................................................................................... 241
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.12</td>
<td>Tools</td>
<td>241</td>
</tr>
<tr>
<td>22.13</td>
<td>Object Edit</td>
<td>243</td>
</tr>
<tr>
<td>22.14</td>
<td>Arrow</td>
<td>244</td>
</tr>
<tr>
<td>22.15</td>
<td>Style</td>
<td>244</td>
</tr>
<tr>
<td>22.16</td>
<td>Format</td>
<td>245</td>
</tr>
<tr>
<td>22.17</td>
<td>Auto Update</td>
<td>246</td>
</tr>
<tr>
<td>22.18</td>
<td>Database Access</td>
<td>246</td>
</tr>
<tr>
<td>22.19</td>
<td>Markers &amp; Locks</td>
<td>247</td>
</tr>
<tr>
<td>23</td>
<td>Index</td>
<td>249</td>
</tr>
</tbody>
</table>
1 Introduction

Welcome, and thank you for using Origin!

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists and engineers. What sets Origin apart from other applications is the ease with which you can customize and automate your data import, analysis, graphing and reporting tasks.

Customizations can range from simple modifications to a data plot, saved as a graph “template” for later use, to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple files or datasets.

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your findings. And to help you get the most from Origin, we offer first-class customer and technical support, training and consulting services.

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing and Image Handling.

The purpose of this guide is to introduce you to Origin. We hope that new users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or two about Origin that you had overlooked previously.

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main menu) and numerous other learning resources exist. For a complete listing of available resources, see the Origin Resources chapter of this guide.

A couple of things to look for in this guide:

- We have added short tutorials to numerous topics throughout this guide. These short tutorials are intended to give you a quick introduction to a key Origin feature. To locate these, look for this icon:

- Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are marked with this icon:

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter of this guide.
2 Installing and Updating Origin

2.1 Notes for Upgrade Users

The Origin upgrade installs into a new program folder - it does not update a previous version. It is therefore not necessary to have a previous version of Origin installed prior to upgrading.

Origin license management is version-specific. Thus, after installing the upgrade, you must complete the license management process. A license dialog will display when your upgrade is launched for the first time, and this dialog will step you through the license process.

Origin project files (OPJ files) created in earlier versions of Origin can be opened, updated, and saved in Origin 2015. We do not recommend, however, opening and working with Origin 2015 project files in earlier versions of Origin, as you may suffer some loss of information or data that is specific to the new version. For more information, see the Support area of the OriginLab website (originlab.com/Support).

If you have custom Origin files from your previous version, such as graph templates, themes, fitting functions, LabTalk Script, or Origin C files, you can transfer them to your Origin 2015 User Files Folder. From the Tools menu, select Transfer User Files.

Lastly, we want to point out that Origin 2015 has some great new features. For more information on key features by version, see the originlab.com/VersionComparison page on our website.

2.2 Notes for Administrators of Multi-user Packages

Instructions for getting started with the multi-seat node-locked and concurrent network packages are available on the OriginLab website (originlab.com/GetStarted).

In addition to the script-based Origin installer that runs from the DVD startup program, an MSI installer and sample transform are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin installation package for distribution. Further information on the MSI installer and other deployment techniques are provided on the GetStarted web page.

2.3 Installing Origin

Origin is a Windows application. You can run Origin on an Intel-based Mac if you have installed virtualization software and set up a virtual computer running Microsoft Windows. For more information, see the Run Origin on a Mac page on the OriginLab website (originlab.com/HelpCenter).

There are three steps that must be completed to prepare Origin for use:

- Installation
- Selecting a User Files Folder
- License management
Both the Origin upgrade and the full product install into a new program folder. Origin does not overwrite previous versions when upgrading, so your original version does not have to be installed when running the upgrade.

The startup program that launches when you insert the Origin DVD includes an Origin installation button. If the startup program does not automatically run, you can browse the DVD to launch the startup program (or the installer).

2.3.1 Installing on a 64-bit Computer

When installing on a 64-bit computer, you have the option to install 32-bit or 64-bit Origin, or both. The 64-bit version has much more memory at its disposal, so it is useful for large data sets. See the Support area of the OriginLab website (originlab.com/Support) for more information about 32-bit versus 64-bit installations.

If you install 32-bit only (or 64-bit only), and you later want to install 64-bit (or 32-bit), run the Origin Add or Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option.

2.3.2 How to Proceed if You Already Have the Origin Evaluation Installed

If you already have the evaluation version of Origin installed on your computer, you can convert it to the full product or upgrade. To do this, run the Origin Add or Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option and then select Install Product (requires serial number).

2.3.3 How to Correct or Change your Serial Number After you Complete an Installation

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option and then click Yes to change your serial number.

2.4 Selecting a User Files Folder

After installing Origin, each Windows login user must select a User Files Folder (UFF) at the first Origin startup. The UFF is the default location for saving and opening files for that login user.

Consider these points in selecting your UFF:

- If you have a mobile computer, it is best to select a location on your computer rather than on your network.
- For non-mobile computers, you can select a location on the computer or on the network, as long as you have stable access to the folder.
- Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin users, please see the chapter on Sharing Origin Files, later in this Guide.
- If you upgraded from an earlier version of Origin, you must create a UFF with a different path from your previous installation's UFF. To transfer files from your previous installation's folder,
select the Tools menu and then select Transfer User Files. For more information, see Transfer User Files.

At each Origin startup, Origin will check that your UFF is accessible. If Origin can not connect to the UFF, you will be prompted to select a new folder at startup. Note that you can change your UFF when you are running Origin. From the Tools menu, select Options and then click the System Path tab.

2.5 Licensing Origin

All Origin packages include license management. The type of license management provided with your package is determined at the time of your Origin purchase.

2.5.1 Node-locked

Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website using a licensing "wizard" provided when you start Origin. This process requires a log in account with administrator permissions. Instructions are provided for computers with no internet access.

2.5.2 Concurrent Network

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains a license for this server from the OriginLab website, and then sets up a license service. The license service counts and restricts the number of Origin computers that can run concurrently. For more information, see the Help Center on the OriginLab website (originlab.com/HelpCenter).

2.5.3 Dongle

A dongle (USB hardware key) is provided with the Origin package and must be present in the computer’s USB port to run Origin. Dongles are version-specific. The dongle license is installed by Origin.

2.6 Registering Origin

Although registration is optional, it is recommended. Registering Origin is a prerequisite for Origin support from OriginLab and the team of Origin distributors. Registration also activates Origin’s Check for Updates command (available in the Help menu). Check for Updates allows you to check if patches or updated Help files are available for your Origin install, and to obtain those updates.

If you have an Origin package with node-locked license management, your Origin install is automatically registered when you successfully complete the licensing process. To verify this, select About Origin from the Help menu. The About Origin dialog will display the Registration ID assigned to your Origin.

For all other license management packages, a Registration dialog box displays when starting a licensed, but unregistered, Origin installation. Use the Registration dialog to register your Origin installation on the Origin website. During this process, a Registration ID is issued. Enter, or copy and
paste, this Registration ID into the Registration dialog to complete the process. The About Origin dialog will now display your Registration ID.

2.7 Maintenance

Most Origin packages are sold with the first year of maintenance included. Maintenance provides you with free Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting services, and a home use license.

- To check if your Origin package includes maintenance, select the Help menu and then select About Origin. If your package includes maintenance, the About Origin dialog will show your maintenance expiration date.
- To learn about the benefits of your maintenance, contact OriginLab or your local Origin distributor.
- As your maintenance expiration date approaches, Origin will display a maintenance expiration message with a link to the OriginLab website to learn how to renew your maintenance. This reminder message provides a check box to prevent showing in the future.

2.8 Updating your Current Version

Within an Origin version, OriginLab publishes free updates service releases (patches). A service release provides bug fixes and feature improvements for the current version. All customers are encouraged to apply the service releases. To check if a patch is available, select the Check for Updates command from the Help menu. Patches are also available from the Support area of the OriginLab website (originlab.com/Support).

2.9 Upgrading you Origin Version

OriginLab publishes a new version of Origin each year, providing features and improvements based on customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin version. After a new version release, OriginLab and the team of Origin distributors notify maintenance customers by email. However, to make sure you receive notification of a new version release, please join the OriginLab website (originlab.com) if you do not already have an account, and select the check box in your user profile to receive "product updates".

2.10 Setting the Origin Display Language

Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland, Austria, and Liechtenstein, may support running Origin with English display, or with Japanese or German display. To access this language control, select Change Language from the Help menu.
2.11 System Transfers - Deactivating a License

2.11.1 Node-locked Licenses (Computer ID-based)

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

- If Origin can still be used on your computer:

Right-click on the Origin program icon and select Run As Administrator to open Origin. And then select **Deactivate License** from the **Help** menu. After successful deactivation, your Computer ID will be removed from OriginLab’s server so that you can install and activate on another computer.

- If your licensed Origin computer is no longer available:

Complete the "System Transfer Request Form" available from the Support area of the OriginLab website. System Transfer

2.11.2 Concurrent Networks

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not required when replacing an Origin computer.

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available from the Support area of the OriginLab website.

2.11.3 Dongles

A system transfer is not required when replacing a dongle-managed Origin computer.

2.12 Uninstalling Origin

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder, or use the Windows **Uninstall or change a program** tool. In both cases, the Origin Setup program displays providing options to **Modify**, **Remove**, or **Repair**. Select the **Remove** option and complete the wizard as prompted.

The Remove program deletes all folders and files that were installed by the Origin setup program. It also deletes folders and keys created by the installer in the Windows registry.
### 3 Origin Resources

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor, your Origin distributor may provide additional resources. Please contact your distributor to learn more.

#### 3.1 Direct Support Resources for Origin

<table>
<thead>
<tr>
<th>Direct Support</th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
</table>
| Technical Support | • Phone or email OriginLab  
                        | • Report a bug  
                        | • Suggest a feature | [originlab.com/Support](http://originlab.com/Support) |
| Chat Online     | • Chat online with an OriginLab representative | [originlab.com](http://originlab.com)  
                        | ...and click the *Live Chat* icon floating on the right |
| User Forum      | • Share information with and get help from the Origin user community | [originlab.com/Forum](http://originlab.com/Forum) |
| Training and Consulting | • Making optimal use of OriginLab products  
                        | • Help in developing custom tools for your particular application | [originlab.com/Support](http://originlab.com/Support) |
# 3.2 Resources Installed with your Origin Software

<table>
<thead>
<tr>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Help Files</strong></td>
<td></td>
</tr>
<tr>
<td>- Latest version of the Origin Help Files</td>
<td>Help: Check for Updates</td>
</tr>
<tr>
<td><strong>Context-sensitive Help</strong></td>
<td></td>
</tr>
<tr>
<td>- Control-by-control explanation of Origin dialog boxes</td>
<td>Press F1</td>
</tr>
<tr>
<td>- The dialog box must be open</td>
<td>or</td>
</tr>
<tr>
<td>- Some dialogs have multiple sections/tabs and you may have to click on that section/tab to set the focus</td>
<td>Click ? in the upper-right corner of the dialog box</td>
</tr>
<tr>
<td><strong>Quick Help</strong></td>
<td></td>
</tr>
<tr>
<td>- Problems or questions that arise while using Origin</td>
<td>View: Quick Help</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>Help: Origin: Quick Help</td>
</tr>
<tr>
<td><strong>Sample Projects</strong></td>
<td></td>
</tr>
<tr>
<td>- Examples of 2D, 3D and statistical graph types, plus data import, data exploration, transformation, curve fitting and statistical analyses</td>
<td>File: Open Sample Projects</td>
</tr>
<tr>
<td><strong>Tutorials</strong></td>
<td></td>
</tr>
<tr>
<td>- Step-by-step instructions on performing many Origin operations, from the simple to the complex</td>
<td>Help: Origin : Tutorials</td>
</tr>
</tbody>
</table>
# 3.3 Online Resources for Origin

<table>
<thead>
<tr>
<th></th>
<th>For Information On ...</th>
<th>Go Here</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Online Documentation</strong></td>
<td>• Product documentation</td>
<td>originlab.com/doc</td>
</tr>
<tr>
<td><strong>Help Center</strong></td>
<td>• Installation and License Documentation&lt;br/&gt;• FAQs&lt;br/&gt;• Video Tutorials&lt;br/&gt;• OriginLab User Support Archives&lt;br/&gt;• Newsletters</td>
<td>originlab.com/HelpCenter</td>
</tr>
<tr>
<td><strong>Video Tutorials</strong></td>
<td>• Help with a wide range of Origin’s key features</td>
<td>originlab.com/Videos</td>
</tr>
<tr>
<td><strong>Webinars</strong></td>
<td>• Live and recorded webinars highlighting key features</td>
<td>originlab.com/Webinars</td>
</tr>
<tr>
<td><strong>Origin Blog</strong></td>
<td>• Blog posts with plenty of software tips and tricks</td>
<td>blog.originlab.com</td>
</tr>
<tr>
<td><strong>Case Studies</strong></td>
<td>• How others are using Origin in their work</td>
<td>originlab.com/CaseStudies</td>
</tr>
<tr>
<td><strong>Graph Gallery</strong></td>
<td>• Outstanding examples of Origin graphs, many of them submitted by the Origin community</td>
<td>originlab.com/GraphGallery</td>
</tr>
</tbody>
</table>

Information on key Origin features often can be found by just doing a quick web search. Open a browser and search on phrases such as... "Origin shortcut keys", "LabTalk graph legend", or "OriginC NAG functions".
4 OriginPro

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis tools and capabilities.

If you don't know which product you have -- Origin or OriginPro -- look to the title bar.

If you have already purchased the standard version of Origin, you can upgrade to OriginPro by contacting your Origin representative.

4.1.1 Curve Fitting

In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the following:

- Linear fitting with X error.
- Nonlinear fitting with X and Y errors (orthogonal regression).
- Fitting with implicit functions (orthogonal distance regression).
- Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two datasets to one model.

For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.

4.1.2 Surface Fitting

With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.

- Fit worksheet data (XYZ) or matrix data (Z values).
- Locate and fit multiple peaks using one of several peak identification methods.
- Automatic peak parameter initialization.
- Apply constraints and bounds to parameters and fix parameter values.
- Output parameter and statistical results plus residual curves.
- Find specific Z values along the fit surface and include them in your output.
- Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use.
For more information on 3D Surface Fitting, see this webpage.

4.1.3 Peak Fitting

OriginPro includes the Peak Analyzer tool with support for the following:

- Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative).
- Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined, None).
- Fit Peaks with built-in or user-defined functions.
- Fit individual peaks with different fitting functions.
- Fit Baseline as part of the peak fitting process (user-defined or built-in functions).
- Control fit parameters (fix, share, set bounds).
- Batch peak analysis using a predefined Theme file.

For more information about peak fitting in OriginPro, see this web page.

4.1.4 Statistics

OriginPro includes support for advanced statistical analyses in these areas:

- Descriptive statistics (distribution fit, correlation coefficient).
- ANOVA (one-/two-way repeated measures).
- Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial least squares).
- Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival functions)
- Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-/two-sample proportion test).
- Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney, two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood’s median test, Friedman ANOVA, support for simultaneous tests).
- Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test, one-way ANOVA).
- ROC curve analysis.

For more information about the statistical tools available in OriginPro, see this web page.
4.1.5 **Signal Processing**

In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:

- Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT).
- Filtering (IIR filter design, 2D FFT filter).
- Correlation (2D correlation).
- Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D wavelet reconstruction).
- Rise-time Gadget (linear search, histogram, largest triangle).
- Decimation (moving average, finite impulse response).
- Coherence.
- Envelope curves (upper and/or lower, smooth during envelope detection).

For more information on signal processing in OriginPro, see [this web page](#).

4.1.6 **Gadgets**

Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:

- Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and deleting points).
- 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data).
- Rise-time Gadget (analyze rise/fall time of stepped signals).

For more information on these and other Gadgets, see [this web page](#).

4.1.7 **Image Processing**

Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional tools in the following areas:

- Image adjustments (function lookup table, leveling).
- Image conversion (dynamic binary, threshold, RGB merge/split, image scale).
- Spatial filters (user filter).
- Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological filter, pixel logic, replace background, subtract background, subtract interpolated background).
For more information on these and other image processing tools, see this page on our website.
5 What's New in 2016

5.1 Ease of Use Features

Object Manager

- Dockable Object Manager to easily show or hide plots on a graph. Read more ...

Smart Plotting with Cloneable Templates

- If a graph template is saved as cloneable, the user can easily plot similar graphs from a workbook or worksheet with the same data structure. Read more ...

Layer Contents Dialog Improvements

- The Layer Contents dialog used to work for one layer at a time. Now, the user can switch layers or even create new layers without leaving Layer Contents. Change plot order in a group with no need to first ungroup. Read more ...

Format Units Display for Axis Title

- Set a global unit display format such as (unit), [unit], or even customize it as you like on the Axis tab in the Tools: Options dialog. Read more ...

Improvements in the Insert Variables Dialog Box

- Insert Variables now includes a “hunt” button to interactively select worksheet cell(s) and insert cell contents into a graph annotation. Read more ...

- Easier way to label graph with project path, name and window name. Read more ...

Customize Annotation Tool Labels

- In addition to showing X & Y coordinates or row index, the Annotation tool can be customized to show plot source-column metadata, or even worksheet cell information. Read more ...

Define and Access Project Variables in Set Column Values

- Use Variables: Project Variables menu to easily access project variables and define more project variables. Read more ...

Edit: Select...

- Select columns with matching label or by skipping every N columns. Make it easy to plot or analyze patterned data. Read more ...
5.2 Graphing and Graph Customization

Exclude Weekends and Holidays when Plotting Financial Data
- Axis scale type is set as Discrete for stock plot types to skip weekend and holidays when no data exist. Read more ...

Text Label and Legend Improvements
- Multi-line Spacing. Legend Text Color Same as Plot. Read more ...
- Data labeling on Indiced Points Only and more Label Format controls. Read more ...

Contour Graph Improvements
- Show Color Scale as Separated color blocks and corresponding data range each represents. Set threshold so values smaller or bigger than threshold will be treated as missing values. Read more ...

Axis Related Improvements
- Show Additional Lines at non-zero position. This makes it very easy to plot column/bar plot from non-zero baseline. Read more ...
- Minor tick label display format. Read more ...

Multi-layer Graph Improvements
- Align layers at specified value Read more...
- Set multiple layer’s height or width with common scale unit. If one layer, the y axis range is from 0 to 20, while the other is from 0 to 10, the 1st layer will be twice as high as the 2nd. Read more ...
- Besides linking XY axis length to Scale (Isometric), support setting X:Y ratio. Read more ...

Other Graph Improvements
- Scatter Matrix: Upper/Lower triangular layer arrangement, show tick and label in alternate layer, customize all layers together. Read more ...
- Stack Columns: Incremental mode for stack column Read more ..., error bar support for 100% stack columns.
- Map line style and line width to another column. Read more ...
- Customize graph window Short/Long Name when save template and during Batch Plotting. Read more ...
- Show 2D/3D Symbol in 3D Waterfall, Wall and Ribbon plots
- More control of color-incrementing behavior in grouped plots.
- Find max/min of colormap levels for grouped plots.
5.3 Analysis

- GUI for Customization of Linear, Non-Linear and Peak Fit Report Tables on Graphs. Read more...
- Tab Style Dialog for Linear Fit and some Statistics Tools.
- Show Equation with Values after Non-linear Curve Fit. Read more...

5.4 Statistics

- Three-way ANOVA. Read more...
- Partial Correlation. Read more...
- Cross Tabulation. Read more...

Other Statistics Improvements

- Means comparison on interaction combinations in two-way ANOVA
- t-Test for summarized data

5.5 Import and Export

Send Graphs to PowerPoint Tool Improvements

- Origin used to send all graphs under a folder to Powerpoint. Now supports specifying what graphs to send, in what order, and which template to use. Read more...
- Import Data to Cloned Workbook/Sheet Read more...
- Script after Import Read more...
- Column Plot Designation for more Import Routines Read more...
- More 3rd Party Files Read more...

5.6 Batch Processing

- Support Word Template for Report Creation in Batch Processing. Read more...
- Script Before Each Process, Import Multiple Files to Sequential Worksheet, and Append Results by Columns in Batch Processing. Read more...
- PA Improvements to Save Better Themes for Batch PA Processing: Snap to Spectrum; Relative Baseline; Sequentially Initializing Parameter Values. Read more...
5.7 Programming

- Improvements to LabTalk Script Execution Speed
- R Language Support. [R Console](#) and [RServe Console](#). [Read more ...](#)

5.8 Apps for 2016

- Apps Gallery with extra tools for Origin 2016. To find out what is available, visit the [File Exchange area of originlab.com](#).
- **Maps Online.** This App fetches map images of a given longitude and latitude range from a WMS server. The map is then inserted as an image into the active graph layer. Multiple layers of maps can be combined and inserted.
- **Solve Ordinary Differential Equations.** Solve an ordinary differential equation or a system of first order differential equations, and provide a numeric solution in the given interval for specific initial conditions.
- ... and more.
6 The Origin Interface

6.1 The Origin Workspace

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim this chapter.

6.1.1 Origin Menus and Menu Commands

- **Context-sensitivity of menu bar and menus**: The menu bar and menu commands are context-sensitive; they change as you change window type (from worksheet to graph to matrix, for instance). Only menus pertinent to the active window will display.

- **Menu bitmaps, toolbar buttons and shortcut keys**: Some menu commands also have bitmaps that display to the left of the command. Additionally, you may see a shortcut key combination listed to the right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the same functionality.

- **Shortcut menu commands**: Many commands are available from shortcut menus. To open a shortcut menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent menu commands will show.

- **Collapsible menus**: By default, main and shortcut menus in Origin are "collapsed", meaning they display an abbreviated set of commands. When you use a menu item which isn't included, it is added to the menu.
- **Most frequently used analysis menu commands:** Most-recently used menu commands will appear at the bottom of the analysis menus (*Worksheet, Analysis, Statistics, Image*, etc.). This gives you quick access to tools when performing repeat operations.

- **Custom Menu Organizer:** Since Origin 8.1, Origin users have been able to use the Custom Menu Organizer to add or remove menu items. To learn more, see the chapter *Customizing Origin*, later in this Guide.

### 6.1.2 Origin Toolbars

Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize toolbars.

- **Customize toolbar button appearance:** Use controls on the Options tab of the Customize Toolbars dialog box to modify button and toolbar appearance.

- **Dock/Float a toolbar:** Toolbars can be undocked and made to float on the workspace. To float a toolbar, hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title bar.

- **Hide/Show a toolbar:** Clicking the Close button on a toolbar removes the toolbar from view. To restore a hidden toolbar, open the Customize Toolbars dialog box and select the toolbar.

- **Hide/Show a button:** Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a toolbar.

- **Move button location:** Alt+drag a button to move it to a new location within or among toolbars. Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window till X shows to remove a button.

### 6.1.3 Project Explorer

**Project Explorer (PE)** is a tool to help you organize the contents of your Origin project files (OPJ).
Project Explorer is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel shows folders and windows in the folder highlighted in the primary panel.

- Right-click the PE title bar to display the panels stacked (Vertical Alignment) or side-by-side (Horizontal Alignment).
- Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on what is selected or where you have right-clicked.
- Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your mouse).
- The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons, Extra Large Icons.
- In any view (except "Extra Large Icons"), mousing over a graph window icon shows a preview of the graph. Mousing over a matrix or worksheet window shows an optional PE comment:

![Graph Preview, Details View](image1)

![PE Comment, Details View](image2)

- When displaying windows as Extra Large Icons, the PE sub-panel displays a preview of graph and layout windows.

![Pink Border = Active Window](image3)

To disable PE previews, open the Script Window (Window: Script Window) and type one or both of the following, then highlight the text and press Enter:

```plaintext
@PESS=-1; //turn off graph preview in PE
@PESH=0; //turn off comments preview in PE
```

When you set the value of a system variable using the Script Window, you are altering Origin's behavior for the current session only. To set the value of a system variable across sessions, see this FAQ.
1. By default, Project Explorer is docked to the left side of the Origin workspace in auto-hide mode. Mouse over the **Project Explorer** tab to show the PE window.

![Project Explorer](image)

2. Click on the "push pin" icon on the PE title bar to pin the window in the docked position.

3. By default the sub-panel is in Details view. In this view, window metadata such as **Name**, **Size** and **Comments** show below these column headings. Right click the column header and check **Modified**. A new column shows. Now, drag column headers to reorder them.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Comments</th>
<th>Created</th>
<th>Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Surface with Point Label</td>
<td>212KB</td>
<td></td>
<td>8/22/2012 11:41</td>
<td>10/28/2013 11:42</td>
</tr>
<tr>
<td>MBook4</td>
<td>190KB</td>
<td>Matrix of Elevation Data</td>
<td>8/22/2012 11:40</td>
<td>3/16/2015 14:28</td>
</tr>
</tbody>
</table>


5. The project file will open with the root folder selected in primary panel of PE. The sub-panel shows folders and windows in the root folder. Also, in the Origin workspace, you can now see windows in the selected folder.

![Project Explorer](image)

6. In the primary panel, double-click the **3D Surface** folder to expand it and select the **Surface Plot from XYZ Data** folder. All windows in this folder now show in
the sub-panel and in the Origin workspace. Note that the window that is active in the workspace appears in bold type in the PE sub-panel.

7. Mouse over each window in the PE sub-panel. Different tooltips show for different window type: Graph windows show a preview of the graph; Notes windows show the contents of the note; Workbook windows show workbook comments.

8. Single-click the \texttt{XYZRandomGaus} window in the sub-panel and click in the corresponding cell in the \texttt{Comments} column. You can modify the comments by in-place edit. You can also right-click on a window or folder and choose \texttt{Properties...} to edit names and comments.

9. Double-click the \texttt{XYZRandomGaus} window in the sub-panel to make it the active window. Active window is bold in Project Explorer. Double-clicking an active window will hide it in the Origin workspace.

10. Right-click the \texttt{Surface Plot from XYZ Data} window in the sub-panel and choose \texttt{Duplicate}. A duplicate graph window is created.

11. Right-click on the \texttt{Surface Plot from XYZ Data} folder in the primary panel or right-click below the window list in the sub-panel and choose \texttt{New Folder} to create a new folder. Rename the folder \texttt{Graphs}. Select the two graph windows and drag them into the new \texttt{Graphs} folder.

12. Right-click the \texttt{Surface Plot from XYZ Data} folder in the primary panel and choose \texttt{Save as Project} to save the folder and windows under it as a project on your computer.

13. Choose \texttt{File: Recent Projects:} to load the saved OPJ file. The new project file is opened and PE displays the project's folder structure.

\subsection*{6.1.4 Apps Gallery}

\textbf{Apps} are custom applications forOrigin that perform specific graphing and/or analysis tasks. Apps are not pre-installed with Origin. Instead, Origin users can browse for Apps and download and install them from the \texttt{File Exchange} area of the OriginLab website. The \textbf{Apps Gallery} displays installed Apps and is docked to the right side of the workspace, by default.
To see which Apps are available for Origin, click **Tools: Apps on File Exchange** and select one of the Apps from the list (maximum of 15 are displayed).

To install an App, download it from the **File Exchange Website** and drop it onto the Origin workspace.

To see a list of installed Apps, open the **Apps Gallery** by clicking **View: Apps** (by default, the Gallery is docked to the right side of the workspace).

For more information on Apps, see the Origin Help File.

### 6.1.5 Object Manager

The **Object Manager** is a dockable panel that opens to the right side of the workspace, by default. Use the Object Manager for quick manipulation of graph layers and data plots in the active graph window:

- Select an element (layer, plot group, data plot or special point) in the Object Manager to select the corresponding element in the graph window and *vice versa.*
- Hide or show plot elements by clearing or selecting the corresponding check box in the Object Manager.
For additional actions, right-click on an element in the Object Manager panel and choose from the shortcut menu:

- Show or hide plots of the same Long Name.
- Reorder plots in a plot group.
- Toggle Edit Mode for grouped plots between Dependent and Independent
- Change plot type.
- Remove a plot from the graph window (not the same as hiding).
- Access the Plot Details, Layer Contents and Plot Setup dialog boxes.

6.1.6 Origin Child Windows

- **Origin Workbooks**: The Origin workbook provides a framework for importing, organizing, analyzing, transforming, and plotting your data. The tabbed workbook contains between 1 and 255 sheets. Each sheet may contain more than 1 million rows and up to 10,000 columns of data. Workbook windows may also store annotations, column-based functions, scripts and programmable button objects, LabTalk variables and import filters.

- **Origin Matrix Books**: Like the worksheet, a matrix sheet is a grid of cells, arranged in rows and columns. The primary difference is that in the worksheet, each column is a dataset and each dataset can be configured to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast, the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X) index numbers.

- **Graphs**: The graph window is the primary container for your data plots. Origin supports over 100 chart types, chosen specifically for their applications in various technical fields. Each chart is created using a built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data plots, the graph may also contain annotations (text and drawing objects) or button objects that, when triggered, perform some custom graphing or analysis task. Graph window can be inserted into cells or floating on sheet of Workbook window.
- **Function Graphs**: The function graph is a specialized graph window that displays a curve described by a function. The function graph differs from other Origin graphs in that there is not a dataset of discreet values associated with the plot.

- **Layout Pages**: The layout window allows you to combine and arrange graph and worksheet windows and various annotations onto a single “display panel.” It is used primarily for creating presentations.

- **Excel workbooks**: Excel workbooks can be opened or created in Origin. Workbooks can be saved separately or as part of your Origin project file.

- **Notes**: The Notes window is a text-only window used for recording analysis procedures, making notes to students and colleagues, and cutting and pasting text from other applications.

---

**Note**: For more information on Origin's child windows, see

- **Help**: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a Child Window

---

To save an Origin child window independently of the Origin project file:

- Select **File: Save Window As...** to save active window. File extension OGW, OGG, OGM are for Origin workbook, Graph and Matrix window respectively.

- Right click any window title bar and choose **Save as...** context menu.

**Note**: To save an Excel window as an external Excel file, right click the Excel window title in Origin and choose **Save Workbook as...** context menu.

---

To open a worksheet, graph, matrix, or notes window that was saved to a file:

- Select **File: Open** or click the **Open** button 📂 on the Standard toolbar to open window files.

- Select **File: Recent Books, File: Recent Graphs** to open recently saved workbook and graph window files.

**Note**: Origin supports window short name, long name and comments and short name must be unique in an Origin session. So your window short name will be renamed if such name has already been used. After opening a window file, if you then save the project, the window will become part of the current project.

---

To open an Excel workbook file:

1. Click **Open Excel** button in the **Standard** toolbar or select **File: Import: Excel (XLS, XLSX, XLSM)...** from the main menu.

**Note**: If you choose **Open Excel**, the Excel workbook is opened as an Excel workbook, in an Excel session that runs inside Origin. It can’t access all features of Origin. If you choose **Import Excel**, the Excel workbook is imported into Origin workbook so all Origin features are available.
6.1.7 The Command Window and Script Window

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped command history that can be carried over from session to session, and intellisense which provides auto-completion features when writing x-function command.

The Command Window is dockable and has two panels. The left-hand panel displays the command history, while the right-hand panel provides the command line.

The Script Window provides some of the same functionality as the Command Window. It lacks some of the Command Window’s features (no intellisense, no command prompt, no command history) but it is handy for issuing LabTalk commands and running Python scripts. The window’s Tools menu also opens the LabTalk Variables and Functions dialog box where you can view a list of Origin variables, functions, macros, loose datasets, etc.

To open the Command Window:


To open the Script Window:

1. Select Window: Script Window menu or press SHIFT+ALT+3.

6.1.8 The Status Bar

The Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:

- Help messages and tool descriptions.
- Statistics on the current workbook, matrix or graph selection.
- Whether the AutoUpdate analysis feature is turned on.
- The name of the System Theme, if any.
- Information pertinent to the active window.
- Angular unit (radians, degrees, or gradians).
- Tool tips for functions listed in the Set Values F(x) menu.

Note: You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items from the context menu. You can copy displayed statistical values by selecting Copy Statistics from the context menu. The copied data are TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.
Smart Hints and the Smart Hint Log

Smart Hints give the user focused advice, pertinent to the task at hand. It's triggered by actions you have done. These hints may appear briefly inside a dialog box, as in this example …

….. or, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.

Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking the "Do not show this message in the future" box.

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab, docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).

To open (and close) the Smart Hint Log window:

1. From the Origin menu, select View: Smart Hint Log or press ALT+7.

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you to confirm that you do not want to show or log this message.
To turn off all Smart Hint display in the session, open the Script Window and type the following:

\[ \text{@SHS} = 0; \]

To turn on Smart Hint display (including those were individually hidden), type \(@SHS = 1\), and click Help: Reactivate All Hints.

You can customize general properties of Smart Hints by setting system variables \(@SHG\) and \(@SHO\). See the system variable list for details.

When you set the value of a system variable using the Script Window, you are altering Origin's behavior for the current session only. To set the value of a system variable across sessions, see this FAQ.

### 6.1.10 Code Builder

Origin's programming language is called Origin C. Origin C's integrated development environment (IDE) is called Code Builder. Code Builder provides tools for writing, compiling, and debugging your Origin C functions. Origin C, IDE

To open Code Builder:


### 6.1.11 Quick Help

As the name implies, the Quick Help window is intended to provide help with specific Origin tasks. To open (and close) the Quick Help window:

1. From the Origin menu, select View: Quick Help or press ALT+5.

To use the Quick Help window, start typing in the Find box. Generally speaking, typing in a few keywords works best. Like several other Origin tools, the Quick Help window can be floated, docked or set to auto-hide.

### 6.1.12 Messages Log

The Messages Log window shows messages about operations including Output Information, Results and Errors. It displays messages that are not sent to the Script Window or the Command Window. To open (and close) the Messages Log window:

1. From the Origin menu, select View: Messages Log or press ALT+6.
6.1.13 Results Log

Origin automatically types many analysis and fitting results to the **Results Log**. Each entry in the Results Log includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see *Dates* below), the type of analysis performed, and the results.

In most cases, when results are reported to the **Results Log**, it opens automatically. Manually open (or close) the Results Log by doing one of the following:

1. Click the **Results Log** button on the Standard toolbar. Alternately, from the Origin menu, select **View: Results Log** or press ALT+2.

Right-click in the Results Log to open a shortcut menu with commands to **Copy**, **Print**, **Clear**..., and **View Results**.

6.1.14 Float, Dock and Auto-Hide Windows

There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows include **Project Explorer**, **Results Log**, **Command Window**, **Messages Log**, and **Quick Help**. This allows you to customize your Origin workspace so as to maximize utility and save screen space.

6.2 Numbers in Origin

- **Displayed vs. Actual Cell Value**: When you import or type your data into a workbook or matrix book, Origin uses a combination of user-specified settings to determine how to display the data in each cell. What displays is a visual representation of the data value. The actual data values are stored with the full precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the actual data values that are used and not the displayed values.

- **Display of Numbers that Exceed Cell Width**: If a workbook or matrix book contains data that exceed the cell (column) width, Origin displays values as series of pound signs (**######**). This avoids confusion caused by a truncated display of cell values. Pound signs **######** will revert to numbers when you enter cell editing mode.

- **Missing Values in the Worksheet**: When spreadsheet programs first appeared it was recognized that there was a need for a special number that was "not a number" which would - when used in a calculation - generate itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix and it can be used in calculations or scripts (for instance, to return a missing value unless some condition is met). Origin displays missing values in a worksheet or matrix sheet as "--". However, you shouldn't confuse this display (output) with what you enter as a missing value (input).

- **Decimal, Scientific and Engineering Notation**: You can display workbook or matrix book data in **Decimal**:1000, **Scientific**:1E3, **Engineering**:1k, and **Decimal**:1,000 notations. You can manually choose from these data display options but you can also pre-define thresholds for automatic display of scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower).
- **Dates and Times in Origin**: Origin interprets dates based on the Gregorian Calendar. Origin's mathematical system for dates and time is based on Astronomical Julian Day Numbers. This defines January 1, -4712 (January 1, 4713 BCE), 12 hours Greenwich Mean Time as zero.

**Note**: For more information on numbers, see Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in Origin

Origin workbooks and matrix books support the following **Data Types**:

<table>
<thead>
<tr>
<th>Workbook</th>
<th>Matrix Book</th>
<th>Bytes</th>
<th>Range of Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>double</td>
<td>double</td>
<td>8</td>
<td>±1.7E±308 (15 digits)</td>
</tr>
<tr>
<td>real</td>
<td>float</td>
<td>4</td>
<td>±3.4E±38 (7 digits)</td>
</tr>
<tr>
<td>short</td>
<td>short</td>
<td>2</td>
<td>-32,768 to 32,767</td>
</tr>
<tr>
<td>long</td>
<td>int</td>
<td>4</td>
<td>-2,147,483,648 to 2,147,483,647</td>
</tr>
<tr>
<td>char</td>
<td>char</td>
<td>1</td>
<td>-128 to 127</td>
</tr>
<tr>
<td>byte</td>
<td>char, unsigned</td>
<td>1</td>
<td>0 to 255</td>
</tr>
<tr>
<td>ushort</td>
<td>short, unsigned</td>
<td>2</td>
<td>0 to 65,535</td>
</tr>
<tr>
<td>ulong</td>
<td>int, unsigned</td>
<td>4</td>
<td>0 to 4,294,967,295</td>
</tr>
<tr>
<td>complex</td>
<td>complex</td>
<td>16</td>
<td>±1.7E±308 (15 digits), each 8 bytes</td>
</tr>
</tbody>
</table>
6.3 Topics for Further Reading

- Project Explorer
- The Object Manager
- Finding Data in your Origin Project
- Basic Child Window Operations
- Numbers in Origin
- Dates and Times in Origin
- FAQ: How do I turn off the collapsible menus and show full menus?
- Customizing Toolbars
- Setting Your Preferences
- The Numeric Format Tab of Tools: Options
### 7 Origin File Types

#### 7.1 Roundup of Origin File Types

Various Origin file types and their usages are listed in the table below:

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extension</th>
<th>Used As</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin Project Files</td>
<td>*.opj</td>
<td>A container for all data.</td>
</tr>
<tr>
<td>Child Window Files</td>
<td><em>.ogw;</em>.ogg;<em>.ogm;</em>.txt</td>
<td>The child windows for workbooks (.ogw), graph (.ogg), matrix (.ogm), notes (.txt).</td>
</tr>
<tr>
<td>Template Files</td>
<td><em>.otp;</em>.otw;*.otm</td>
<td>A stored customizable suite of data-handling and format options: graphs (.otp), worksheets (.otw), matrix (.otm).</td>
</tr>
<tr>
<td>Theme Files</td>
<td><em>.oth;</em>.ois;<em>.odt;</em>.ofp</td>
<td>A saved suite of user-defined settings with multiple applications in Origin. A *.oth file applies to a graph/worksheet/matrix sheet/report table; A *.ois applies to analyses and dialogs; A *.odt applies to dialogs; A *.ofp applies to function plots.</td>
</tr>
<tr>
<td>Import Filter Files</td>
<td>*.oif</td>
<td>An external file which handles basic import file parsing and data extraction.</td>
</tr>
<tr>
<td>Fitting Function Files</td>
<td>*.fdf</td>
<td>A fitting function definition file.</td>
</tr>
<tr>
<td>LabTalk Script Files</td>
<td>*.ogs</td>
<td>A text file organized in sections of LabTalk script.</td>
</tr>
<tr>
<td>Origin C Files</td>
<td><em>.c;</em>.cpp;<em>.h;</em>.etc</td>
<td>A file used for developing Origin C programs.</td>
</tr>
<tr>
<td>X-Function Files</td>
<td><em>.oxf;</em>.xfc;</td>
<td>An Origin tool with a flexible mechanism for performing a wide variety of data manipulation tasks.</td>
</tr>
<tr>
<td>Origin Package Files</td>
<td>*.opx</td>
<td>A package file created for distributing custom applications.</td>
</tr>
</tbody>
</table>
### File Guide

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extension</th>
<th>Used As</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin Menu Files</td>
<td><em>.xml;</em>.omc;</td>
<td>A file that contains Origin menu information. An *.xml file can be edited outside of Origin for menu customization purposes. An *.omc file contains the configuration of customized menus.</td>
</tr>
<tr>
<td>Initialization Files</td>
<td>*.ini</td>
<td>A file that controls the configuration of some Origin features on startup.</td>
</tr>
<tr>
<td>Configuration Files</td>
<td>*.cnf</td>
<td>A text file that contains LabTalk script commands.</td>
</tr>
<tr>
<td>Custom Plot Symbols</td>
<td>origin.uds</td>
<td>A binary file that holds the bitmap images of custom symbols.</td>
</tr>
</tbody>
</table>

### 7.2 Topics for Further Reading

- Opening, Closing and Backing Up the Origin Project File
- Protecting Origin Projects
- Origin Template Files
- The Theme Organizer
- System Themes
- Import Wizard, Save Filters Page
- Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder
- OGS Files and Getting Started with LabTalk
- Running LabTalk Script from OGS Files
- Using X-Functions in LabTalk
- Packaging Multiple Files as an OPX File
8 Import Data

Origin imports many file types: ASCII, CSV, Excel, binary files, and many third-party formats, including pClamp, NI TDM and NetCDF. When working with Excel files, you have the choice of importing files or opening files while running an OLE instance of Excel inside of Origin (we strongly suggest importing your Excel data).

Files are imported via the Import menu (File: Import) or by drag-and-drop (to a workbook, a matrix book, or a graph window).

File import is frequently a repetitive operation and Origin has a number of features which can greatly speed up the import process -- particularly when importing files with similar structure. Import settings can be saved with the child window and they can be saved as a Dialog Theme. When imported via the Import Wizard, settings can be saved to an Origin Import Filter file (*.oif) along with post-import processing instructions (in the form of LabTalk script).

Finally, you can opt to add an import routine that was saved as a Theme, to the File: Import menu, or use the File: Re-Import Directly menu command to re-import files that were updated after the last import.
Starting with Origin 2015, you can re-import multiple sheets from an Excel file to the active Origin workbook. The Origin workbook maintains a link to the Excel file, allowing you to update Origin by choosing File: Reimport Directly (CTRL + 4).

8.1 ASCII Import

The File: Import: Single ASCII... and File: Import: Multiple ASCII... methods are generally satisfactory for importing text files having a simple structure. These methods are also accessible from the and buttons located in the Standard toolbar. These methods will typically handle files with commonly-used delimiters and a simple header structure, without adjustments.

If a file imports with only minor complications, select the Show Options Dialog checkbox when selecting your files in the ASCII dialog (File: Import: Single ASCII... and File: Import: Multiple ASCII...). This will open the impASC dialog box prior to file import, allowing you to tweak the way that the files are handled.

<table>
<thead>
<tr>
<th>Template Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Structure</td>
</tr>
<tr>
<td>Columns</td>
</tr>
<tr>
<td>Header Lines</td>
</tr>
<tr>
<td>Number of Main Header Lines (exclude subheader lines)</td>
</tr>
<tr>
<td>Auto Determine Subheader Lines</td>
</tr>
<tr>
<td>Line Number Start from Bottom</td>
</tr>
<tr>
<td>Number of Subheader Lines</td>
</tr>
<tr>
<td>Extract Long Names and Units from Same Line</td>
</tr>
<tr>
<td>Short Names</td>
</tr>
<tr>
<td>Long Names</td>
</tr>
<tr>
<td>Units</td>
</tr>
<tr>
<td>Comments From</td>
</tr>
</tbody>
</table>

Once you've adjusted import settings, you can save them in one of two ways: (1) with the worksheet template or (2) as a Theme file from within the impASC dialog box. Saving import settings with the worksheet template offers portability. Saving import settings as a Theme offers the option of adding your import routine to the Import menu (File: Import).

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide. Additionally, see topics listed under "Topics for Further Reading", below.

Note: For a more in-depth discussion of simple ASCII import, see the help topic:

Help: Origin: Origin Help > Importing and Exporting Data > Importing Simple ASCII Data Files
For import of complex ASCII files -- those not satisfactorily handled by the methods previously mentioned -- you can use the Origin Import Wizard (File: Import: Import Wizard...). The Wizard is also accessible from the button located in the Standard toolbar. Apart from its advantages for import of complex files, the Wizard also offers the following:

- Using wild cards, you can create filename-specific filters that are targeted to a group of similarly-named files. This is especially useful for drag-and-drop import operations because all you do is drop the files onto the workspace. Origin looks at the file name, matches it with the correct custom import filter and imports the file according to your specifications.

- Import data from the web pages using the Clipboard.

- Extract variables from the import file name and header.

- Specify custom delimiters and date formats.

- The ability to post-process your imported data using a custom LabTalk script.

**Note:** For more information, view the help topic:

Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard

---

**Tutorial: Importing Multiple Files into Worksheets**

1. Click on the **New Workbook** button on the Standard toolbar to open a new workbook.

2. With the new workbook active, click on the **Import Multiple ASCII** button on the same toolbar. This opens the ASCII dialog.

3. In the ASCII dialog, select the files Sensor01.dat, Sensor02.dat, and Sensor03.dat from the \Samples\Curve Fitting subfolder of your Origin installation folder, and click the **Add File(s)** button. Then check the **Show Options Dialog** check box and press **OK**.

4. The impASC dialog will open. Under the Import Options node, change Import Mode to Start New Sheets. Expand the (Re)Naming Worksheet node and clear Rename Book with (Partial) Filename.

5. Press the arrow button at the top right of the dialog box, then select **Save As...** from the shortcut menu. In the dialog box that opens, enter a name such as **Import to sheets** and press **OK**. This will save your settings as a Theme that you can later use with other files.

6. Press **OK** to close the impASC dialog.

The three files will be imported, each into a worksheet, and the sheets will be renamed with the file name.
You can quickly access your custom import theme from the **File: Recent Imports** menu item. You can also use the **File: Import: Customize...** menu to open the **Import Menu Customization** dialog box where you can select and add **User Themes** to the **File: Import** menu.

### 8.2 CSV Import

You can use **File: Import: Comma Delimited (CSV)...** to import comma delimited files into an Origin workbook file. Modifications to import file handling are made in the **impCSV** dialog box and changes can be saved as a Theme file for later use. Alternately, once you've successfully imported your .csv file into an Origin workbook, you can save the workbook as a workbook template file (*.ogw) and reuse the template for re-importing files of like structure.

### 8.3 Binary Import

Files with an optional header section followed by a sequential binary structure, can be imported using the Origin Import Wizard (**File: Import: Import Wizard...**).

If the binary file format is commonly used in your field of work, please contact your Origin representative so we can consider adding support for such files in future versions.
8.4 Copy/Paste and Clipboard Data

One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook. However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your data into Origin. Here are some things you should know:

- Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the number of displayed decimal digits in Excel.

- When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin (not into the column label rows), then select a row and use the (right-click) shortcut key commands Set as Long Name, Set as Units, Set as Comment, etc. to tag your header information.

- Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted data. For more information, see the tutorial Using the Import Wizard to Import Clipboard Data.
8.5 Excel

There are three ways to work with Excel data in Origin:

- You can import your Microsoft Excel workbook into an Origin workbook. To do this, use the File: Import: Excel (XLS, XLSX, XLSM)... menu command, or click the button located in the Standard toolbar. You can also update the imported data by using File: Re-Import Directly or use Ctrl+4 keys to re-import Excel sheets with same settings as before.

- You can copy Excel data to the Clipboard and paste or paste link that data into Origin.

- You can open your Excel workbook in Origin as an Excel workbook. To do this, use the File: Open Excel... menu command.

When you import or paste your Excel workbook data into an Origin workbook, you have full access to Origin's powerful graphing and analysis features. When you open your Excel workbook as an Excel workbook, you are actually running an OLE instance of Excel inside of the Origin workspace. In this case, you have access to Excel's menus and features, but limited access to Origin's graphing and analysis features.

Things to know:

- To re-import multiple sheets from Excel to Origin, you need to have Origin 2015 or later.
- To open an Excel file in Origin, you need to have Office 97 or later installed on your computer.
- To import an Excel file in Origin, the file needs to be of file type .xls, .xlsx or .xlsm.
- Origin does not support dynamically linking a formula in an Excel workbook to source data in another Excel workbook.
- You can link your Origin project file (.opj) an external Excel file. That way updates to the Excel file will trigger updates to dependent graphs etc. when you open the Origin project file.

Note: To learn more about working with Excel data, see the Origin Help:

Help: Origin: Origin Help > Working with Microsoft Excel

8.6 Third Party Formats

Origin imports many widely-used third party data formats, including pClamp, NI TDM, and NetCDF. As with ASCII import, you can customize third-party file import options and save your settings with the worksheet template or as a dialog Theme for later use.

As with other supported file types, you can import third party files by drag and drop.
## Import Data

### File Type

<table>
<thead>
<tr>
<th>Method</th>
<th>To Learn More, see Help: Origin: Origin Help &gt; Importing and Exporting Data</th>
</tr>
</thead>
</table>

- Thermo (SPC, CGM)
- pCLAMP (ABF, DAT, AB?)
- Princeton Instruments (SPE)
- Sound (WAV)
- NetCDF (NC)
- CDF (CDF)
- HDF5 (H5, HE, HDF5)
- NI DIAdem (DAT)
- NI TDM (TDM, TDMS)
- Famos (DAT, RAW)
- ETAS INCA MDF (DAT, MDF)
- IgorPro (PXP, IBW)
- Prism (PZFX, XML)
- MATLAB (Mat)
- Minitab (MTW, MPJ)
- KaleidaGraph (QDA)
- SigmaPlot (JNB)
- MZXML (mzData, mzXML, mzML, imzML)
- EarthProbe (EPA)
- EDF (EDF, BDF, REC, HYP)
- Somat SIE (SIE)
- JCAMP-DX (DX, DX1, JDX, JCM)
- HEKA (DAT)
- SPSS (SAV)
- Data Translation (DCF, HPF)
- Binary 2D Array
- Image

**Note:** Some of these 3rd party file formats are hidden by default. Turn them on by choosing File: Import: Add/Remove File Types.... This will add file types to the File: Import menu. To insert separators between menu commands, right-click in the right-hand panel of Import Menu Customization and choose Add Separator.

Drag-and-drop support for various file extensions can be customized using the Filter Manager dialog accessible from the Tools: Import Filter Manager... menu item.
8.7 Database

Origin provides two tools for database import:

- SQL Editor: A simple SQL editor for typing and running SQL queries, one at a time.
- Query Builder: A graphical query builder that assists you in creating an SQL script.

Generally speaking, the SQL Editor is more useful for editing of SQL scripts, while Query Builder is helpful for those who aren't familiar with SQL syntax.

**Note:** For more information, see the Origin Help

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database

Note that Query Builder is not available in 64bit Origin. You can use the 32bit version to build a query and save. You can then run the 64bit version and use SQL Editor to open and edit further.

8.8 Digitizer

At times, you may only have a graphic representation of some data that you would like to explore further. In such cases, Origin's Digitizer tool may prove handy. Use the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you can study and re-plot using Origin's analysis and graphing tools.
Import Data

- Import most common image formats.
- Rotate the imported image, remove noise and calibrate scales by picking start and end values.
- Pick points on curves manually or automatically.
- Manually add curve inflection points, as needed.
- Interactively remove points that you do not want digitized.
- Support for Cartesian, polar and ternary coordinate systems.

To open the Digitizer:

1. Click the **Digitize Image** button on the **Standard** toolbar or choose **Tools: Digitizer...** from the main menu.

### 8.9 Re-Importing Data Files

There are two re-import commands in the **File** menu:

- **Re-Import Directly.** When you import a file into an Origin worksheet or matrix sheet, by default a number of parameters, including file path and name, are saved in the sheet. If you have an external data file that is periodically updated, direct re-import is a quick way to update your Origin project file.

- **Re-Import...**. This menu command opens the corresponding X-Function import dialog box for the file type so that you can adjust your import options before re-importing.

**Notes:**

- Only one file can be re-imported at a time. When you use either of these two menu commands, only the file associated with the active worksheet or matrix sheet, will be imported. If the selected data are imported from multiple files, re-importing will fail.

- If you import an *ASCII* file via the **Import Wizard** and select **File: Re-Import...**, the **Import Single ASCII** dialog will be open instead of the **Import Wizard**.

- Re-import does not work for *Binary* or *User Defined* data types brought in using the Import Wizard.
8.10 Topics for Further Reading

- Importing Simple ASCII Data Files
- Customizing the ASCII Import Options
- Import and Reimport Excel Data
- Importing Third Party Files
- Tutorial: Updating Graphs by Re-importing Data from a Database
- Importing Data from a Database
- Drawing or Deleting Data Points
- Tutorial: The Digitizer
9 Workbooks Worksheets Columns

9.1 Workbook, Worksheet and Column Basics

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing, organizing, analyzing, transforming, plotting and presenting your data. Each workbook is a collection of one or more worksheets. Each worksheet contains a collection of columns and each column contains rows of cells.
9.1.1 Naming Workbooks, Worksheets and Columns

- A Workbook has a **Short Name** and an optional **Long Name** and **Comments**. Origin uses the **Short Name** for internal operations.
- **Short Names** must be unique within the project file, can contain only alpha-numeric characters (letters and numbers), must begin with a letter and are limited to 13 characters.
- A Workbook **Long Name** is optional, need not be unique within the project file, can use any characters in any order and should be limited to 359 characters (including spaces).
### Workbooks Worksheets Columns

| **Worksheets** | - A Worksheet has a **Short Name** and optional **Long Name** and **Comments**.  
- The **Short Name** must be unique in a workbook.  
- A Worksheet **Short Name** has a 32 character limit, including spaces. It can contain special characters but must begin with an alphanumeric character. These special characters are not allowed: `{|"<>!\}.  
- A Worksheet **Long Name** is optional, need not be unique within the project file, can use any characters in any order. |
| **Columns** | - A Column has a **Short Name** and an optional **Long Name**.  
- The **Short Name** must be unique within the worksheet, cannot contain special characters, must begin with a letter or number, use only alphanumeric and limited to 18 characters.  
- A Column **Long Name** is optional, need not be unique within the project file, can use any characters in any order.  
- If the **Auto update column Short Name to follow Long Name** check box is selected (*Tools: Options: Miscellaneous*), column **Short Name** tracks column **Long Name**, removing spaces/special characters, truncating to 17 characters, as needed. Check box is cleared by default.  
- Dialog box and Status Bar references to data range will use **Long Names**, provided that (1) **Long Name** exists and (2) you have selected **Use Long Names when available** (*Tools: Options: Miscellaneous*). Otherwise, **Short Names** are used. |

**Note:** Origin has a formal notation for addressing columns which makes use of the **Workbook Short Name**, the **Column Short Name** and the **Worksheet index** if larger than 1:  

```text
WorkbookShortName_ColumnShortName@SheetIndex
```

as in

```text
Book1_C@200.
```

This notation is limited to 24 characters and Origin adopts various strategies in limiting Short Names (Book or Column) to allow user flexibility and still allow operation flexibility.

For example, this explains why you can create longer column short names in books with shorter book short names.
9.1.2 Workbooks

When you start an Origin session, Origin loads an empty Project and adds the default ORIGIN.OTW workbook template (You can modify this behavior by clicking Tools > Options > Open/Close tab > Start New Project). Add workbooks to your Origin project file at any time by clicking the New Workbook button on the Standard toolbar.

An added workbook window is assigned a Short Name of Book\(N\), with \(N\) reflecting the order of window creation. You can rename the workbook with something more meaningful:

1. Right-click on the workbook window title bar and choose Properties....
2. Give your workbook a Long Name (optional) and/or a Short Name and choose to display either or Both in the window title bar. See the above table for rules on workbook naming.

**Note:** The workbook has a Comments property that you can access by right-clicking on the workbook title bar and choosing Properties.... These Comments display as a workbook window tooltip in Project Explorer and become searchable when using the Find in Project tool.

9.1.3 Worksheets

An Origin workbook can have up to 255 worksheets. To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:

- **Insert.** Inserts a single worksheet ahead of the active sheet.
- **Add.** Appends a single worksheet.
- **Duplicate Without Data.** Duplicates the active worksheet without duplicating the data.
- **Duplicate.** Duplicates the active sheet, including the data.

Each sheet in a workbook can have its own set of customizations. When you Insert or Add a worksheet, the new sheet is based on the ORIGIN.OTW file, specifically the version of ORIGIN.OTW that is saved to your User Files Folder if you have customized this file. If you wish to add a sheet that is based on another sheet in the workbook (including number of columns and special formatting), you would use the Duplicate or Duplicate Without Data shortcut command.

To control worksheet tab name display:

1. Right-click on the worksheet tab.
2. Select Sheet Name to Show: Long Name if available/ Short Name/ Long Name from the shortcut menu.

To change the Short Name or Long Name that displays on the worksheet tab:

1. Double-click on the worksheet name or right-click on the worksheet tab and choose Name and Comments. See the above table for rules on worksheet naming. If you are editing the Short Name and you exceed 32 characters, Origin automatically truncates your entry to create the
Short Name. If Long Name did not previously exist, the unmodified text becomes the Long Name.

Note: When mousing over the worksheet tab, the worksheet Short Name, Long Name and Comments appear as a tooltip.

9.1.4 Worksheet Columns

- **To add a new column** to an existing worksheet, right click in the gray area to the right of the worksheet columns and choose Add New Column or Click the Add New Column button on the Standard toolbar.

- **To add multiple columns** to the worksheet, make the worksheet active then choose Column: Add New Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog box and click OK or use the Format: Worksheet... menu item or the F4 hot key to open the Worksheet Properties dialog, then set the desired value for Column Number in the Size tab.

Worksheet columns can be renamed by:

- Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name and/or Long Name.

- Type a Long Name directly into the worksheet header cell by double-clicking in the cell.

- Import a data file and specify that the workbooks, worksheets, and columns be named upon import.

- Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column names and labels.

- Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-right corner of the selection to auto fill and enumerate the names for other columns. This also works for other column label rows such as Comments.

See the above table for rules on worksheet column naming.

9.1.5 The Column Properties Dialog Box

The Column Properties dialog box is used to customize properties of the column including...

- Long Name, Short Name, Units, Comments, etc.

- **Format** (Numeric, Text, Time, Date, etc.).

- Plot Designation.
To open the **Column Properties** dialog box:

1. Double-click on the column header.
2. Right-click the selected column(s) and choose **Properties**....

Use the **Properties** tab to edit the column **Short Name**, if desired. Other properties -- **Long Name**, **Units** and **Comments** -- can be edited here or entered directly into the appropriate cell.

Note that the worksheet column can be configured for different data formats, including **Text & Numeric**, **Numeric**, **Text**, **Time Date**, **Month**, and **Day of Week**. A column can contain data of only one format type. It is important to know that the default Format is **Text & Numeric** and unless you are using a custom workbook template, you may need to manually set Format so that column data display and are handled properly. For instance, many users get tripped up when they enter date or time data into a worksheet column but fail to set the necessary Format and Display options. **Column Properties** is where you do that.

We should also point out the worksheet column **Plot Designation**. Columns are designated as **X**, **Y**, **Z**, **Label**, **Disregard**, **Y Error** or **X Error**. A column's Plot Designation determines how the selected data will be handled, by default, during plotting and analysis operations. As Origin has evolved, the Plot Designation has become somewhat less important than it once was. For instance, the Plot Setup dialog and many Analysis dialogs allow you to select data interactively, thus overriding the Plot Designation. Still, Plot Designation is an important concept and you should be aware of its effects on plotting and analysis operations. To learn more, see **Plot Designation (Column Properties)**.

You can customize the display of individual cells or groups of cells in a column, editing such things as font, cell fill color, or number of displayed decimal digits:

- Style settings are generally made using controls on the **Format** toolbar.
- Decimal digits are controlled by a Digits drop-down in the Column Properties dialog box. Additional numeric format controls are found on the **Numeric Format** tab of the **Options dialog box** (Tools: Options).
9.1.6 Column Label Rows

All columns have fixed properties (i.e. metadata) that display in the column label rows. These include the Long Name, Units, and Comments. The values of these properties are used to address and represent data columns both internally and in the Origin GUI.

Display of column label rows is controlled by shortcut menu commands:

1. Right-click here and choose View from the shortcut menu.
2. Right-click here and choose Edit Column Label Rows or other label row command.
3. Right-click here for global control of row labels and row and column header display.
Column label rows store information which can be used when plotting, such as for group plotting and for setting legend text. Label row data can also be incorporated into data analysis operations (for instance, in math operations on worksheet columns), or in data manipulation operations (for instance providing grouping information when stacking worksheet columns).

Numeric data stored in a column will graphically display in the column header in a special label row called Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent variable (Y) against the row number or the associated X column as independent variable (X). Sparklines can also be plotted as a histogram or as a box chart, providing a "thumbnail" view of column statistics. When importing data, Origin displays sparklines by default when the number of columns is less than 50.

Turn on sparklines for selected columns by clicking Column: Add or Update Sparklines or for all columns by right-clicking on the Sparklines row label and choosing Add or Update Sparklines. Sparklines can be deleted by clicking the Sparklines row label and pressing the delete key. Note that sparklines can be edited graphically. Double-clicking on a sparkline pops open a graph window where you can customize the plot. When you close the pop-up window, your customizations are applied to sparkline.

### 9.1.7 Some Workbook, Worksheet and Column Limits

<table>
<thead>
<tr>
<th>Maximum Number of...</th>
<th>32Bit OS</th>
<th>64Bit OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheets in a workbook</td>
<td>255</td>
<td>255</td>
</tr>
<tr>
<td>Rows in a worksheet, 1 column</td>
<td>90,000,000</td>
<td>90,000,000</td>
</tr>
<tr>
<td>Rows in a worksheet, 5 columns</td>
<td>25,000,000</td>
<td>90,000,000</td>
</tr>
<tr>
<td>Rows in a worksheet, 32 columns</td>
<td>4,860,000</td>
<td>7,300,000</td>
</tr>
<tr>
<td>Columns in a worksheet, 1 row</td>
<td>65,500</td>
<td>65,500</td>
</tr>
<tr>
<td>Columns in a worksheet, 100 rows</td>
<td>65,500</td>
<td>65,500</td>
</tr>
<tr>
<td>Columns in a worksheet, 1000 rows</td>
<td>65,500</td>
<td>65,500</td>
</tr>
</tbody>
</table>

### 9.2 Workbook Templates

Origin workbook windows are created from a workbook template file with OTW extension. By default, Origin uses the ORIGIN.OTW template when creating new workbook windows. ORIGIN.OTW contains a single, two-column worksheet. You can customize an Origin workbook and save it as a new template file. Customized templates get saved to your User Files Folder (UFF) by default. Built-in template files can’t be overwritten; instead a template file with same name will be saved to your UFF. The UFF version then becomes the template used by Origin’s menu commands and toolbar buttons.

- To save the active workbook as a template, choose File: Save Template As. This opens the template_saveas dialog box.

**Note:** Data are NOT saved with a template file.
The following table lists some of the kinds of things that are saved with the workbook template file. Click the dialog box link for more information.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>What is Saved?</th>
<th>Menu Command</th>
</tr>
</thead>
</table>
| **Worksheet Properties** | • Display of row/column heading labels.  
• Display of worksheet grid lines.  
• Number of rows/columns in the worksheet.  
• Auto addition of worksheet rows, when needed.  
• Creation and naming of worksheet column heading user-defined parameters.  
• The order of worksheet column heading row labels. | **Format:**  
Worksheet... |
| **Column Properties** | • Column Short Name, Long Name, Units, Comments.  
• Formula (if any) used for calculating column values.  
• Column width settings.  
• Column Plot Designation. (X,Y,Z, Label, etc.).  
• Column data Format (text, numeric, date, etc.).  
• Column number Display (decimal, scientific, engineering).  
• Column Digits and data storage requirements. | **Format:**  
Column... |
| **Column Formulas and Scripts**  
(Set Column Values) | • Formulae used to create or transform column values. | **Column:**  
Set Column Values... |
| **Programming Control**  
and **Object Properties** | • Any annotations along with their settings in the Programming Control and Object Properties dialog boxes.  
• Any scripts associated with the object's Programming Control dialog box. | **Format:**  
Programming Control...  
and  
Format: Object Properties... |
### Dialog Box

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>What is Saved?</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet Query</td>
<td>• Equations in the <strong>Worksheet Query</strong> dialog box.</td>
<td><strong>Worksheet:</strong> <strong>Worksheet Query</strong></td>
</tr>
</tbody>
</table>
| Worksheet Properties, Script tab or Script Panel | • Scripts entered in the **Script** tab of the **Worksheet Properties** dialog box.  
• Scripts in the worksheet **Script Panel**.  | **Worksheet:** **Worksheet Script**  
**Show Script Panel** |
| Query Builder               | • Option to save database queries with the workbook template.                 | **File:** **Database Import:** **New** |

### 9.2.1 Creating a New Workbook from a Custom Template

To create a workbook based on a specific template:

1. Select **File:** **Recent Books** menu. All recently saved workbook template will be listed there.
2. Select **File:** **Open...** menu, then change **File Type** to **Templates (*.otp, *.otw, *.otm)**.
3. Click the **Open Template...** button on the Standard toolbar and change **File Type** to **Workbook Template**.
4. Select **File:** **New: From Template: More...** This menu command opens the **Load Template** dialog box.
   - Select **Workbook** in the **Type** group.
   - If necessary, use the browse button in the **Path** group to locate the .otw file.
   - Select the worksheet template from the **Name** drop-down list.
   - Optionally, specify this as the default workbook template by clicking **Set Default**.

By default, the **New Project** and **New Workbook** buttons will use the **Origin.OTW** template located in the Origin EXE folder. You can customize a workbook and save it as Origin.OTW. Your customized file will be saved in the User Files Folder, and will be used from then on as the default template. If you wish to roll back to your original Origin.OTW, browse to your User Files Folder in Windows Explorer and rename or delete the ORIGIN.OTW that is saved there.
9.2.2  **Worksheets for Analysis and Reporting**

Apart from containing text and numeric data, worksheet cells support storage and display of various other types of data such as graphs, graphic objects, notes, hyperlinks to documents and web pages, and links to project variables.

This makes the worksheet an ideal medium for presenting analyses and reporting results. You can link to cells in other worksheets and report sheets. You can also embed graphs, images from external disk files, or image plots corresponding to matrix objects in your Origin Project. Groups of cells in a worksheet can be merged, allowing for larger objects to be displayed fully. Graphs can also be placed on worksheets as floating objects.

Once created, such custom reports can be exported as image files (for instance, as PDF or JPEG), and they can also be used in the creation of an **Analysis Template**.

---

Starting with Origin 2016, you have the option of generating custom reports by exporting data to a custom **MS Word** template, and optionally, a **PDF** file. This is done by running an output-generating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally, saving the workbook as an Analysis Template. To generate your report, you open the **Batch Processing** tool, point to both your Analysis Template and your Word template, run the batch process and generate your reports.
For more information on batch analysis and generating custom reports, see the **Batch Analysis** section of the "How to Handle Repetitive Tasks" chapter of this Guide.

### 9.2.3 The Workbook Organizer

The workbook typically stores metadata, including such things as import file path and name, date and time of data import, file header information, variable names and values, etc. Such metadata can be viewed in the **Workbook Organizer** panel.

To show a workbook's Organizer panel right-click on the workbook title bar and select **Show Organizer** (note that this action toggles the panel on or off). The Organizer provides a tree-view listing of metadata stored with a particular workbook.
9.3 Simple Utilities for Filling Columns with Data

Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a menu command to fill a worksheet column with either row index numbers, uniform random numbers or normal random numbers. This is useful for generating quick datasets to test and try out other Origin features.

These simple procedures create a dataset in a pre-selected worksheet range or column(s):

<table>
<thead>
<tr>
<th>Action</th>
<th>Toolbar Button</th>
<th>Menu Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill a range or column with row numbers</td>
<td>![Chart Icon]</td>
<td>• Column:Fill Column With:Row Numbers &lt;br&gt;or &lt;br&gt;• Right-click and select Fill Range/Column(s) With Row Numbers</td>
</tr>
<tr>
<td>Action</td>
<td>Toolbar Button</td>
<td>Menu Command</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fill a column with uniformly distributed random numbers between 0 and 1</td>
<td><img src="image.png" alt="Random Numbers" /></td>
<td>• Column: Fill Column With: Uniform Random Numbers &lt;br&gt; or &lt;br&gt; • Right-click and select Fill Range/Column(s) With Uniform Random Numbers</td>
</tr>
<tr>
<td>Fill a column with normally distributed random numbers</td>
<td><img src="image.png" alt="Random Numbers" /></td>
<td>• Column: Fill Column With: Normal Random Numbers &lt;br&gt; or &lt;br&gt; • Right-click and select Fill Range/Column(s) With Normal Random Numbers</td>
</tr>
<tr>
<td>Fill a column with a patterned or random set of numbers</td>
<td>--</td>
<td>• Right-click and select Fill Range/Column(s) With A set of Numbers...</td>
</tr>
<tr>
<td>Fill a column with a patterned or random set of Date/Time Values</td>
<td>--</td>
<td>• Right-click and select Fill Range/Column(s) With A set of Date/Time Values...</td>
</tr>
<tr>
<td>Fill a column with arbitrary set of Text&amp;Numeric values</td>
<td>--</td>
<td>• Right-click and select Fill Range/Column(s) With Arbitrary set of Text&amp;Numeric values...</td>
</tr>
</tbody>
</table>

The **auto fill** feature can be used in filling column label rows and the worksheet data cells:

To use auto fill to **extend** a pattern in the data across a range of cells (numeric data only):

1. Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.
2. When the cursor becomes a "+", hold down the **ALT** key and drag the mouse to the bottom or the right.

To use auto fill to **repeat** a pattern in the data across a range of cells (text or numeric data):

1. Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.
2. When the cursor becomes a "+", hold down the **CTRL** key and drag the mouse toward the bottom or to the right.
Datasets can also be generated quickly using LabTalk script. As an example:

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the following lines of script code into that window:

   ```labtalk
   col(1)={0:0.01:4*pi};
   col(2)=sin(col(1));
   ```

2. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be filled with data.

### 9.4 Setting Column Values

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or more columns of worksheet data.

To open the Set Values dialog box for a single column:

1. Select a worksheet column or a range of cells in a worksheet column.
2. From the menu, choose Column: Set Column Values... or right-click on the worksheet column and choose Set Column Values... from the shortcut menu.
To open the **Set Values** dialog box for multiple columns:

1. Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet.
2. From the menu, choose **Column: Set Multiple Column Values...** or right-click on the worksheet column and choose **Set Multiple Column Values...** from the shortcut menu.

![Set Values - Multiple Columns dialog box](image)

- **Specify the range of columns by column index**
- **Note:** Other controls and panels are similar to the **Set Values** dialog for single column
### 9.4.1 Set Values Menu Commands

<table>
<thead>
<tr>
<th>Menu Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Formula</strong>: Load a saved formula into the column formula box. Formulas are saved using <strong>Formula: Save</strong> or <strong>Formula: Save As</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>wcol(1)</strong>: Use the menu to include worksheet columns in either your column formula or your Before Formula Scripts (column reference is inserted at the cursor). A Column Browser is available to help in selecting the correct columns. Columns are listed by column index.</td>
<td></td>
</tr>
<tr>
<td><strong>Col(A)</strong>: Similar to wcol(1) menu functionality but columns are listed by column name (including Long Name, if it exists).</td>
<td></td>
</tr>
<tr>
<td><strong>Function</strong>: Add LabTalk functions to your expressions (function name is inserted at the cursor). Note that when you hover over a function in the menu list, the function description will be shown in the Status Bar. When a function is selected, its description will be displayed in a pop-up Smart Hint.</td>
<td></td>
</tr>
<tr>
<td><strong>Variables</strong>: Add a variable or a constant to <strong>Column Formula</strong> or <strong>Before Formula Scripts</strong>; Add range variables (including by selection) or file metadata, to <strong>Before Formula Scripts</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Options</strong>: Allow direct editing of column formula in worksheet <strong>Formula</strong> row; add a comment about the column formula; or preserve text in Set Values columns (do not treat as text as missing values).</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a single line expression for generating data. Functions, conditional operators and variables can be used.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Before Formula Scripts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LabTalk scripts to be executed before the expression in the column formula box is executed.</td>
<td></td>
</tr>
</tbody>
</table>

When you mouse over one of the functions listed in the **Function** menu in **Set Values** dialog, a one-line tooltip is displayed in the **Status Bar**. If you select the function, a Smart Hint appears with a more detailed explanation and a link to the full function description, syntax, examples, etc.

Additionally, you can click the **Search and Insert Functions** button to search for available functions by keyword and, once found, insert the function into your expression.

Use the **Before Formula Scripts** panel to define variables, LabTalk functions, or run LabTalk scripts before the expression in the upper panel is evaluated.
Tutorial 1: Computing Moving Average and Moving Standard Deviation

1. Import the file Samples\Signal Processing\fftfilter1.DAT.

   1. Add two more columns to the worksheet.
   2. Click on the header of the 3rd column to select it, then right-click and select Set Column Values... from the context menu.
   3. In the Set Values dialog, enter the following in the upper panel:

   \[ \text{movavg}(\text{col}(2), 5, 5) \]

   4. and press Apply. Column 3 is filled with an 11-point moving average of the data from column 2 (note that you can insert functions such as movavg from the Function menu of the Set Values dialog box).
   5. Click the >> button above the edit box to switch to the 4th column.
   6. In the edit box for the 4th column, enter the following formula and press OK. This 4th column will be filled with standard deviation values, using a window size of 11 at each point.

   \[ \text{stddev}(\text{col}(2)[i-5:i+5]) \]

   **Note:** The stddev function does not accept parameters for left and right window size. The \([i-1:i+5]\) notation is used to specify the window. This notation therefore allows you to specify row range, similar to how one can specify the range interactively in Excel.

Tutorial 2: Set Values for Multiple Columns

1. Create a new project by clicking the New Project button \(\text{新建项目}\) on the Standard toolbar.

2. Click the Import Multiple ASCII button \(\text{导入多个ASCII文件}\) to import the files F1.dat and F2.dat in the <Origin Folder>\Samples\Import and Export\ path. In the impASC dialog, select Start New Books for the Import Mode drop-down list.

3. Two workbooks are created, named as F1 and F2. Click the New Workbook button \(\text{新建工作簿}\) on the Standard toolbar to create another workbook.
4. With the 3rd workbook active, click the Add New Columns button to add a column. Highlight all columns and select Column: Set Multiple Columns Values from the main menu or right-click the columns and select Set Multiple Columns Values from the shortcut menu to open the Set Values dialog box.

5. Expand the bottom panel by clicking the Show Scripts button. Enter this script in the Before Formula Scripts edit box,

\[
\text{range } r1=[F1:F1!wcol(j)]; //"j" \text{ is the column index.}
\]

\[
\text{range } r2=[F2:F2!wcol(j)];
\]

6. Enter \((r1+r2)/2\) in the Column Formula edit box.

7. Select Options: Direct Edit Formula Cell to clear this option.

8. Select Options: Formula Text... and enter \((F1+F2)/2\) in the Formula Text dialog, then click OK.

9. Click the OK button in the Set Values dialog box. You will see the results in the worksheet, and \((F1+F2)/2\) will display in the \(F(x)\) column label row instead of the formula.

9.5 Processing Worksheet Data

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the Worksheet menu while some are on the Edit, Column or Analysis menus. Note that a worksheet must be the active window.

<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
</table>
| Sorting Data           | **Worksheet: Sort Range**  
|                        | **Worksheet: Sort Columns**  
|                        | **Worksheet: Sort Worksheet**  
<p>|                        | <strong>Worksheet: Sort Columns by Label</strong>             |
| Find                   | <strong>Edit: Find in Project</strong>                       |
|                        | <strong>Edit: Find in Sheets</strong>                        |
|                        | <strong>Edit: Replace</strong>                               |
| Hide Column            | <strong>Column: Hide/Unhide Columns</strong>                  |
| Hide Rows              | <strong>Hide/Unhide Rows</strong> (shortcut menu only)       |</p>
<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Move Columns</td>
<td><strong>Column</strong>: Move Columns or <strong>Column toolbar</strong>.</td>
</tr>
<tr>
<td>• Swap Columns</td>
<td><strong>Column</strong>: Swap Columns</td>
</tr>
<tr>
<td>• Query Worksheet Data</td>
<td><strong>Worksheet</strong>: Worksheet Query</td>
</tr>
<tr>
<td>• Append Worksheet</td>
<td><strong>Worksheet</strong>: Append Worksheet</td>
</tr>
<tr>
<td>• Split Worksheet</td>
<td><strong>Worksheet</strong>: Split Worksheet</td>
</tr>
<tr>
<td>• Split Workbook</td>
<td><strong>Worksheet</strong>: Split Workbooks</td>
</tr>
<tr>
<td>• Worksheet Transpose</td>
<td><strong>Worksheet</strong>: Transpose</td>
</tr>
<tr>
<td>• Stack Multiple Columns into One with Grouping</td>
<td><strong>Worksheet</strong>: Stack Columns</td>
</tr>
<tr>
<td>• Unstack Grouped Data into Multiple Columns</td>
<td><strong>Worksheet</strong>: Unstack Columns</td>
</tr>
<tr>
<td>• Summarize Data with Pivot Table</td>
<td><strong>Worksheet</strong>: Pivot Table</td>
</tr>
<tr>
<td>• Filter data using conditions on one or more columns</td>
<td><strong>Column</strong>: Filter menu, or <strong>Worksheet Data</strong> toolbar</td>
</tr>
<tr>
<td>• Data Reduction</td>
<td><strong>Worksheet</strong>: Remove/Combine Duplicated Rows</td>
</tr>
<tr>
<td></td>
<td><strong>Worksheet</strong>: Reduce Columns</td>
</tr>
<tr>
<td></td>
<td><strong>Worksheet</strong>: Reduce Rows</td>
</tr>
<tr>
<td></td>
<td>Analysis: Data Manipulation: Reduce Duplicate X Data</td>
</tr>
<tr>
<td></td>
<td>Analysis: Data Manipulation: Reduce by Group</td>
</tr>
<tr>
<td></td>
<td>Analysis: Data Manipulation: Reduce to Evenly Spaced X</td>
</tr>
<tr>
<td>• Reverse Order</td>
<td><strong>Column</strong>: Reverse Order</td>
</tr>
</tbody>
</table>
Some of these worksheet data processing utilities are available from a shortcut menu. For access, right-click on your data selection.

9.6 Topics for Further Reading

- The User Files Folder
- Origin Template Files
- What is Saved with the Workbook Template?
- Arranging the Worksheet
- Displaying Supporting Data in the Worksheet Header Rows
- Controlling How Numeric Data Display
- Dates and Times in the Worksheet
- Generating Simple Worksheet Datasets
- Using Formulae to Set or Transform Worksheet Column Values
- Simple Manipulation of Worksheet Datasets
- Inserting Graphs, Images and other Objects into Worksheet Cells
- Inserting Links into Worksheet Cells
- Inserting Variables into Worksheets
- Analysis Report Sheets and Columns
10.1 Matrix Books, Matrix Sheets and Matrix Objects

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X and Y values. The following table summarizes some important matrix book limits:

<table>
<thead>
<tr>
<th>Maximum Number of...</th>
<th>32Bit OS</th>
<th>64Bit OS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix sheets in a matrix book</td>
<td>255</td>
<td>255</td>
</tr>
<tr>
<td>Matrix objects in a matrix sheet</td>
<td>65,527</td>
<td>65,527</td>
</tr>
<tr>
<td>Cells in a matrix (Note)</td>
<td>90,000,000</td>
<td>90,000,000</td>
</tr>
</tbody>
</table>

Note: The product of any combination of rows and columns must not be greater than 90,000,000.
10.1.1 Naming Matrix Books, Matrix Sheets and Matrix Objects

- The matrix book has a **Short Name** whether you display it or not. Origin uses the **Short Name** for internal operations.

- **Short Names** must be unique within the project file, cannot contain spaces, must begin with a letter, consist only of alphanumeric characters (A to Z and 0 to 9), and limited to 13 characters. You can use lowercase characters and the text will appear as such, but upper and lower case are not unique characters. (You cannot name one matrix MBOOK1 and another mbook1.)

- **Long Names** are optional, need not be unique within the project file, can contain spaces, can begin with a letter, a number or a special character, and the length cannot exceed 520 characters, including spaces.
### Matrix Sheets
- The sheet Short Name (a Layer object) must be unique within the matrix book and is limited to 32 characters.
- Can contain spaces, numbers and special characters.
- Can begin with a letter, number or special character.
- These special characters are not allowed: `!"%\|()[{}<>`

### Matrix Objects
- Origin assigns a Short Name -- the matrix object index number -- to each matrix object, as it is created. This name/index number cannot be changed.
- You can add an optional Long Name to the object by clicking on the yellow object icon - \[\] for a data matrix or \[\] for an image matrix - in the upper right corner of the matrix sheet and choosing Rename from the menu.

---

**10.1.2 Different Views of the Matrix**

In the worksheet, a dataset is contained in a single column and the dataset may consist of X, Y, Z, Error, or Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The matrix contains a single dataset of Z values.

- Matrix columns are mapped to linearly-spaced X values.
- Matrix rows are mapped to linearly-spaced Y values.

Note that the matrix window has two column and row heading view modes:

- By default, matrix row and column headings display as row and column index numbers (View: Show Column/Row from the menu or press Ctrl+Shift+C).
- You can opt to view matrix row and column X and Y values by choosing View: Show X/Y from the Origin menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values, calculated by linear interpolation of the axes From and To values by the number of columns and rows.

In addition to the two row and column heading view modes, there are two matrix display modes:

- In Data Mode (View: Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as raw numbers.
- In Image Mode (View: Image Mode from the menu or press Ctrl+Shift+I), the matrix object displays as either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of real numbers or complex numbers displays as a gray-scale image while RGB values will display as a color image.
An image in a matrix can be cropped within the existing window or it can be cropped and copied to create a new matrix window:

1. Make sure that there is a check mark beside Region of Interest Tools on the Tools menu. If this menu item is not checked, select it.

2. Click the Rectangle Tool button on the Tools toolbar.

3. Drag out a rectangular area on the image.

4. Right-click on the rectangle and select Crop from the shortcut menu.
10.1.3 Matrix Books

Like the workbook window, the matrix book window is created from a customizable template (.otm file). The matrix template stores such things as number of sheets in the book, the names of the matrix sheets, matrix dimensions, data type, math functions, data import handling instructions as well as various style and format options.

When you create a new matrix book, the book is named MBookN, with N reflecting the order of window creation. Appended to the book name, you will see something like ":1/3" where the first integer denotes the active matrix object and the second denotes the number of matrix objects in the active matrix sheet. Following the above example, if you click the yellow object icon to the right side of the matrix, the menu shows three matrix objects with the first being the active one - the one with a check mark placed beside it (note that in our illustration, the objects are empty).

**Note:** If the matrix object is an image, the object icon will display as whether you are viewing the matrix object as an image (View:Image Mode) or as numbers (View:Data Mode). Likewise, when the matrix object contains numbers, the object icon will display as regardless of view mode.
10.1.4 Matrix Sheets

A matrix book can have up to 255 matrix sheets. The default matrix book template - ORIGIN.otm - has a single matrix sheet containing 32 rows and 32 columns. Each matrix sheet can differ in dimensions (number of rows and columns and X & Y range).

To specify the dimensions of your matrix window:

1. Make sure that your matrix is the active window and choose **Matrix:Set Dimensions/Labels**. This opens the **Matrix Dimensions and Labels** dialog box.
2. Specify a number of columns (X dimension) and rows (Y dimension).
3. Specify a **From** and **To** value for X (columns) and Y (rows).

**Note:** The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix column and the last X is mapped to the last matrix column. The X coordinates of other columns are interpolated. Matrix rows are similarly mapped using the **From** Y and **To** Y values. When plotting or analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y coordinate values (not column or row index) and the Z value contained in the cell intersected by the row and column.

10.1.5 Matrix Objects

A matrix sheet can contain up to 65,527 matrix objects, though the actual limit is likely to be far less (determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row (Y) headers, but every object can have its own **Z header**. Other matrix object properties include internal data type and numeric display options.

Matrix object properties are set in the user interface via the **Matrix Properties** dialog box.
To open the dialog box:

1. Make sure that the matrix object is active (check mark shows beside it in the object menu).
2. Choose Matrix:Set Properties... from the main menu.

You can set properties for multiple matrix objects without closing the Matrix Properties dialog box by clicking the Previous or Next buttons at the top of the dialog box.

10.2 Virtual Matrix

Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour plots. The data can include a column or row or label row with the X or Y values. Unlike a regular matrix which only supports a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y coordinate values (provided those values are in ascending or descending order).

Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in the X and Y dimensions. This is not considered a "virtual matrix."

10.3 Matrix Templates

Matrix windows are created from a matrix template file (*.otm). The template file saves such things as the number of sheets in the matrix book, the number of rows and columns in each sheet, internal memory allocated for each sheet, mathematical formula used to fill the matrix with numbers and certain ASCII import and export options.
Note: Data are NOT saved with the matrix template file.

To save the active matrix window as a template:

1. With the matrix window active, choose File: Save Template As from the main menu. This opens the template_saveas X-Function dialog box.
2. Select a category from the Category drop-down list or enter a new category.
3. Select or type a file name in the Template Name box (the .otm extension is automatically added).
4. Enter a description into the Template Description text box (optional).
5. Type the file path for the template or click the browse button to locate your folder. Typically, you would save your template to your User Files folder.

The following table lists some of the kinds of things that are saved with the matrix template file. It also tells you where to find these controls.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>What is Saved?</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The Organizer</td>
<td>Right-click on window title bar and choose:</td>
</tr>
<tr>
<td></td>
<td>• The Script Panel</td>
<td>• Show Organizer</td>
</tr>
<tr>
<td></td>
<td>• The Matrix Image Thumbnails</td>
<td>• Show Script Panel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Image Thumbnails</td>
</tr>
<tr>
<td>Matrix Properties</td>
<td>• Matrix Long Name, Units, Comments.</td>
<td>Matrix:Set Properties</td>
</tr>
<tr>
<td></td>
<td>• Column width settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column number Display (decimal, scientific, engineering).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Column Digits and data storage requirements.</td>
<td></td>
</tr>
<tr>
<td>Matrix Dimensions and Labels</td>
<td>• Numbers of rows and columns in the matrix, xy coordinates, XYZ axis labels.</td>
<td>Matrix:Set Dimensions/Labels...</td>
</tr>
<tr>
<td>Set Values</td>
<td>• Formula used to create or transform matrix values.</td>
<td>Matrix: Set Values ...</td>
</tr>
</tbody>
</table>
### 10.4 Simple Manipulation of Matrix Data

<table>
<thead>
<tr>
<th>Utility</th>
<th>Menu Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Flip or Rotate</td>
<td>Matrix: Rotate90</td>
</tr>
<tr>
<td></td>
<td>Matrix: Flip: Vertical</td>
</tr>
<tr>
<td></td>
<td>Matrix: Flip: Horizontal</td>
</tr>
<tr>
<td>• Expand (by interpolation)</td>
<td>Matrix: Expand</td>
</tr>
<tr>
<td>• Shrink (by averaging)</td>
<td>Matrix: Shrink</td>
</tr>
<tr>
<td>• Transpose</td>
<td>Matrix: Transpose</td>
</tr>
<tr>
<td>• Convert to Worksheet</td>
<td>Matrix: Convert to Worksheet</td>
</tr>
</tbody>
</table>

### 10.5 Setting Matrix Values

The **Set Values** dialog box is used to generate or transform data in a matrix object. To open the **Set Values** dialog box, make sure that the matrix object is active, then:

1. From the menu, choose **Matrix: Set Values**.

   or

1. Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix icon/name), then right-click on the matrix and choose **Set Matrix Values** from the shortcut menu.
### Menu Commands

- **Formula**: Load a saved formula into the matrix formula box. Formula are saved using **Formula: Save** or **Formula: Save As**.
- **Mat(1)**: Use the menu to include matrix objects in either your matrix formula or your Before Formula Scripts (matrix object reference is inserted at the cursor). A Matrix Browser is available to help in selecting the correct objects. Objects are listed by object index.
- **Mat(A)**: Similar to Mat(1) menu functionality but matrix objects are listed by object Long Name, if one exists.
- **Function**: Add LabTalk functions to your expressions (function name is inserted at the cursor).
- **Variables**: Add a variable or a constant to **Matrix Formula** or **Before Formula Scripts**: Add range variables (including by selection) or file metadata, to Before Formula Scripts.

### Matrix Formula

- Add a single line expression for generating data. Functions, conditional operators and variables can be used.

### Before Formula Scripts

- Enter one or more lines of LabTalk script to be executed before the expression in the Matrix formula box is executed.
Use the **Before Formula Scripts** panel at the bottom of the **Set Values** dialog box to define variables or LabTalk functions that you wish to use in your matrix formula.

Click the **Search and Insert Functions** button to search for built-in LabTalk functions.

### 10.6 Converting Worksheets to Matrixes

There are four methods for converting worksheet data to matrix data.

<table>
<thead>
<tr>
<th>Method</th>
<th>Conversion Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>X across columns</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y across columns</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No X and Y</td>
<td>Ideal for spreadsheet data that conforms to the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• X data values in the 1st column, Y data values in the 1st row and Z values in columns 2 to N and rows 2 to M.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Y data values in the 1st column, X data values in the 1st row and Z values in columns 2 to N and rows 2 to M.</td>
</tr>
<tr>
<td>Expand</td>
<td></td>
<td>Some ASCII files have an upper limit for characters allowed on a single line. Use this method when your file breaks a single line of data across multiple lines.</td>
</tr>
<tr>
<td></td>
<td>Row</td>
<td>• Expand by <strong>Row</strong> specifies the number of ASCII file rows comprising one matrix row.</td>
</tr>
<tr>
<td></td>
<td>Column</td>
<td>• Expand by <strong>Column</strong> specifies the number of ASCII file columns comprising one matrix column.</td>
</tr>
</tbody>
</table>
### 10.7 Converting Matrixes to Worksheets

There are two methods for converting matrix data to worksheet data:

- **Direct**: This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of M rows by N columns of Z values, this method produces a worksheet which has M rows and N columns. By default, the X and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to the worksheet header and the Y coordinates to the 1st worksheet column.
- **XYZ Columns**: This method produces a worksheet with three columns: an X, a Y and a Z column. The X and Y columns contain the X and Y coordinate values of the matrix Z values. The matrix Z values are contained in the worksheet Z column.

![Matrix Worksheet Example]

### 10.8 Profiling Matrix Data

Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.

1. Activate the matrix object and choose **Plot: Profile: Image Profiles** from the main menu.

This creates an image plot and opens the **Image Profile** dialog box. Use the dialog box to specify X and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the configuration or the appearance of the plots -- without closing the dialog box.
10.9 Topics for Further Reading

- Matrix Books, Matrix Sheets and Matrix Objects
- Matrix Book and Matrix Sheet Operations
- What is Saved with the Matrix Template?
- Matrix Dimensions and XY Coordinates
- Matrix Object Data Properties
- Setting Matrix Values
- Matrix Conversion and Gridding
- Creating 3D and Contour Graphs from a Virtual Matrix
- Viewing and Profiling Matrix Data
11 Graphing

11.1 Creating a Graph

With Origin, you can create over 100 graph types with Origin’s built-in graph templates. Each of these graphs has been specifically chosen for its applications in various technical fields. All plot types are accessible from the Plot menu, 2D Graphs and 3D and Contour Graphs toolbars. Graphs can be created from either data or from mathematical functions.

Creating most graphs involves just two steps.

1. Select your data.
2. Select the plot type.

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple data arrangements. See the Notes in the Origin Graph Types table for specific requirements.

11.1.1 Creating Graphs from Worksheet Data

Origin’s most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and creating a simple graph.

**Tutorial: One click to create graph with selected data**

1. Open a new workbook and select File: Import: Single ASCII... from the main menu.
2. Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open.
3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across the four column headings.
4. Click the Line + Symbol button on the 2D Graphs toolbar. A graph window is created with four line and symbol plots. Note that the plots differ by line color and by symbol type.
5. Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y).
6. This time, select the Plot: Multi-Panel: 4 Panel menu item. Note that a very different plot is created using the same datasets.

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs discusses customizing graphs and saving templates in more depth.
We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a 3D surface plot, then overlaying it with a 3D scatter plot.

**Tutorial: 3D Surface Plot from XYZ Data**

1. Create a new, empty workbook window and import the file `\Samples\Matrix Conversion and Gridding\XYZ Random Gaussian.dat`.

2. Highlight column C and right click. Select Set As: Z from the fly-out menu.

3. Select **Plot: 3D Surface: Color Map Surface** to create a 3D Colormap Surface plot.

4. Select the **Graph: Layer Contents...** menu item or right click the layer icon on the left-top of the graph to open the **Layer Contents** dialog. In this dialog, click on drop-down next to the button and select **3D Scatter/Trajectory/Vector** from the fly-out menu.

5. Select column C from the left panel and click on the **Add Plot** button to add the 3D scatter plot to the graph. Click **OK** to close the dialog.

6. Double-click on the plot to open the **Plot Details** dialog. In the left panel, expand the **Layer1** node and then expand the 2nd node which represents the scatter plot. Click and select the branch named **Original**. Be sure to leave the node-level check box selected, otherwise this plot will be hidden.

7. In the **Symbol** tab on the right side, set **Shape** to **Ball**, **Size** to 12 and **Color** to **Color Mapping: Col(C)**.

8. In the **Drop Lines** tab, clear the **Parallel to Z Axis** check box.

9. Select **Layer1** from the left panel of the **Plot Details** dialog. In the **Lighting** tab, under **Mode**, select **Directional**. Click **OK** to close the dialog.

10. Click on the scatter plot in the graph to select this plot, then in the **Style** toolbar, click on the button and select the **Rainbow** palette.

Your graph should look like this:
You can hold down the R key on your keyboard and use the mouse to freely rotate the surface. With the pointer tool active, click on the layer for additional controls to move, stretch and rotate the surface.

**Worksheet Column Plot Designations**

The labels (X), (Y), (Z), etc. in column headings are referred to as the Column Plot Designation. Columns can also be designated as Label, Disregard, Y Error or X Error. Each plot type has its own data requirements and these work in concert with settings saved in the graph template, to quickly create a graph.

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose **Column: Set as:<option>** or right click and choose an option from the Set As: context menu.

In the 1st tutorial above, we plotted 2D graphs, which require Y data. The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D graph from Z data. The Z data were plotted against X and Y data columns to the left of the Z data column.

**Note:** For a complete explanation of Column Plot Designations and how they affect plotting behavior, consult the Origin Help file topic The Column Properties Dialog Box, Properties tab Settings.
Selecting Worksheet Data

There are a number of ways to select data for plotting:

- **Single column**: Click on the column heading, e.g. B(Y).

- **Multiple columns**: To select a few contiguous columns, click on the first column heading and drag the pointer to the last column heading. To select a large number of contiguous columns, click on the first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the CTRL key while clicking on the desired column heading.

- **A range in a column**: Click on the first cell of the range and drag to the last cell of the range.

- **Multiple ranges within a column**: Select one range. Press the CTRL key while selecting each range. When plotting, each range will be treated as a separate data plot in a plot group.

- **Ranges across multiple columns**: If cells are contiguous, click on the first cell and drag to the last cell. If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be treated as a separate data plot in a plot group.

- **Range(s) across all columns**: Click on the first row heading and drag to the last row heading, to select multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot group.

- **Entire worksheet**: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-pointing arrow, click to select the entire worksheet.

### 11.1.2 Creating a Graph from Matrix Data

As discussed in the Matrix Book, Matrix Sheets and Matrix Objects chapter, a matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix data is used to create 3D, contour and heatmap graphs—all of which require “3D” data. In earlier versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case (see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars still require matrix data.

Note, however, that there are still many situations in which you will be creating 3D plots from matrix data. If you have data in worksheet form and you need to convert it into a matrix form, see Converting Worksheets to Matrixes.

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Note that you cannot select a portion of the matrix when plotting 3D graphs. You can, however, choose a subset of the data plot to display once the graph is created. See Editing Plot Range in the Manipulating Data Plots section of this chapter.

### The Virtual Matrix

Graphing Virtual Matrix DataPlotting Virtual Matrix Data The Virtual Matrix concept was covered in the Matrix Book, Matrix Sheet and Matrix Object chapter of this Guide. To recap, a virtual matrix is block of worksheet cells which contain Z values, with X and Y coordinates in the first row or column label row, and column. X and Y coordinates don’t have to be evenly spaced and can even be in the form of text or date/time data.
When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, Column Plot Designations are ignored and a dialog box is opened where you designate your X and Y coordinates. The intersecting data points are then treated as Z values.

**Tutorial: Contour Plot from Virtual Matrix**

1. With a new workbook active, use the **File: Import: Import Wizard...** menu to open the Import Wizard dialog.

2. Press the browse button in the dialog and select the file *Waterfall.dat* from the **Samples\Graphing** subfolder.

3. This file has an import filter already associated with it. Press the **Finish** button to import the file.

4. With the workbook active, press **CTRL+A** to select the entire sheet.

5. Now select the **Plot: Contour/Heat Map: Contour - Color Fill** menu item. The **plotvm** dialog will open.

6. In the dialog, set the **Y Values in** drop-down to **Column Label**, and then set the **Column Label** drop-down to **Excitation Wavelength(nm)**.

7. Set the **X Values in** drop-down to **1st column in selection**, then press **OK** to close this dialog.

8. The contour plot will be created.

9. Use the **Graph: Speed Mode...** menu item, then in the dialog that opens, set the **Speed Mode** drop-down to **Off** and press **OK**. This will turn off speed mode so that all data points are plotted (see the discussion of **Speed Mode**, below).

10. Click on the contour plot to select this data plot, then from the **Style** toolbar, click the **Palette** button and then select the **Pumpkin Patch** palette. Your graph should look similar to the image below:
Once you customize your contour levels and colors, you can save your settings as a Theme, or simply copy-paste your customizations from one graph to another. To save a Theme, right-click on the graph and choose Save Format as Theme; or use the Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog box.

### 11.1.3 2D and 3D Function Plots

To create function plots and parametric function plots, select File: New: Function Plot menu. There are four options to choose from:

<table>
<thead>
<tr>
<th>Type</th>
<th>Function Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Function Plot</td>
<td>( y = f(x) )</td>
</tr>
<tr>
<td>2D Parametric Function Plot</td>
<td>( x = f_1(t) )  ( y = f_2(t) )</td>
</tr>
<tr>
<td>3D Function Plot</td>
<td>( z = f(x, y) )</td>
</tr>
<tr>
<td>3D Parametric Function Plot</td>
<td>( x = f_1(u, v) )  ( y = f_2(u, v) )  ( z = f_3(u, v) )</td>
</tr>
</tbody>
</table>
These plot types are also accessible from the function plot buttons on the Standard toolbar.

![Function Plot Buttons](image)

**Tutorial: 3D Function and 3D Parametric Function in Same Layer**

1. From the menu, choose File: New: Function Plot: 3D Parametric Function Plot...

2. In the dialog that opens, click on the arrow button at the top right side of the dialog, and from the fly-out menu select the built-in example Partial Torus (System) and press OK to close the dialog. The function plot will be created.

3. With the function plot window active, invoke the menu File: New: Function Plot: 3D Function Plot...

4. In the dialog that opens, enter -5 and 5 for the From and To edit boxes for x and y scale.

5. In the $Z(x,y)$ edit box, enter 0.

6. Set the drop-down at the bottom left corner of the dialog to Add to Active Graph and press OK to close dialog.

7. The $Z=0$ plane will be added to the graph, and the plane will properly intersect the parametric surface plot. You can hold down the R key and use the mouse to freely rotate the plot.
Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions.

For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is created. For 2D function plots, right click the plot and choose Make dataset copy of Function to create data.

Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate Surface... You can even add noise to the plot. Corresponding data is created as well.

11.2 Plotting without Using Column Plot Designations

While Column Plot Designations remain an important concept, they are no longer required by many Origin graphing and analysis operations. The Plot Setup dialog box allows you to freely specify which column is used as X, Y, etc. when plotting, thereby overriding the Column Plot Designations.

In order to make full use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of objects contained in the Origin graph window.

11.2.1 Pages, Layers, Plots and the Active Plot

Layer Icon, Graph Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the white area inside the graph window. Anything that lies outside the page is not printed or exported. By default, the dimensions of the graph page are defined by the printable area of your default printer driver; without adjusting settings, a printed graph should fill the printed page.
The graph page must contain at least one, and may contain as many as 255, graph layers. In turn, each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that the graph in the image above contains three graph layers, represented by the three non-printing layer icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted, indicating the active layer. Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is the first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is active. The active plot will have a check mark beside it.

The hierarchical structure of the graph page can be seen in these places:

- The Plot Details Dialog Box (Format: Page Properties ...)
- The Object Manager (View: Object Manager)
- The Plot Setup Dialog Box (Graph: Plot Setup...)

The graph page in the image above contains a graph of characteristics of samples grown under different conditions. The x-axis represents transition temperature, and the y-axis represents deposition pressure. There are three different sets of data points, each represented by a different symbol and color, indicating the as-grown and annealed conditions.
11.2.2 The Plot Setup Dialog Box

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data plots in an existing graph.

- Creating graphs without regard to Column Plot Designations.
- Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrix books, loose datasets, etc.
- Creating graphs combining multiple plot types.
- Adding, removing, replacing data plots.
- Grouping or ungrouping data plots.
- Reordering data plots in a layer or moving data plots to another layer.
To create a graph with the **Plot Setup** dialog, make sure no data is selected in the active worksheet and choose the plot type.

To open the **Plot Setup** dialog for an existing graph window, right-click on any layer icon in the upper left corner of the graph window and select **Plot Setup**..., or choose menu **Graph: Plot Setup**....

**Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box**

1. Click the **New Workbook** button on the **Standard** toolbar.

2. Click **File: Import: Single ASCII**, browse to the Origin installation folder and import the file `\Samples\Curve Fitting\Step01.dat`. Starting from column B, columns are actually paired - X data and Y data -- but by default all columns are assigned a "Y" Column Plot Designation on import.

3. Without selecting any data, click **Plot: Line: Line**. This opens the Plot Setup dialog box.

4. Click the two "double-arrow" buttons to show all three dialog box panels.

5. In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for Column C (Sensor Ay), then click the **Add** button to add the plot to Layer 1 in the bottom panel.

6. Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By), then click **Add**.

7. Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy), then click **Add**. Three plots are added to Layer 1.

8. Press CTRL and click on each plot in the bottom panel to select all three, then right-click and choose **Group**.

9. Click **OK** to create a grouped line plot.
Tutorial: Creating a Graph with Data from Multiple Worksheets

1. Click the **New Workbook** button on the **Standard** toolbar.

2. Click **File: Import: Multiple ASCII**, browse to the Origin installation folder and select Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve Fitting to import. After Import, 3 workbooks are created.

3. Without selecting any data, click **Plot: Line+Symbol: Line+Symbol**. This opens the Plot Setup dialog box.

4. Expand the top panel if it is hidden. From the **Available Data** list, choose **Worksheets in Folder**.

5. Select Sensor01, Sensor02 and Sensor03 sheets in the top panel.

6. In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box for Column B (Sensor Output), then click the **Add** button.

7. Click **OK** to create a grouped Line+Symbol plot using Sensor Output columns from 3 worksheets.

![Plot Setup: Configure Data Plots in Layer](image)
The Plot Setup middle panel only allows choosing one X column at a time.

If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) but you only want columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns and select all columns with same Long Name and plot them together. The Y columns will be plotted against corresponding X columns.

To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button.

All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a group, right-click the Group node in bottom panel and Ungroup first.

Drag and drop data plots to move them to different layers.

If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click the OK button to create your graph.

11.3 Manipulating Data Plots

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed plot customizations, including those involving such things as changing plot symbols, colors, and legend customizations, see the Customizing Graphs chapter.

The following methods of manipulating data plots in the graph window are fairly easy to use. Thus, you may want to choose File: Open Template and pick your template to create a blank graph window. Then, using the methods below you can add and group data plots in the graph.

11.3.1 Changing Plot Type

Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing plot with a few other select plot types. Some examples:

- Scatter, line, line+symbol, column/bar are interchangeable.
- 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable.

To change the plot type of an existing plot:

- Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu.
- Click on the data plot and choose Format: Plot Properties and in Plot Details choose from the Plot Type drop-down list.
• Click on the data plot, then click one of the supported graph toolbar buttons.

Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are switched.

For more information on switching plot types, see Fast Switching of Plot Types in the Origin Help file.

11.3.2 Exchanging Data Plots

Worksheet Plot Designations You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands. Right-click on a data plot, then select one of these options:

• Change X. This menu item allows you to change the assignment of X data to another data column in the same worksheet.

• Change Y. This menu item allows you to change the assignment of Y data to another data column in the same worksheet.

• Change Worksheet. This menu item allows you to replace both X and Y with data from another worksheet. The selected worksheet should have the same Short Names, the same Column Plot Designations and the same row index range as the current worksheet.

If you have a grouped data plot, then clicking once on any of the plots in the group will select the entire group. Click a second time to select a particular member of the group. The context menu options to change worksheet, X, or Y are available only when a single data plot is selected.

Tutorial: Changing X and Y assignment of a data plot

1. Start with a new workbook and import the file automobile.dat from the Samples\Statistics sub-folder of the Origin installation folder.

2. Select the Gas Mileage column and select the Plot: Symbol: Scatter menu item. The Gas Mileage column is plotted against the default X column Year.

3. Right-click on the data plot and select Change X: Engine Displacement. The Gas Mileage column is now plotted against Engine Displacement.

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the graph should be rescaled. If data are not significantly different, you may want to manually rescale the graph (Hot key: CTRL+R).

If you perform analysis on the data plot (e.g. linear regression with Recalculate set to Auto), the fit results will automatically update when you change X/Y or the worksheet.
11.3.3 Adding, Removing and Hiding Data Plots

Use the following methods to add or remove data plots from a graph.

Adding Data with the Add Plot to Layer Menu Command

This is a simple method for adding a range of data to an existing Line, Scatter, Line + Symbol, Column or Area graph:

1. Highlight your worksheet data.
2. Go to the graph window where you want to add data. If there are multiple layers in the graph, press the layer icon to activate the desired layer.
3. From the menu, choose Graph: Add Plot to Layer: Graph Type.

- You can use the Graph: Add Error Bars... menu item to add error bars, calculated from statistics such as standard deviation.
- Error data will be output beside the data column in the worksheet. This only works for the active plot. You can set the active plot from the Data menu. The active plot has a check mark beside it.

Adding Data by Drag and Drop

You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column Plot Designations to create the plot.

1. Select the worksheet data (one or more columns or a range of one or more columns).
2. Move the mouse over the left or right edge of the selected range.
3. When the pointer looks like this, hold down the left mouse button and drag the data to the graph window. Release the mouse.
4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse.

Usually the current plot type is used when plotting by drag-and-drop. To change the global plot type to use when drag and drop, choose Tools: Options... from the main menu. Go to the Graph tab and change the global Drag and Drop plot type.
Adding and Removing Data with the Layer Contents Dialog Box

Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right panel lists datasets that are plotted in the active layer.

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the layer.

Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box

Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.

1. To add plots to the graph, use the top panel of Plot Setup to identify your source data.
2. Use the controls in the middle panel to specify the plot type and how the data selection should be treated (as X, Y, yError or Label).
3. In the bottom panel, choose the Layer to which you want to add plots, then click the Add button.
4. To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.
5. To hide a plot, uncheck the Show check box for the plot.
6. To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in middle panel and click the Replace button.

Adding Data by Direct ASCII Import

You can import ASCII files directly into the active graph window using the the **Import ASCII** toolbar button. Note that this method works only with files having a simple structure and it supports only the simplest of graph types - **Line**, **Scatter**, **Line + Symbol**, **Column** and **Bar** charts.

1. Click the **Import ASCII** button. This opens the Import ASCII dialog box.
2. Choose a file.
3. Click **Open**.

The file is imported and plotted in the active graph window.

Adding Data by Copying and Pasting a Plot

You can copy a plot from an existing graph window and paste it into the same or another window.

1. Click on the plot to select it and press CTRL+C.
2. Click on the target graph and press CTRL+V.

Simultaneously, a ClipbN worksheet is created. You can open this worksheet by double-clicking on the plot, then clicking the **Workbook** button at the bottom of Plot Details; or right-click on the plot in the graph window or in the Object Manager and choose Create worksheet ClipbN.

Removing or Hiding Plots with the Object Manager

The **Object Manager** is a new, dockable panel that allows for easy manipulation of graph layers and data plots. See the section on **The Object Manager** in this Guide.
To hide or remove plots, right-click on a plot and choose from the shortcut menu:

- To show or hide plots of the same Long Name.
- Show all plots.
- Remove a plot from the graph window (not the same as hiding).

- When you right-click on a plot, there is a **Remove** shortcut menu item. If the plot is part of a **group**, the entire group will be removed.
- When you right-click on a plot, you can use the **Hide Data Plot** and **Hide Others** shortcut menu items to quickly hide selected plots (restore plots by enabling their display in the **Object Manager** or in **Plot Details**).

**Removing or Hiding Data with Plot Details**

In the left panel of the Plot Details dialog box (**Format: Plot Properties**), right-click on a plot and choose **Remove** or **Hide** from the context menu. **Remove** will delete the data plot from the graph so if you just want to temporarily hide a plot, choose **Hide**. Neither of them will delete data from worksheet or matrix.

**Deleting Plots using the Delete Key**

Click on a data plot (either in the graph window or Object Manager) and press the **Delete** key. If the selected plot is part of a group, the entire group is deleted. This action does not delete worksheet or matrix data. To restore the deleted plots, choose **Edit: Undo Remove Plot** from the main menu.

**Editing Plot Range**

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:
• Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To values.

• In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column by right-clicking on the column headings and choosing Range. Click on a plot’s range values, then click the ... button that appears to the right side of that column.

• In the bottom panel of Plot Setup (Graph: Plot Setup), Click on the plot range in the Range column and click ... button that appears to the right side of that column.

Choose Graph: Rescale to Show All menu to rescale the graph after editing plot range.

11.3.4 Grouping Data Plots

When you make multiple range or column selections, then create a graph, Origin groups the resulting data plots in the graph layer. This applies to most 1D (statistical), 2D or a 3D XYY graphs (3D bar, 3D ribbon, 3D wall, and 3D waterfall plots).

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, triangle...; etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list of styles. For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot might be denoted by a red line (the second color in the color list), the third plot by a green line (the third color in the color list), and so on.

Tutorial: Creating a simple grouped data plot

1. Open a fresh worksheet and click the Import Single ASCII button on the Standard toolbar.

2. Browse to the Samples\Graphing subfolder in the Origin software folder and Open GROUP.DAT.

3. Select B(Y), C(Y), and D(Y) columns

4. Click the Line & Symbol button on the 2D Graphs toolbar. Note that line and symbol color and symbol type are automatically differentiated for each plot.

Tutorial: Grouping (or ungrouping) plots manually

• Via the Layer Contents dialog box

1. To open the Layer Contents dialog box, double-click on the layer n icon in upper-left corner of the graph window.

2. To create a group, select the desired data sets from the Layer Contents list (use CTRL + select, SHIFT + select, or simply drag the mouse to select
3. Click **Group**. Note that each plot in Layer Contents is now preceded by a **gn** (for "group1", "group2", etc.).

4. To ungroup, click on one of the grouped data plots in the **Layer Contents** list and click **Ungroup**.

- **Via the Plot Setup dialog box**

1. To open the **Plot Setup** dialog box, ALT + double-click on the **layer n** icon in upper-left corner of the graph window.

2. To create a group, select the desired plots from the **Plot List** (use the CTRL or SHIFT keys to select multiple data sets).

3. Right-click and select **Group**. Note that a **Group** icon now precedes the selected plots in the **Plot List**.

4. To ungroup, right-click on the **Group** icon and choose **Ungroup** from the shortcut menu.

### 11.3.5 Speed Mode

With **Speed Mode**, you can control the number of data points displayed in a graph layer. This option is most useful when working with large data sets. Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in red and a **Speed Mode is On** watermark appears in the layer. The watermark is *not included when printing, copying, or exporting the graph.*
To adjust Speed Mode settings:

1. With your graph active, select **Format: Layer Properties** from the Origin menu.

2. Select the **Size/Speed** tab.

3. For plots created from worksheet data, Select the **Worksheet Data, Maximum Points Per Curve** check box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n, Origin displays a subset of the data plot containing n points, drawn by extracting values at regular intervals from the data set.

4. For 3D data plots created from a matrix or for contour data in the layer, Select the **Matrix Data, Maximum Points Per Dimension** check box to enable Speed Mode. Type the desired value (n, m) in the X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at regular intervals from the matrix columns (X) and rows (Y).

**Note:** Click the **Enable/Disable Speed Mode** button on the Graph toolbar, to toggle Speed Mode on/off for all layers in the graph window.

Alternatively, you can select **Speed Mode** from the **Graph** menu which opens the **speedmode X-Function** dialog. The dialog lets you specify a number of options for where your changes should apply (**Target**) as well as a range of Speed Mode settings from **Off** to **On - High**.

To turn off the **Speed Mode is On** watermark:

1. Select **Tools: Options** to open the Options dialog box.

2. Select the **Graph** tab and clear the **Speed Mode Show Watermark** check box.

**Notes on Speed Mode:**

- The Speed Mode controls on the **Size/Speed** tab of the layer’s Plot Details only apply to what you see on screen. They do not apply to graphs that are printed or exported, by default. If you wish to **skip points** in printouts, use controls in the **Print** dialog. See the discussion of the Skip Points feature as it applies to some graph windows in the Origin Help file. If you wish to apply Speed Mode settings to graphic export, please see this discussion of **Performance Group** controls on the **Miscellaneous** tab of the Plot Details dialog box or use controls under **Export Settings** node in **Graph Export** dialog.

- All Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for a particular graph type, you will have to resave the graph template to make those changes permanent.

- Always exercise caution when using Speed Mode. Since Speed Mode systematically weeds out a portion of your data points, it should be kept in mind that any graph in which Speed Mode is turned on, may -- or may not -- accurately represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and compare Speed Mode settings to ensure that trends in your data are accurately depicted.
11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and Printing

There are a number of ways to present your finished graph.

- Copy a graph page and paste it in other applications such as Word, Powerpoint, etc.
- Export graph page as an image file (raster or vector).
- Send Graphs to Powerpoint.
- Printout.
- Slideshow within Origin.
- Create Movies.

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading" there.

11.5 Origin Graph Types

Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Typically, this means an "X" column and one or more "Y" columns (or a sub-range of one or more Y columns). A few graphs require an additional error bar column. Of the 3D and contour graph types, some are created from XYZ worksheet data; some are created from a particular worksheet data arrangement that we call a Virtual Matrix; and some are created from Matrix window data.

If you have not read previous sections of this Guide, you might want to skim the Workbook and Matrix chapters before moving ahead, paying particular attention to these sections:

- Different Views of the Matrix (Chapter 9)
- Virtual Matrix (Chapter 9)
- Creating a Graph from Worksheet Data (this chapter)
- Worksheet Data and Column Plot Designations (this chapter)

The following table is a comprehensive list of all supported graph types. Graph types are shown grouped and in the approximate order in which they appear in the Plot menu. The toolbar button precedes the graph name and the Notes column provides information on the data arrangement needed to make the basic graph.

To create your graph, highlight the required data and click one of the graphs listed in the Plot menu. Alternately, you can click one of the buttons on the 2D Graphs or 3D and Contour Graphs toolbars.
<table>
<thead>
<tr>
<th>Plot Menu</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Line** | ![Line](image1) Line ![Horizontal Step](image2) Horizontal Step ![Vertical Step](image3) Vertical Step ![Spline Connected](image4) Spline Connected | • Start with a Worksheet.  
• Select one or more Y columns or at least a portion of one Y column.  
• Multiple Y columns are grouped in layer.  
• If there is an associated X column, X column supplies X values; otherwise, default X values are used. |
| **Symbol** | ![Scatter](image5) Scatter ![Scatter Central](image6) Scatter Central ![Column Scatter](image7) Column Scatter ![Y Error](image8) Y Error ![XY Error](image9) XY Error ![Vertical Drop Line](image10) Vertical Drop Line ![Bubble](image11) Bubble ![Color Mapped](image12) Color Mapped ![Bubble + Color Mapped](image13) Bubble + Color Mapped | • Start with a Worksheet.  
• Select one or more Y columns or at least a portion of one Y column.  
• For Color Mapped, Indexed and Error Bar graphs, Y columns of values to the right of the Y column supply colormap, index and error bar values.  
• If there is an associated X column, X column supplies X values; otherwise, default X values are used. |
| **Line + Symbol** | ![Line + Symbol](image14) Line + Symbol ![Line Series](image15) Line Series ![2 Point Segment](image16) 2 Point Segment ![3 Point Segment](image17) 3 Point Segment | • Start with a Worksheet.  
• Select one or more Y columns or at least a portion of one Y column.  
• Multiple Y columns are grouped in layer (except Line Series).  
• For Line Series graph, select 2 or 3 Y columns.  
• If there is an associated X column, X column supplies X values; otherwise, default X values are used. |
<table>
<thead>
<tr>
<th>Plot Menu</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column/Bar/Pie</td>
<td>- Column</td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Column + Label</td>
<td>• For Pie charts, select one Y column.</td>
</tr>
<tr>
<td></td>
<td>- Grouped Column-Indexed Data</td>
<td>• For Bar, Column or Column + Label, select one or more Y columns (multiple Y columns are grouped in layer).</td>
</tr>
<tr>
<td></td>
<td>- Bar</td>
<td>• For Floating Bar/Column, select two Y columns.</td>
</tr>
<tr>
<td></td>
<td>- Stacked Column</td>
<td>• For Stack graphs, select two or more Y columns.</td>
</tr>
<tr>
<td></td>
<td>- Stacked Bar</td>
<td>• If there is an associated X column, X column supplies X values; otherwise, default X values are used.</td>
</tr>
<tr>
<td></td>
<td>- 100% Stacked Column</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- 100% Stacked Bar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Floating Column</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Floating Bar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- 3D Color Pie Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- 2D B&amp;W Pie Chart</td>
<td></td>
</tr>
<tr>
<td>Multi-Y</td>
<td>- Double-Y</td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>- 3Ys Y-YY</td>
<td>• Select two or more Y columns.</td>
</tr>
<tr>
<td></td>
<td>- 3Ys Y-Y-Y</td>
<td>• Multiple Y Axes opens interactive dialog. Choose plot type, number of axes, plots per layer, axis color to match plot, etc.</td>
</tr>
<tr>
<td></td>
<td>- 4Ys Y-YYY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- 4Ys YY-YY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Multiple Y Axes...</td>
<td></td>
</tr>
<tr>
<td>Y-Offset/Waterfall</td>
<td>- Stack Lines by Y Offsets</td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>- 3D Waterfall</td>
<td>• Select at least two Y columns (or a range of at least two Y columns). If the Y columns have an associated X column, the X column is used; otherwise the worksheet's default X values are used.</td>
</tr>
<tr>
<td></td>
<td>- 3D Waterfall Y:Color Mapping</td>
<td>• The 3D Waterfall is based on 3D OpenGL technology and with enhanced features and faster speed.</td>
</tr>
<tr>
<td></td>
<td>- Waterfall</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Waterfall Y:Color Mapping</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Waterfall Z:Color Mapping</td>
<td></td>
</tr>
<tr>
<td>Plot Menu</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multi-Panel</td>
<td>• Vertical 2 Panel</td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Horizontal 2 Panel</td>
<td>• Select at least two Y columns (or a range of at least two Y columns). If the Y columns have an associated X column, the X column is used; otherwise the worksheet's default X values are used.</td>
</tr>
<tr>
<td></td>
<td>• 4 Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 9 Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Stack...</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Multiple Panels by Label...</td>
<td></td>
</tr>
<tr>
<td>3D XYY</td>
<td>• XYY 3D Bars</td>
<td>• Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>• 3D Ribbons</td>
<td>• Select at least two Y columns (or a range of at least two Y columns). If Y columns have associated X, then the X column is used; otherwise, the worksheet's default X values are used.</td>
</tr>
<tr>
<td></td>
<td>• 3D Walls</td>
<td>• For XYY 3D Bars, Y value of each data point is used for height of column.</td>
</tr>
<tr>
<td></td>
<td>• 3D Waterfall</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 3D Waterfall Y:Color Mapping</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 3D Waterfall Z:Color Mapping</td>
<td></td>
</tr>
<tr>
<td>3D Surface</td>
<td>• Color Fill Surface</td>
<td>• Color Fill Surface, Colormap Surface w/ Projection, Color Fill Surface w/ Error Bar, Wire Frame, Wire Surface: <strong>XYZ, Virtual Matrix, Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>• X Constant with Base</td>
<td>• X Constant w/ Base, Y Constant w/ Base: <strong>Virtual Matrix, Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Y Constant with Base</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Color Map Surface</td>
<td>• Color Fill Surface w/ Error Bar, Color Map Surface w/ Error Bar, Multiple Color Fill Surfaces, Multiple Color Map Surfaces: <strong>Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Colormap Surface with Projection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Color Fill Surface with Error Bar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Colormap Surface with Error Bar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Multiple Color Fill Surfaces</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Multiple Colormap Surfaces</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Wire Frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 3D Ternary Colormap Surface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 3D Ternary Colormap Surface</td>
<td></td>
</tr>
</tbody>
</table>

**Graphing**
<table>
<thead>
<tr>
<th>Plot Menu</th>
<th>Graph Types</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Symbol/Bar/Vector</td>
<td><a href="#">3D Bars</a></td>
<td>• 3D Bars, 3D Scatter: XYZ, Virtual Matrix, Matrix.</td>
</tr>
<tr>
<td></td>
<td><a href="#">3D Scatter</a></td>
<td>• 3D Trajectory, 3D Vector XYZ XYZ, 3D Vector XYZ dXdYdZ: XYZ.</td>
</tr>
<tr>
<td></td>
<td><a href="#">3D Trajectory</a></td>
<td>• 3D Scatter + Error Bars: XYZ, Matrix.</td>
</tr>
<tr>
<td></td>
<td><a href="#">3D Scatter + Error Bars</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">3D Vector XYZ XYZ</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">3D Vector XYZ dXdYdZ</a></td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td><a href="#">Box Chart</a></td>
<td>• Histogram: Worksheet, Matrix.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Grouped Boxes - Indexed Data</a></td>
<td>• All other types, Worksheet only.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Grouped Boxes - Raw Data</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Interval Plot</a></td>
<td>• For Histogram + Probabilities, Pareto Chart - Raw Data, Probability Plot, and Q-Q Plot, select exactly one Y column.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Histogram</a></td>
<td>• For Box Chart and QC (X Bar R), select one or more columns.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Histogram + Probabilities</a></td>
<td>• For Histogram, select one or more columns, or a matrix.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Stacked Histograms</a></td>
<td>• For Pareto Chart - Binned Data, select two Y columns.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Marginal Histograms</a></td>
<td>• For Scatter Matrix and Stacked Histograms, select two or more Y columns.</td>
</tr>
<tr>
<td></td>
<td><a href="#">Marginal Boxes</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">2D Kernel Density</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">QC (X bar R) Chart</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Pareto Chart - Binned Data</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Pareto Chart - Raw Data</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Scatter Matrix...</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Probability Plot</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Q-Q Plot...</a></td>
<td></td>
</tr>
<tr>
<td>Plot Menu</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Area</td>
<td>Area</td>
<td>- Start with a <strong>Worksheet</strong>.</td>
</tr>
<tr>
<td></td>
<td>Stack Area</td>
<td>- For Area Graph, select at least one Y column.</td>
</tr>
<tr>
<td></td>
<td>Fill Area</td>
<td>- For Stack Area Graph, select at least two Y columns.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- For Fill Area Graph, select two Y columns.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If the Y column(s) has an associated X column, the X column supplies the X values; otherwise, the worksheet's default X values are used.</td>
</tr>
<tr>
<td></td>
<td>B/W Lines + Labels</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Gray Scale Map</td>
<td>- Heat Map: <strong>Virtual Matrix</strong>, <strong>Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>Heat Map</td>
<td>- Polar Contour theta(X)r(Y): <strong>XYZ</strong>, <strong>Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>Polar Contour theta(X)r(Y)</td>
<td>- Polar Contour r(X)theta(Y): <strong>XYZ</strong>.</td>
</tr>
<tr>
<td></td>
<td>Polar Contour r(X)theta(Y)</td>
<td>- Ternary Contour: <strong>XYZZ</strong>.</td>
</tr>
<tr>
<td>Profiles &amp; Image</td>
<td>Contour Profiles</td>
<td>- Contour Profiles: <strong>XYZ</strong>, <strong>Virtual Matrix</strong>, <strong>Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>Image Plot</td>
<td>- Image Profiles: <strong>Virtual Matrix</strong>, <strong>Matrix</strong>.</td>
</tr>
<tr>
<td></td>
<td>Image Profiles</td>
<td>- Image Plot: <strong>Matrix</strong>.</td>
</tr>
<tr>
<td>Plot Menu</td>
<td>Graph Types</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| Specialized | ![Polar theta(X) r(Y)](image) | - Start with a **Worksheet**.  
- For Polar graphs, select at least one pair of XY columns. For Polar theta(X) r(Y) plot, X should contain Angular data and Y is the Radius; for Polar r(X) theta(Y), X is the Radius and Y is Angular data. |
| | ![Polar r(X) theta(Y)](image) | - For Piper diagrams, select XYZXYZ columns. |
| | ![Wind Rose - Binned Data](image) | - For Radar/Spider Chart, select one Y column. The X column displays as the title of the radial axis around the chart. |
| | ![Wind Rose - Raw Data](image) | - Vector XYAM needs three Y columns. |
| | ![Ternary](image) | - Vector XYXY needs two X, two Y columns. |
| | ![Piper](image) | - Wind Rose and Smith Charts require one or more Y columns. |
| | ![Smith Chart](image) | - Ternary plot requires Z column. |
| | ![Radar](image) | - Start with a **Worksheet**. |
| | ![Vector XYAM](image) | - High-Low-Close requires three Y columns. |
| | ![Vector XYXY](image) | - Japanese Candlestick and OHLC charts require four Y columns. |
| Stock | ![Zoom](image) | - OHLC-Volume requires five Y columns. |
| | ![High-Low-Close](image) | - Line (Stock) requires one or more Y columns. |
| | ![Japanese Candlestick](image) | - If there is an X column to the left of the Y columns, this X column is used; otherwise, the worksheet’s default X-values are used. |
| | ![OHLC Bar Chart](image) | - OHLC-Volume requires five Y columns. |
| | ![OHLC-Volume](image) | - Line (Stock) requires one or more Y columns. |
| | ![Line (Stock)](image) | - If there is an X column to the left of the Y columns, this X column is used; otherwise, the worksheet’s default X-values are used. |
Origin project files featuring a sampling of 2D and 3D graph types are included with your Origin software. To view these graphs choose **File: Open Sample Projects** from the main menu.

### 11.6 Topics for Further Reading

- [The Page-Layer-Plot Hierarchy](#)
- [Page Viewing Modes](#)
- [Graph Axes](#)
- [Creating Graphs from Graph Templates](#)
- [Creating Multi Layered Graphs](#)
- [Adding Data Plots to the Graph Layer](#)
- [The Layer Contents Dialog Box](#)
- [The Object Manager](#)
- [Graph Layers](#)
- [Linking Layers](#)
- [3D and Contour Graphing](#)
- [Plotting Mathematical Functions](#)
12 Customizing Graphs
12.1 Introduction

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph template. If the graph is fairly standard for its type, the options that were stored in the graph template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation was covered in the last chapter, Graphing.

Sooner or later, however, you are going to want to add annotations, modify axis scales or change plot colors. Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and techniques and to point you toward resources that will help you manage more complex graph customization tasks.

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are commonly used for quick modifications of graph elements.

12.2 Toolbars

Toolbar buttons useful for graph-customization tasks:

<table>
<thead>
<tr>
<th>Description</th>
<th>Toolbar (default configuration)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format toolbar buttons:</strong></td>
<td><img src="" alt="Format Toolbar" /></td>
</tr>
<tr>
<td>• Creating and customizing text objects.</td>
<td></td>
</tr>
<tr>
<td><strong>Style toolbar buttons:</strong></td>
<td><img src="" alt="Style Toolbar" /></td>
</tr>
<tr>
<td>• Editing colors, line thickness, fill patterns.</td>
<td></td>
</tr>
<tr>
<td><strong>Tools toolbar buttons:</strong></td>
<td><img src="" alt="Tools Toolbar" /></td>
</tr>
<tr>
<td>• Add text objects, lines, arrows, rectangles, circles, polygons.</td>
<td></td>
</tr>
</tbody>
</table>
Customizing Graphs

<table>
<thead>
<tr>
<th>Description</th>
<th>Toolbar (default configuration)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graph toolbar buttons:</strong></td>
<td>![Graph toolbar image]</td>
</tr>
<tr>
<td>- Add graph layers incl. inset graphs, merging or extracting graphs; exchanging axes; anti-aliasing and Speed Mode.</td>
<td></td>
</tr>
<tr>
<td><strong>Add Object to Graph toolbar buttons:</strong></td>
<td>![Add Object to Graph toolbar image]</td>
</tr>
<tr>
<td>- Add legends/color scales/bubble scales; date &amp; time and project path stamps; XY scale; table objects.</td>
<td></td>
</tr>
<tr>
<td><strong>Object Edit toolbar buttons:</strong></td>
<td>![Object Edit toolbar image]</td>
</tr>
<tr>
<td>- Arranging and aligning objects and layers on the page.</td>
<td></td>
</tr>
</tbody>
</table>

**12.3 Menus and Dialog Boxes**

Many graph customizations are initiated via commands on the Graph menu. Options for customization are explained in the sections below. The following table lists key dialog boxes used for customizing graphs:

<table>
<thead>
<tr>
<th>Task</th>
<th>Dialog Name</th>
<th>Method</th>
</tr>
</thead>
</table>
| Customize the graph Page, Layer, or Data Plot | **Plot Details** dialog | • Double click on Page, Layer or Data Plot  
• Format: Page Properties... menu  
• Format: Layer Properties... menu  
• Format: Plot Properties... menu |
<table>
<thead>
<tr>
<th>Task</th>
<th>Dialog Name</th>
<th>Method</th>
</tr>
</thead>
</table>
| Customize Axes | Axis Dialog | Double click on axes or tick labels  
| | | Format: Axes... menu  
| | | Format: Axis Tick Labels... menu  
| | | Format: Axis Titles... menu  |
| Add or Customize Legend | Update Legend dialog | Right click legend and choose Legend: Update Legend  
| | | Graph: Legend: Update Legend... menu  
| | | Legends/Titles tab at page level of Plot Details dialog  |
| Merge multiple graph windows into one graph window | Merge Graphs dialog | Graph: Merge Graph Windows... menu  |
| Layer level customizations: resize, move, swap, align, or add layers | Layer Management dialog | Graph: Layer Management... menu  |
| Save settings as graph template | Save Template As dialog | File: Save Template As... menu  
| | | Right click graph window title and choose Save Template As...  |
| Manage graph templates, add plots to a template | Template Library dialog | Plot: Template Library... menu  |
| Save settings as graph Theme | Save Format as Theme dialog | Right click and choose Save Format as Theme... context menu  |


<table>
<thead>
<tr>
<th>Task</th>
<th>Dialog Name</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Graph Themes: edit, combine, apply Theme, set as System Theme</td>
<td><strong>Theme Organizer</strong> dialog</td>
<td>• Tools: Theme Organizer.. &gt; Graph tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• F7 hotkey.</td>
</tr>
</tbody>
</table>

**12.4 Customizing Page, Layer and Data Plots**

A graph has a collection of editable properties at the page, layer and data plot levels. Quick formatting of some graph properties can be done using toolbar buttons, as discussed above. However, the vast majority of properties are customized via Origin's **Plot Details** dialog box.

- The left panel depicts the `Page > Layer > Plot` hierarchy as an expandable/collapsible tree.
- The right panel lists controls that pertain to the object that is currently selected in the left panel.
- To customize an object, select it in left panel and modify the corresponding properties that appear on the various tabs in the right panel.
<table>
<thead>
<tr>
<th>Selected Left Panel Object</th>
<th>Right Panel, Controls for...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>Print/Dimensions, layer drawing orders, page display color, legends/titles.</td>
</tr>
<tr>
<td>Layer</td>
<td>Layer background colors, layer size and speed mode settings, layer display settings, stack settings for applicable plot types. Some plot types will include extra tabs/controls specific to the plot type.</td>
</tr>
<tr>
<td>Data Plot</td>
<td>Plot specific properties. The tabs and controls are pertinent to the plot type.</td>
</tr>
<tr>
<td>Data Point</td>
<td>Point specific properties. Available for some plot types. The tabs and controls are generally similar to those available at the Data Plot level.</td>
</tr>
</tbody>
</table>

---

Prevent text and label objects from scaling when resizing layer, by going to the **Display** tab of Plot Details (at the Layer level) and setting **Fixed Factor** to 1.
12.4.1 Customizing Grouped Plots

When you select and plot multiple data ranges in a single graph layer, the plots are *grouped* in the layer. By default, grouped plots are automatically differentiated by varying one or more plot properties according to some incrementing scheme that is saved with the graph template (.ogg) or Theme file (.oth).

The above image shows Group tab settings for a line + symbol plot. The first column lists Line Color, Symbol Type, Line Style and Symbol Interior. Line Color and Symbol Type are set to Increment By One, while Line Style and Symbol Interior are set to None (does not increment). These happen to be the Origin default settings for the standard line + symbol graph template, but the template can be modified and saved with new default settings.

To customize individual plots in a plot group, open Plot Details, select the first data plot in the plot list, click on the Group tab and set Edit Mode to Independent. Then select each plot on left panel and customize its plot properties. Alternately, you can ungroup data plots by double-clicking on one of the graph's Layer icons to open the Layer Contents dialog box. Select the grouped data plots in right panel and click the Ungroup button at the top of the dialog box. Then select each plot in left panel and customize it.

12.4.2 Customizing Individual Data Points

For some plot types such as scatter and column, you can modify the display properties of a single data point. This is another plot customization that happens via the Plot Details dialog box. To edit a single point, press the CTRL key and double-click on the data point in the graph. This opens the Plot Details dialog box with the focus set to edit this data point. Note that the data point will be identified in
the left-panel of Plot Details by its row index number. Use the controls on the tabs in the right panel to modify the appearance of the data point. Changes you make will not affect the appearance of other points in the data plot.

To remove customizations made to a single data point:

- Right-click the single point in the left panel of the Plot Details dialog and choose **Remove**.
- In the graph window, click on the single point to select it, then press DELETE on the keyboard.

The point properties revert to those of the containing dataset.

### 12.5 Customizing Graph Axes

Most graph axis customizations are made via the **Axis Dialog** box. Double-click on the graph axis or tick labels to open the **Axis Dialog - Layer N** dialog box (note that in multi-layer graphs, each layer may have a separate axis dialog box).

This image shows the tab-based axis dialog used by most 2D and 3D graphs.
In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify the axis or axes to be customized, then select the desired tab and choose your options.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Controls for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Scale range of values, scale type, rescale mode and margin, reverse scale, major and minor ticks.</td>
</tr>
<tr>
<td>Tick Labels</td>
<td>Display and format options for major and minor tick labels, including custom labeling by formula.</td>
</tr>
<tr>
<td>Title</td>
<td>Axis title (often set using variable notation) and font options. Note that you can directly edit by double-clicking the text object in the graph.</td>
</tr>
<tr>
<td>Grids</td>
<td>Control display and properties of grid lines at major and minor ticks.</td>
</tr>
<tr>
<td>Line and Ticks</td>
<td>Global axis line and tick display options for all axes.</td>
</tr>
<tr>
<td>Special Ticks</td>
<td>Placement of special tick labels.</td>
</tr>
</tbody>
</table>
Recognize the **Enable line breaks and configure each break.**

Click the **Apply To...** button to selectively apply the axis format settings of one axis to another axis.

**Note:** For more information on axis customization and for axis controls for specialized graph types (e.g. polar, ternary, radar chart, etc), refer to:

**Help:** Origin: Origin Help > Graphing > Graph Axes

## 12.6 Graph Legends

### 12.6.1 Auto Creation of the Graph Legend

A graph legend is automatically created when you plot data. For 2D and some 3D graph templates, Origin creates a default legend that combines plot style information with dataset information (metadata) and places the resulting label object in the upper-right corner of the graph page.

The default legend object is created using LabTalk substitution notation. The reason for this is:

- The legend object is able to incorporate identifying information that has been entered into the worksheet column headings either manually, or automatically on file import.

- The legend object is dynamically linked to the plotted data so that the legend can be updated when data are added or removed from the graph. The substitution notation becomes visible when you double-click inside of the legend object (as if to edit it).

![Legend Examples](image)

The notation used for legend texts is controlled by the **Translation mode of %1, %2 list** in the **Legends/Titles** tab of the **Plot Details** dialog box (**Format: Page**). Custom format of the notation(s) is supported.

- To prevent auto creation of a graph legend, create and customize your graph, then delete the legend object and **save the graph template to a new name**.

- Right-click the legend object for some useful controls such as **Reverse Order**, **Show Legend for Visible Plots Only**, and **Hide Legend for Fitted**.
Customizing Graphs

Curves.

- Select the legend object; then press CTRL while dragging a selection handle to change the layout of the legend (e.g. drag horizontally to create a legend that is all on one line).
- Double-click the legend text to go to in-place edit mode. Double-click a legend symbol to open the Plot Details dialog box with corresponding plot selected.

12.6.2 Adding and Updating the Graph Legend or Scale Object

There are a number of reasons for modifying the default graph legend. We suggest that you look at this topic in the online documentation to see what sort of customizations are supported. Before attempting to customize the data plot legend, you should know the difference between updating a legend and reconstructing a legend: Updating will preserve any previous customizations, reconstructing will not. Also, it should be noted that the graph template stores a Legend Update Mode setting that determines how the legend is refreshed when adding or removing data plots from the graph. For more information, see Legend Update Mode.

This table lists tasks associated with creating and customizing the default legend and where to find controls for each.

<table>
<thead>
<tr>
<th>Task</th>
<th>Method (graph is active)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or reconstruct legend</td>
<td>- Graph: Legend: Reconstruct Legend menu.</td>
</tr>
<tr>
<td></td>
<td>- New Legend button (Add Object to Graph toolbar).</td>
</tr>
<tr>
<td></td>
<td>- CTRL+L.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Customizations made to an existing legend will be lost when you use these commands.</td>
</tr>
<tr>
<td>Update legend</td>
<td>Open the legendupdate dialog box:</td>
</tr>
<tr>
<td></td>
<td>- Graph: Legend: Update Legend menu.</td>
</tr>
<tr>
<td></td>
<td>- Right-click on legend and select Legend: Update Legend.</td>
</tr>
<tr>
<td>Advanced legend customizations</td>
<td>Right-clicking the legend object provides several advanced options to customize the graph legend. Applies primarily to:</td>
</tr>
<tr>
<td></td>
<td>- Categorical data plots.</td>
</tr>
<tr>
<td></td>
<td>- Box charts.</td>
</tr>
<tr>
<td></td>
<td>- Legends constructed point-by-point.</td>
</tr>
<tr>
<td>Task</td>
<td>Method (graph is active)</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add color scale</td>
<td>Only available for color-mapped plots.</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>Add Color Scale</strong> button (Add Object to Graph toolbar).</td>
</tr>
<tr>
<td></td>
<td>- Right-click in the layer and select <strong>New Color Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Graph: New Color Scale</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>- For multiple color-mapped plots with different color scale in one graph, click on each plot to select it and add corresponding color scale.</td>
</tr>
<tr>
<td>Control color scale</td>
<td>Available when a color scale object is added to a graph. To open the <strong>Color Scale Control</strong> dialog:</td>
</tr>
<tr>
<td></td>
<td>- Double click on the color scale object.</td>
</tr>
<tr>
<td></td>
<td>- Right-click on the color scale object and choose <strong>Properties</strong>.</td>
</tr>
<tr>
<td>Add bubble scale</td>
<td>Available for bubble plot, or when symbol size is controlled by a dataset.</td>
</tr>
<tr>
<td></td>
<td>- Select <strong>Graph: New Bubble Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Right-click in the layer and select <strong>New Bubble Scale</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Click the <strong>Add Bubble Scale</strong> button on the Graph toolbar.</td>
</tr>
<tr>
<td></td>
<td>- Right-click the legend to select <strong>Add Bubble Scale</strong> from the context menu.</td>
</tr>
<tr>
<td>Control bubble scale</td>
<td>Available when bubble scale object is added to a graph. To open the <strong>Bubble Scale Control</strong> dialog:</td>
</tr>
<tr>
<td></td>
<td>- Double click on the bubble scale object.</td>
</tr>
<tr>
<td></td>
<td>- Right-click on the bubble scale object and choose <strong>Properties</strong>.</td>
</tr>
</tbody>
</table>

The **legendupdate** dialog box and the **Legend/Titles** tab at page level of **Plot Details** both offer options for incorporating metadata properties such as the **Long Name, Comment, User Parameters**, etc., in the graph legend. Metadata properties can also be combined using custom LabTalk notation.

There are several options for further customizing the legend. These customizations do not apply to color scales:

- Right-click on the legend and select **Properties**..... Includes controls for formatting font, size, color, background, and rotation.
• Right-click on the graph legend and choose Properties. Modify the size, color, line width and data plot symbols associated with each plot.

• Click on the legend border to view border line controls for adjusting padding between text and border.

**Note:** For more information on creating and customizing graph legends, see:

Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales

### 12.6.3 Controlling Legend Update

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down to control this behavior.

The default setting Update when Adding only affects the legend display of data plots that are added or removed. Previous legend customizations to existing plots, such as literal text entered manually, will be maintained.

**Tutorial: Customize legend and add data plots**

1. Start with a new project in Origin.
2. Open Windows Explorer and navigate to the subfolder `<Origin EXE folder>\Samples\Import and Export`.
3. Shift-select the files `S15-125-03.dat`, `S21-235-07.dat`, `S32-014-04.dat` and then drag-and-drop the files onto an empty Origin workbook. The three files will be imported into three separate workbooks.
4. Click on one of the workbooks, select the column B, and create a line plot.
5. Right-click on the legend and select **Legend: Update Legend...** to open the legendupdate dialog.
6. Change the Auto Legend Translation Mode drop-down to **Custom**, and in the edit box that appears below, enter the string:

```
@WS, @LD3
```

and then press **OK** to close the dialog box. The legend updates, displaying the sheet name and the third user parameter.

7. Click on the second workbook, select column B, click and hold the mouse near the right-edge of the column, and then drag-and-drop this data onto the graph to create a 2nd data plot.
8. Repeat the procedure with column B from the third workbook. The graph will now display three data plots, and the legend will automatically update to display the identifier for all three plots.
9. Click on each individual curve and use the **Style** toolbar to set a different line color for each. The legend will automatically update and display the new line color.
12.6.4 Special Legend Types

Origin also has several special legends used with certain graph types. These legends can be customized and updated similarly to the default legend object.

<table>
<thead>
<tr>
<th>Legend Type</th>
<th>Menu Access</th>
<th>Used When..</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend for Categorical Values</td>
<td>Graph:Legend:Categorical Values</td>
<td>At least one plot attribute (e.g. color, symbol shape, etc) is controlled by data indexing. See <a href="#">Legend for Categorical Values</a> in the online documentation.</td>
</tr>
<tr>
<td>Point by Point Legend</td>
<td>Graph:Legend:Point by Point</td>
<td>The symbol style is controlled by data indexing, or increment list, or color mapping. See <a href="#">Point by Point Legend</a> in the online documentation.</td>
</tr>
<tr>
<td>Legend for Box Chart Components</td>
<td>Graph:Legend:Box Chart Components</td>
<td>The graph is a box chart, or a grouped box chart. See <a href="#">Legend for Box Chart Components</a> in the online documentation.</td>
</tr>
</tbody>
</table>
### 12.7 Annotating Your Graph

Annotating a graph can be as simple as adding a static text object and formatting it with **Format** toolbar tools. Or you might add a more complex object that is linked to some LabTalk script that executes whenever some user-specified event occurs (e.g. object is moved, window is activated, graph axes are rescaled, etc.).

<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Text</strong></td>
<td>- Click the <strong>Text Tool</strong> button, then click on graph to place object.</td>
</tr>
<tr>
<td></td>
<td>- Right click on the graph and choose <strong>Add Text</strong> from the shortcut menu.</td>
</tr>
<tr>
<td></td>
<td>- Double click on text to do rich text editing.</td>
</tr>
<tr>
<td><strong>Add Layer Title</strong></td>
<td>- Right-click on graph and choose <strong>Add/Modify Layer Title</strong> from the shortcut menu to add/modify layer title in active layer.</td>
</tr>
<tr>
<td><strong>Add Vertical/Horizontal Line</strong></td>
<td>- With 2D graph active, use the <strong>Graph: Add Straight Line...</strong> menu item.</td>
</tr>
<tr>
<td><strong>Annotate a Data Point</strong></td>
<td>- Click the <strong>Annotation</strong> tool in <strong>Data Reader</strong> group from <strong>Tools</strong> toolbar.</td>
</tr>
<tr>
<td><strong>Add Drawing Objects</strong></td>
<td>Use the corresponding toolbar buttons on <strong>Tools</strong> toolbar. Origin supports:</td>
</tr>
<tr>
<td></td>
<td>- Arrow, Curved Arrow.</td>
</tr>
<tr>
<td></td>
<td>- Line, Polyline, Freehand Draw.</td>
</tr>
<tr>
<td></td>
<td>- Rectangle, Circle, Polygon, Region.</td>
</tr>
<tr>
<td><strong>Insert Equation, Word Object, Excel Object, Other OLE Object</strong></td>
<td>- Insert Equation group on the <strong>Tools</strong> toolbar.</td>
</tr>
<tr>
<td><strong>Insert Image</strong></td>
<td>- Right click on the graph and choose <strong>Insert Images From Files</strong>.</td>
</tr>
</tbody>
</table>
### Task | Method
---|---
Add Table | • Click the **New Link Table** button on the **Add Object to Graph** toolbar and then click on the graph.<br>• Right click on the graph and choose **New Table** from the context menu.<br>• Double click the table object to edit and customize the table.
Insert Date & Time Stamp | • **Date & Time** button on the **Add Object to Graph** toolbar.
Insert Project Path | • **Project Path** button on the **Add Object to Graph** toolbar.
Add Bracket with Asterisk | • To indicate statistical groupings, click the **Add Asterisk Bracket** button on the **Add Object to Graph** toolbar. Manually adjust the size and placement of brackets by dragging handles on the object.
Add XY Scale | This is useful when using a nonlinear xy scale.<br>• **New XY Scale** button and click on a graph layer.<br>• Right click on a graph layer and choose **New XY Scale** from the shortcut menu.

### 12.7.1 Tips for Editing Your Graph Annotations

- Use the **Format** and **Style** toolbar buttons to quickly modify some plot elements including plot colors and axis titles.
- For text objects, including the axis titles, you can edit text objects directly in "In-place Edit" mode. Double-click on a text object to edit. Use the **Format** toolbar buttons to add superscript, subscript, and Greek characters.
- When you are in In-place Edit mode, you can right-click and choose **Symbol Map** to insert special characters into your text object.
- You can insert the contents of a worksheet cell (data or metadata) into a text object by copying the cell contents; while in In-place Edit mode in the text object, right-click and choose **Paste** or **Paste Link** from the shortcut menu.
- Also, when in In-place Edit mode, you can right click and choose **Insert Info. Variable...** to insert information related to plotted data, into the text object.
You can insert variable values into a text object using the LabTalk %, and $ substitution notation by setting the Link to (%,$), Substitution Level to 1 in the text object's Programming Control dialog box. Right-click on the text object and choose Programming Control... from the shortcut menu.

Pressing CTRL when drawing with the Rectangle or Circle tools, will draw a square or circle (as opposed to a rectangle or ellipse).

Right-click on a text or drawing object and choose Programming Control... to associate LabTalk script with the object. Specify a Script, Run After condition for running the script.

Right-click an object and choose Properties... to edit the properties of the text or drawing object and set the default.

Right click an annotation and choose Customize Label... to associate LabTalk script with that specific annotation or annotations belong to same data plot or annotations belong to plots in same group.

You can copy a range (of cells) from a workbook and paste it into a graph as a table object. The table object is editable.

### 12.7.2 Object Attachment and Scaling

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph layer. This is important to note because if you resize or delete a graph layer, you may resize the object and you will delete the object.

To view or change a text or drawing object's attachment method:

1. Right-click on a text or drawing object and choose Programming Control.... This opens the Programming Control dialog box.
2. Note the Attach to setting.

Though objects are a part of the layer that is active at the time of their creation, you can manage some object behaviors by changing the object attachment method. As the image above shows, an object can be attached in three ways:

- **Page.** When attached to the page, objects are not affected by moving or resizing the graph layer, nor are they affected by a change in axis scales. These objects are still associated with a particular graph layer and they will be hidden or deleted if the layer is hidden or deleted.

- **Layer Frame.** Objects that are attached to the layer frame, resize and move with the layer frame, but are unaffected by changes in the layer's axis scale values. Objects are hidden or deleted if the associated layer is hidden or deleted.
• **Layer and Scales.** Objects are linked to a particular range of axis scale values. If you resize the layer, the object is resized accordingly. If you rescale the axes, the object moves in relation to the scale change and will disappear from view if the associated axis scale range is not displayed. These objects are hidden or deleted if the associated layer is hidden or deleted.

The following table summarizes default attachment methods for common objects. Note that the default attachment method varies by object type.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>When Created Inside Layer Frame, Attached to...</th>
<th>When Created Outside Layer Frame, Attached to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Layer Frame</td>
<td>Page</td>
</tr>
<tr>
<td>Rectangle, Circle, Polygon, Region, Polyline, Freehand</td>
<td>Layer Frame</td>
<td>Page</td>
</tr>
<tr>
<td>Arrow, Line, Curved Arrow</td>
<td>Layer and Scales</td>
<td>Page</td>
</tr>
</tbody>
</table>

**Note:** For more information on object attachment methods, see,

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects > Object Attachment and Scaling

### 12.7.3 Grouping, Aligning and Arranging with the Object Edit Toolbar

You can group text labels and drawn objects so that they move or resize as a unit:

1. To select objects, press SHIFT + click; or drag out a box around objects using the Pointer tool.

2. To group the selected objects, click the **Group** button on the Object Edit toolbar.

3. To ungroup objects, click the **Ungroup** button on the Object Edit toolbar.

You can align text labels and drawn objects using the tools on the Object Edit toolbar:

1. Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using the Pointer tool), then click one of the align objects buttons on the toolbar. Note that objects will be aligned with respect to the first-selected object.

You can bring overlapping objects to the front or send them to the back:
1. Select the objects that you want to move to the front or the back.
2. Click the **Front** button or the **Back** button on the **Object Edit** toolbar.

You can also use **Object Edit Toolbar** to align and set a uniform size for multiple graph layers; or to position graphic objects, text labels or legend on the layer.

**Note:** For more information on graph annotations, see your Origin User Guide: *Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects*

### 12.8 Arranging Graphs and Layers

<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
</table>
| Merge multiple graph windows into a single graph window. | - **Graph: Merge Graph Windows...** menu command  
  or  
  - **Merge Graph Windows** button on the **Graph** toolbar.        |
| Extract data plots in one layer to multiple layers. | - **Extract to Layers** button on the **Graph** toolbar.  
  **Hint:** to preserve your original graph, click the **Duplicate** button before extracting to layers. |
| Extract multiple layers in a single graph to multiple graph windows | - **Graph: Extract to Graphs**  
  or  
  - Click the **Extract to Graphs** button on the **Graph** toolbar.  
  All layers are extracted to individual graph windows, even if a layer is linked to another layer.  
  By default, **Extracted Layers** is set to 1:0, which specifies that all layers be extracted. To act only on certain layers, clear **Auto** and use the **layextract X-Function's comma/colon notation** to point to specific layers. The notation 1:0 means starting with layer 1, extract all layers to graphs (0 denotes all). Specifying 1,3:4, for example, tells Origin to extract only the first, third and the fourth layer. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add, arrange, resize, position, swap, align, or link layers</td>
<td><strong>Graph: Layer Management...</strong> menu. <strong>Hint:</strong> to physically swap inplane positions for layers (don't reassign layer number), use the Layer Management tool's <strong>Swap</strong> control (Graph: Layer Management, Size/Position tab).</td>
</tr>
</tbody>
</table>
| Link graph layers                                                   | • **Linked Axes Scales** tab, layer level of **Plot Details** dialog box. **Link** tab of the **Layer Management** dialog box.  
When linking layers, the child layer must have a higher layer number than the parent layer. 
Linked layers can be moved and resized together. 
You can link layers' axis scale values to be **Straight (1:1)** or you can specify a **Custom** mathematical relationship. |
| Reorder layers                                                      | There are two ways to reorder the layers (reassign Layer number for each Layer). **Open the** **Layer Management** dialog and click the row header (shown in image below) and drag it up or down to change the Layer order. **Learn more about reassigning layer numbers in the mini tutorial below this table.** **Enter the following LabTalk script in the** **Command Window** (Window:Command Window), then press **Enter** to execute. **The command changes the** $n$th Layer to the $m$th Layer. **Note:** Origin may break layer links during the reordering process. To learn more about the Layer Management tool, please refer to documentation for the **laymanage X-Function**. |
In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on top of the layer with lower number. This is important when plots or other objects contained in one layer cover plots or objects in another layer. When necessary, you can change layer order by dragging in the left panel of the Layer Management dialog or by entering the above LabTalk code (page.reorder) in the Command or Script Window.

This mini tutorial shows you how layer reassignment works. Use the preview window to see how layer number reassignment affects your graph.

1. Open the sample folder by clicking File: Open Sample Projects: 2D and Contour Graphs from the main menu.
2. Under this folder, go to 2D and Contour Graphs: Area: Area Plot with Gradient Fill.
3. Activate the Graph: Area Plot With Horizontal Color Gradient, then click the Extract to Layers button on the Graph toolbar. Set both number of rows and columns to 1, click OK, then, click OK again for the page spacing. The green layer is on the top of the yellow layer in the figure. Now we want to reorder the layer and set yellow layer on the top.
4. Choose **Graph: Layer Management...** menu, then drag the row header "1" of the Layer1 in the **Layer Selection** downward under the Layer2 (indicated by a blue line), and click **OK**.

5. You can see the yellow layer is on the top now.

You can easily add an inset layer with data by clicking the **Add Inset Graph With Data** button on the **Graph** toolbar or **Graph: New Layer(Axes): Inset With Data (Linked Data)**.

You can copy a layer from one graph window to another graph window. Click to select the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and choose **Copy**. Click on the target graph window, then right-click to **Paste**.

**Note:** For more information on merging graphs, see your Origin User Guide:

**Help: Origin: Tutorials > Graphing > Layers > Adding and Arranging Layers**

**Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box**
12.9 Templates and Themes

Origin’s flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a couple of ways -- either with templates or with Themes. These concepts are introduced below.

**Note:** For detailed information please refer to Origin Help file, see:

- Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates
- Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes

### 12.9.1 Templates

Customizations to your graph can be saved to template files for repeat use. For example, you can customize a graph page to add multiple layers, set relationships between layers, modify data plot properties, and then save all of these attributes as a graph template (.otp) file. You can further specify that the graph template be "cloneable" allowing you to link these graph customizations to dataset Long Name, Short Name or worksheet column index number and quickly re-create your graph with new data.

Origin ships with over 100 built-in graph templates. You may customize and re-save these templates or create new templates.

- To create a new template from a customized graph, click **File** in the main menu, and then click **Save Template As**...
- To plot with your customized template, click **Plot**, and then click **User Templates**: and choose your template directly from the menu, or open the **Template Library**... to browse your templates and plot.
- To open the template as a blank graph window, choose **File: Open...**, set your file type list to Origin Template (*.otp, etc.) and choose your template.

To learn about adding plots into a graph window, see the **Graphing** chapter of this Guide.

For information on the Template Library, see [The Graph Template Library](#).

For information on "cloneable" templates, see [Graph Template Basics](#).
12.9.2 Themes and Copy/Paste Format

An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin: graph Themes, worksheet Themes, dialog Themes and function plot Themes. Graph Themes are a collection of properties of different elements in a graph window (e.g. a Theme could be as simple as axis major and minor tick direction settings, a colormap for a plot, or a combination of page dimensions, layer background, axis scales, color palettes used in a plot, etc.

Themes allow you to quickly change one or more object properties in an existing graph; or to apply a consistent set of properties for all graph windows. For example, you might apply a black-and-white Theme to one of your color graphs in order to prepare it for journal publication; or you could change the font in all of your graph windows to Times New Roman.

The properties that can be saved as a Theme differ depending upon the selected object. At a basic level, it works like this:

1. Right-click on an object in a graph window, e.g. a plot and choose Copy Format. Depending on what you click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the option as to what exact format to copy.

   - To apply the copied formats to a single graph, right-click on your target graph and choose Paste Format To. Again, there may be a Paste Format shortcut menu item with sub-items that limit what to paste. The formatting option(s) from your source graph should be applied to your target graph.
Customizing Graphs

- To apply the copied formats to multiple windows in the project, keep the source graph window active and select **Edit: Paste Format...** from the Origin menu. This opens the **Apply Formats** dialog box. Here you have the option of editing or selectively applying formats to one or more graph windows in the Origin Project.

2. You can do the above on-the-fly copy and paste format or you can choose the **Save Format As a Theme...** shortcut menu item instead of **Copy Format**, then use **Tools: Theme Organizer** to apply the Theme in the future.

**Theme Organizer**

Use the **Theme Organizer (Tools: Theme Organizer)** to organize and apply Themes to graphs. With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file.

To combine multiple Themes in the Theme Organizer dialog box:

1. Press the **CTRL** key while selecting multiple Themes, then right-click and choose **Combine** from the shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to add/delete properties from an existing Theme.

- If you right-click on a graph Theme and save it as your **System Theme** in the **Theme Organizer**, then each time you plot a new graph, the System Theme will be applied regardless of the settings that were saved with the graph template.

- If you don't want a System Theme to be applied automatically to the graph, choose **File: Save Template As** and make sure the **Apply System Theme**
The \textit{to Override} check box is cleared.

- You can load a graph Theme in the \textbf{Export Graph} dialog and the Theme will be applied to the exported image file.

### 12.10 Topics for Further Reading

- [Customizing Graph Page Elements](#)
- [Customizing Graph Layer Elements](#)
- [Customizing Plot Elements](#)
- [General Tips for Customizing Plots](#)
- [The Tools: Options: Axis tab Settings](#)
- [The Tools: Options: Graph tab Settings](#)
- [Graph Axes](#)
- [Controlling the Graph Axis Display Range](#)
- [Adding Text and Drawing Objects](#)
- [Hiding Labels, Data and Layers](#)
- [Creating Graphs from Graph Templates](#)
- [System Themes](#)
13 Graphical Exploration of Data

Origin includes a number of tools for graphically exploring your data, including tools for magnifying and zooming, reading XY coordinate values, and drawing and deleting data points.

Start with a data plot ...

Choose a Tools Toolbar tool

For quick interactive analyses and recalculation of results choose Gadgets

Click here for Gadget controls

Gadgets for:
- Peak Finding
- Integration
- Differentiation
- FFT
- Curve Fitting
- Statistics
- Curve Intersection
- and more ...

Pointer
- Object selection mode

Scale In
- Axes magnification, double-click to restore, ctrl-drag to create zoom graph

Screen Reader
- Read screen coordinates, click pointer to restore

Data Reader
- Annotation
- Data Cursor

Data Selector
- Select a range of data, click pointer to restore

Selection on Active Plot
- Selection on All Plots

Mask Points on Active Plot
- Mask Points on All Plots
- Unmask Points on Active Plot
- Unmask Points on All Plots

Free form drawing of data

Zoom-Panning Tool
- Can also hold A to enter tool; Drag page (or arrow keys) to pan, mouse wheel (or +, -) to zoom

Rescale Tool
- Can also hold Z/X to enter tool; 2 Zoom,X/Pan; Shift-Z/X for Y otherwise X dir; Mouse wheel (or +, -) or drag (or arrow keys); Space toggle panning mode (h or minor, major ticks).
13.1 Zooming, Panning and Rescaling

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of the graph. We have split these tools and commands into two groups: Page-level zoom and panning operations that do not change axis scales; and Rescale operations which zoom and pan the graph by changing axis From and To values.

**Note:** Page level zoom and panning treat the graph page as a whole. You can read the current zoom level in the Zoom dropdown list of the Standard toolbar. Page level zoom and pan will not affect the printout or export of the graph, while Rescaling changes axis scales and will affect the printout and export of the graph.

### 13.1.1 Page Zoom and Pan

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom-Panning</strong></td>
<td><img src="image" alt="Zoom-Panning" /></td>
<td>--</td>
<td>--</td>
<td>• Use mouse wheel to zoom in or out, with &quot;hand&quot; as focal point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• Drag with left mouse button to pan.</td>
</tr>
<tr>
<td><strong>Whole Page</strong></td>
<td><img src="image" alt="Whole Page" /></td>
<td>CTRL + W</td>
<td>View: Whole Page</td>
<td>• Reset the view of the page after using the Zoom-Panning tool.</td>
</tr>
<tr>
<td><strong>Zoom All</strong></td>
<td>--</td>
<td>--</td>
<td>View: Zoom All</td>
<td>• Can be used to locate &quot;lost&quot; objects lying outside the graph page.</td>
</tr>
</tbody>
</table>


### 13.1.2 Axis Rescaling

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Menu</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **Rescale**: Rescale and pan the graph in both X and Y dimensions. | ![Rescale Icon] | -- | -- | - Scroll to rescale X.  
- SHIFT + scroll to rescale Y.  
- Drag with the left mouse button to pan (also rescales).  
- Rescales both X and Y. |
| Rescale the graph in the X dimension. | -- | Z + scroll wheel  
or  
Z + +/- keys | -- | - Rescales X.  
- Does not rescale Y. |
| Pan the graph in the X dimension. | -- | X + scroll wheel  
or  
X + +/- keys | -- | - Rescales X.  
- Does not rescale Y. |
| Rescale the graph in the Y dimension. | -- | SHIFT + Z + scroll wheel  
or  
SHIFT + Z + +/- keys | -- | - Rescales Y.  
- Does not rescale X. |
| Pan the graph in the Y dimension. | -- | SHIFT + X + scroll wheel  
or  
SHIFT + X + +/- keys | -- | - Rescales Y.  
- Does not rescale X. |
### Scale In/Scale Out:
Rescale the graph in X and Y dimensions.

- Select **Scale In** button, then drag out a rectangle to define axis scale range.
- Reset by clicking on the **Scale Out** button (no need to drag).
- Rescales both X and Y.

Origin 9.1 SR0 introduced the `@nrm` system variable to modify rescale behavior when using the **Rescale** tool or associated shortcut keys:

- **@nrm = 0**: From/To values on the **Scale** tab of the **Axis** dialog box will change when **Rescale** is set to **Manual**. This is established behavior.

- **@nrm = 1**: From/To values will not change when **Rescale** is set to **Manual**. This is new behavior.

Modify the current behavior by opening the Script Window (Window: Script Window), typing `@nrm = <value>`, then pressing ENTER.

**Note**: When using the older **Scale In** tool you are prompted to override Manual rescaling. However, when `@nrm=1` you cannot override the Axis dialog box Rescale setting.

### 13.2 Reading Coordinate Values

Origin provides several tools to aid in graphical exploration of your data plots. Most of these tools are available from the **Tools** toolbar (View: Toolbars). There is a related tool -- **Vertical Cursor** -- available from the **Gadgets** menu.

The simplest data exploration tool is the **Screen Reader**. The Screen Reader works with the **Data Display** window to dynamically display the XY coordinates of the cursor on the graph page. The Data Display window opens automatically when you select the Screen Reader tool from the **Tools** toolbar.
You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-clicking inside the window.

To use the Screen Reader:

1. Click the Screen Reader button on the Tools toolbar. This opens the Data Display tool.
2. Click on a location in the graph page to read its X, Y, and Z coordinates (ternary and contour only). Coordinate values show in the Data Display tool.
3. To increase cross-hair size, press the space bar.
4. Click the Pointer button on the Tools toolbar to exit screen reading mode.

### 13.3 The Data Info Window

The Data Info window opens when you choose either the Data Reader, the Annotation or the Data Cursor tools. At first glance, the Data Info window seems to duplicate the functionality of the Data Display tool (reading XY coordinates in the graph).

However, the Data Info window is customizable and ultimately, more powerful than the Data Display window. In addition to numerical data, you can display other classes of data -- metadata and images -- associated with a particular data point.

To customize the display of the Data Info window, right-click on the Data Info window and choose Preferences... from the shortcut menu. Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info window:
The Title tab is used to specify how the report title is displayed in the upper left corner of the Data Info window.

The Rows tab is used to specify which columns in the data worksheet are shown in the Data Info window.

The Columns tab allows control over what displays in the Data Info window. In addition to the data groups that are chosen in the Rows tab, the user can choose to show additional information such as the Long Name, Short Name, Units, and data contained in individual cells.

The Display tab contains options for customizing the display properties of the Data Info window.

On the top of the dialog, there is Dialog Theme control. The Data Info window customization can be saved to graph, layer and even plot level so that every time you use Data Reader, Cursor, or Annotation tool on such graph, layer or plot, such Data Info window will show up. Or you can save it as a theme file and load it in the future.

13.4 The Data Reader Tool

Use the Data Reader tool to read information associated with a data point in your plot. This information can include XY(Z) coordinate values and other metadata and images describing the data point.

The Data Reader tool is grouped with two related tools -- an Annotation tool and a Cursor tool. Only one of these will display at a time. To select a hidden tool, click on the small arrow in the lower-right corner of the button and select a tool from the shortcut menu.

To use the Data Reader tool:

1. Click the Data Reader button on the Tools toolbar. This opens the Data Info window.
2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the Data Info window (and Data Display window).
3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or click on the data point using your mouse. If you have multiple plots in a layer, use UP and DOWN arrow keys to move it to a data point on another plot or user mouse to click it.

4. To change the vertical and horizontal cross hair size, click on a point and press the spacebar to adjust.

5. Click the **Pointer** button on the **Tools** toolbar to exit the Data Reader tool.

### 13.5 The Annotation Tool

Use the Annotation tool to label a data point. Choose from several standard labels or create your own custom label using LabTalk script. To annotate a data point:

1. Click the **Annotation** button on the **Tools** toolbar and move the cursor to your graph. Note that the **Status Bar** displays information on Annotation tool use.

   ```plaintext
   double click=add an annotation, TAB=toggle annotation label, current label:Custom (this point's x location is $X)```

2. Use the TAB to toggle between the following standard annotation options: (X coordinate value, Y coordinate value), (X coordinate value, Y coordinate value)[index number], X coordinate value, Y coordinate value, or index number (row number).

3. Double-click to add the chosen label to the data point.

   **Note:** You can use the Annotation button to label most Line & Symbol plots and Column/Bar plots.

#### Tutorial: Customizing the Annotation String

The annotation string can be customized by combining literal characters with the X and Y coordinate values:

1. Start with a graph of your data

2. Open the **Script Window** (Window:Script Window) and type the following command, then press Enter:

   ```plaintext
   system.annotation.customlabel$="X value:$(x,.2), Y value:$(y,*5)"
   ```

3. Click the **Annotation** button, then press the **Tab** key several times to cycle through the annotation choices until the custom string format specified above is displayed in the status bar.

4. Start double-clicking on data points to add the custom annotation string. The X values will be displayed with two decimal places and the Y values will be displayed with 5 significant digits.
Note: Please view more information on string formatting in the Programming help file:

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical
Listing of Objects > String

Note: Once created, you can drag the label to reposition it, and the line connecting the label to the data point will follow.

13.6 The Data Cursor Tool

The Data Cursor tool allows you to place cursors on a data plot and then measure the X and Y distance between the cursor locations. The cursors can also be placed on different data plots within a layer to measure relative distance between data points in different plots. Data cursor work together with data reader to read X and Y distance between data reader and data cursor.

Tutorial: Using the Cursor Tool to Measure Relative Distance

1. Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot.
2. Click and select the Data Cursor button from the Tools toolbar.
3. Double-click on one of the peaks to place a cursor object on the data point or select the data point and press ENTER key to add cursor object.
4. Repeat to place a second cursor object on another peak.

5. Double click in Data Info. window to open Data Info. Report Settings dialog. If this window is not visible, select the View: Show Data Info menu item to turn on Data Info. window.

6. Switch to the Columns tab and then right-click in the gray area to the right of the columns and choose Add Column.

7. In the new column that is added, click on the source row of new column, and select Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close the dialog.

8. Now you can drag and move the cursor objects and the third column in the Data Info window will display the X and Y distances between the two cursors.
Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:

- **Vertical Cursor**
- **Statistics**
- **Cluster** (OriginPro)

The **Vertical Cursor** gadget is especially useful for reading XY coordinate values for data points in stacked panel plots or multi-plot graphs, where plots share a common X scale.

To open the Vertical Cursor:

1. With a graph window active, choose **Gadgets: Vertical Cursor...** from the main menu. This opens the **Vertical Cursor** dialog box.

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label font size, hide labels, etc.
The **Statistics** gadget returns basic statistics on data points falling inside a rectangular region-of-interest (ROI) on the graph.

- Display basic statistics for data inside the ROI.
- Display mean and $n$th Standard Deviation lines inside the ROI.
- Update results dynamically as ROI is moved or resized.
The **Cluster** gadget (available in OriginPro) provides the following features:

- Display basic statistics for data inside a region of interest (ROI).
- Switch between rectangular or elliptical ROI.
- View statistics for points inside and outside of the ROI.
- Edit, copy, mask, delete or group data points.
- Update results dynamically as ROI is moved/re-sized.
- Output results to a worksheet.
Note: To learn more about these gadgets, see:

Help: Origin: Origin Help > Gadgets

13.8 Topics for Further Reading

- Gadgets
- The Data Analysis chapter of this User Guide
- The Cluster Gadget (OriginPro)
- The Vertical Cursor Gadget
- The Digitizer
- The Statistics Gadget
- Masking Data
- Data Filtering
- Drawing or Deleting Data Points in the Graph
- List of Origin Built-in Toolbars and Buttons
14 Gadgets

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple: While each Gadget has a specific purpose, each is built around applying a set of customizable analysis operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.

14.1 Origin Gadgets
The **Gadgets** main menu is available when a graph window is active. There are 14 gadgets available in Origin:

<table>
<thead>
<tr>
<th><strong>Cluster Gadget</strong></th>
<th>View statistics on points inside/outside a rectangular or elliptical ROI <em>(OriginPro Only)</em>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Differentiate Gadget</strong></td>
<td>Calculate and plot the $n$th-order derivative of selected data.</td>
</tr>
<tr>
<td><strong>FFT Gadget</strong></td>
<td>View FFT spectrum of selected data.</td>
</tr>
<tr>
<td><strong>Integration Gadget</strong></td>
<td>Calculate the area under a curve, or between two curves.</td>
</tr>
<tr>
<td><strong>2D Integration Gadget</strong></td>
<td>Calculate the 2D integration for a contour or image graph created from matrix or XYZ worksheet data <em>(OriginPro Only)</em>.</td>
</tr>
<tr>
<td><strong>Interpolate Gadget</strong></td>
<td>Perform linear, spline, b-spline or Akima spline interpolation of selected data.</td>
</tr>
<tr>
<td><strong>Intersect Gadget</strong></td>
<td>Calculate the intersection points of two or more data plots.</td>
</tr>
<tr>
<td><strong>Quick Fit Gadget</strong></td>
<td>Perform linear, polynomial, or nonlinear fitting of selected data.</td>
</tr>
<tr>
<td><strong>Quick Peaks Gadget</strong></td>
<td>Locate peaks, and compute area and other peak properties.</td>
</tr>
<tr>
<td><strong>2D Quick Peaks Gadget</strong></td>
<td>Locate and fit peaks, compute volume and other peak properties in matrix, Virtual Matrix or XYZ data <em>(OriginPro Only)</em>.</td>
</tr>
<tr>
<td><strong>Quick Sigmoidal Fit Gadget</strong></td>
<td>Perform Sigmoidal fit of selected data.</td>
</tr>
<tr>
<td><strong>Rise Time Gadget</strong></td>
<td>Analyzes rise/fall time for the step-like signal <em>(OriginPro Only)</em>.</td>
</tr>
<tr>
<td><strong>Statistics Gadget</strong></td>
<td>Compute and display simple descriptive statistics of selected data on the graph.</td>
</tr>
</tbody>
</table>
### Vertical Cursor Gadget
Read and tag X, Y coordinate values for data plots across multiple graphs that share the same X axis.

### Image/Contour Profile
Analyze the image or contour from matrix data and generate profiles.

**Note:** To learn more about these gadgets, see:

- Help: Origin: Origin Help > Gadgets

---

**Tutorial: Using the Integrate Gadget to Output Results to a Worksheet**

1. With a new workbook active, import the file *Peaks on Exponential Baseline.dat* located in the *Samples\Spectroscopy* subfolder under the Origin installation folder.
2. Create a line plot of the data in column B.
3. With the graph active, go to the main menu and click **Gadgets: Integrate**....
4. In the dialog box that opens, click the **Baseline** tab and select **Straight Line** from the **Mode** drop-down list.
5. Click the **Output** tab, and under the **Output Quantities to** node, select **Append to Worksheet** and clear the other check boxes.
6. Expand the **Quantities** node, select **None** from the **Dataset Identifier** drop-down list and enable **Beginning X** and **Ending X**.
7. Press **OK** to close the dialog box. The Region-of-Interest (ROI) rectangle object is added to the graph.
8. Resize and move the ROI object to cover just the first peak in the data plot, then press the arrow button located at the top-right of the ROI and select **New Output**. This will write the parameters for the first peak to a worksheet.
9. Drag and move the ROI to cover the second peak, and repeat the steps above to generate output for the second peak.
10. Press the arrow button again and this time select **Go to Report Worksheet**. A worksheet with the integration results will open.
Click the arrow button in the top right corner of the ROI and you can opt to output results for all curves in the current layer (New Output for all Curves (N)) or for all layers of the graph page (New Output for All Layers (L)) or press the corresponding N or L hotkey. This allows for batch analysis of multiple curves in a graph.
14.2 Topics for Further Reading

- Gadgets
- The Image/Contour Profile tool
- Tutorial: Using Multiple Gadgets
- Tutorials for Individual Gadgets
- Peak Analyzer
- Digitizer
15 Data Analysis

15.1 Introduction

Origin contains powerful tools for all of your analytic needs, including peak analysis, curve fitting, statistics, and signal processing. The output of one operation can be used as input for another, allowing for a chain of operations and their associated results to be updated. You can easily update results when input data or analysis parameters are changed and avoid the trouble of repeating the procedure from the beginning.

The following sections cover (1) delineating the data that you wish to analyze and (2) the Origin and OriginPro tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.

15.2 Selecting Data

Origin's analysis can be performance from workbook or graph windows. By default analysis will be on done on highlighted data in worksheet or active plot in graph. You may want to restrict your analysis to a subset of the data; say, a certain range of rows or columns in a worksheet, or a certain X range in a graph.

You can either do the data selection (with methods mentioned below) before opening an analysis dialog or after opening the dialog. Most of Origin's X-Function based analysis tools have a Input Data branch with standard range selection control that you'll want to become familiar with (we explain the control, below).

15.2.1 Selecting Data in the Worksheet

When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would include nearly all of those that open from the Analysis or Statistics menus -- you will see your range selection already entered into the dialog box Input Data branch. Most will find that selecting worksheet data prior to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze.
If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do after opening a dialog is to select data in Input Data branch:

1. Click the range selection control next to Input Data. The dialog box will roll up.

2. Go to worksheet and highlight your worksheet data, then click the button at the right end of the rolled up dialog box. The Input Data branch will now show the selected range.

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only supports one dataset, though you could select multiple ranges, only the 1st range will be picked in analysis.
Note:

- The **Input Data** branch has a hierarchical structure. If the analysis supports multiple datasets, you can add multiple ranges under **Input Data** and they will show as **Range 1**, **Range 2**, etc., each with its corresponding **X**, **Y**, **Error** and **Row** controls.

- Mousing over each level will show a tooltip of where the data on that level is from (i.e. book, sheet and column).

- **Rows** control under each range node lets you set range by row index or X value. If you want to apply the same row range to all ranges under **Input Data**, click the arrow button to the right of the range node and choose **Apply Row Range to All**.

- Depending on where you are in the Input Data hierarchy, range selection button may have some limitations. E.g. if you click range selection control next to **Y**, though you could select multiple columns in a worksheet, only the 1st column is accepted.

- Click the **arrow** button to the right of the range selection control will show more selection options, such as pick a column there to do quick data selection.

- Depending on which level you are in, the selection options when clicking the **arrow** button may vary, such as clicking the "arrow" button next to **Input Data**, you will see a Select Columns... menu, which opens **Column Browser** to select multiple columns even from different worksheets.
Use **List Datasets** drop-down list to filter which sheets you want to pick from. The top panel list can be sorted by clicking any of the column headings, making it easy to select, for example, all columns that share the same **LName** or **Comments**. Then click **Add** button to add the column to your selection list in bottom panel. To modify the data input range of any dataset, click the range button to the right of any dataset added to the bottom panel and edit the **From** and **To** values.

### 15.2.2 Selecting Data in the Graph

When a graph window is active and you select one of the **Analysis** menu tools, the default behavior is for the analysis dialog box to open showing the selected range of the active dataset as your **Input Data**. And in the dialog, you could go to Input Data node to adjust Input Data, such as add more data, change data range, etc.

The active dataset is the one that shows in the data list (bottom of the **Data** menu) with a check mark next to it. Note that this analysis dialog box behavior applies even to plot groups. You can force an **Analysis** dialog box to register a particular data range by clicking on another of the data plots listed at the bottom of the **Data** menu.
If your data plots are not part of a plot group, you can click once on the intended plot before opening an Analysis dialog box and this will set the Input Data range to the selected plot.

If your data plots are part of a plot group, click once on any of the plots in the group to set Input Range to all plots in the group; or click a second time on any plot to restrict analysis to the selected plot (note that this does not switch the active dataset). Alternately, you can pre-select multiple plots using the Regional Data Selector (see below).

You can indicate the active dataset by placing a red rectangle around the plot’s legend entry. To turn this feature on, click on your graph window, select Format: Page Properties..., click on the Legends/Titles tab and choose Indicate Active Dataset.

### 15.2.3 Selecting a Subset of Your Data Graphically

You can graphically select a range of data using the Regional Data Selector tool:

1. With a graph window active, click and hold the Regional Data Selector button on the Tools toolbar, and then choose Selection on Active Plot or Selection on All Plots.
2. Drag out a rectangle or freehand object to select an area of the plot(s). Press Space to toggle between rectangle and freehand modes.
When you make your selection, data markers appear on the graph, delineating the selected range(s). You can work with graphically selected data using Origin's analysis tools (e.g., Linear Fit), but note that some analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis: Signal Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot.

**Tutorial: Linear Regression on Partial X Range**

1. Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new workbook.

2. Select all Y columns and create a line plot.

3. Click and hold the **Regional Data Selector** button on the **Tools** toolbar, and then choose the **Selection on All Plots** button.

4. Drag out a rectangle to select the tail-end of the three curves between values of approximately 0.6 and 1.0 along the X axis.

5. Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog.

6. **Input Data** branch is filled with three ranges. Mouse over Input Data branch will show tooltip which shows 1X,1Y, ...3X and 3Y.

7. If you want to change the data selection, click the **arrow** button in **Input Data** and choose **Reselect All Data from Graph**. The dialog will roll up. Drag out a rectangle in graph again to make your selection and then click the **button at the right end of the rolled up dialog box. The new data selection will show in **Input Data** branch.

8. Accept default Linear Fit settings and press **OK** to close the dialog. Linear fitting will be performed on all three curves over the selected range.
In addition to the data selection and masking methods discussed in this section, Origin includes data filtering and data reduction tools.

15.2.4 Editing a Data Marker

To edit a data marker:

- To modify a data range, right click a data marker and choose Edit or double-click on data marker. The red marker changes to dark color with arrows on both ends and cursor changes into a target. Drag start or end marker to a new position or use one of the keyboard shortcuts listed below and modify the data range. To escape edit mode, double-click on the marker or press Enter key.

- Other right-click options for data marker **Delete Data, Delete Marker**, etc..

![Edit Options]

- **Edit**
  - Move to Begin/End
  - Move to Begin
  - Move to End
  - Delete Data
- **Delete Marker**
- **Delete**
**Note:** If you have used the **Regional Data Selector** tool to place markers on multiple plots (Selection on All Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of other selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector.

Alternately, you can use these keyboard shortcuts to select and edit data markers:

1. Select data markers using these keys ...

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>s</td>
<td>Select the first pair of data markers on the graph (those marked with &quot;1&quot;).</td>
</tr>
<tr>
<td>Tab</td>
<td>Select the next pair of data markers (not in edit mode) or the other data marker of the pair (in marker edit mode).</td>
</tr>
<tr>
<td>Home</td>
<td>Return to the first data marker.</td>
</tr>
<tr>
<td>End</td>
<td>Go to the last data marker.</td>
</tr>
</tbody>
</table>

2. ... then activate and edit the data marker using these key combinations:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>Activate the selected data marker for editing. (Press <strong>Enter</strong> again to exit data selection mode.)</td>
</tr>
<tr>
<td>Arrow</td>
<td>Move the active data marker exactly one data point.</td>
</tr>
<tr>
<td>Ctrl/Shift + Arrow</td>
<td>Move the active data marker multiple data points.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the the active data marker.</td>
</tr>
</tbody>
</table>
15.2.5 Difference between Data Markers and Analysis Markers

- **Data Markers** define a sub-range that you select using the **Data Selector** tool. If you want to remove the data markers from a graph, you can select **Data: Clear Data Markers** from the main menu, or click the **Clear Data Markers** button on the **Markers and Locks** toolbar.

- When the analysis routine is completed, Data Markers are replaced with **Analysis Markers**. By default, Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange, Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun your analysis, you must right-click an analysis marker and choose **Change Parameters**. Change the Input Data range and rerun the analysis.
Note:

- If you set **Recalculate** to **None** in the analysis dialog box, then no analysis markers are generated.
- Data markers and analysis markers are not exported when you choose **File: Export Graphs**.
- To select the exact same range again for another analysis, click the green lock and choose **Plot Input Data with Data Markers** to create a new graph and do analysis on it.
- There is a **Markers and Locks** toolbar to manipulate Analysis Markers and Locks, for instance, toggling Analysis Markers on or off by clicking the **Marker Hide Show** button. There is also a **Data: Analysis Marker** menu item and a context menu control (available when you right-click on a Marker or Lock).

15.3 Data Masking

Masking is another tool that you can use when you want to analyze only a subset of your data, or when you have spurious data points that you do not want included in your analysis. Mask or unmask will trigger recalculation.

You can mask data points in either your worksheet or your graph. When data exist in both the worksheet and the graph, masking data in one will mask the corresponding data in the other.

Note that there are two toolbars with masking buttons: the **Tools** toolbar and the **Mask** toolbar. The masking tools on the **Tools** toolbar work only with graphs. The tools on the **Mask** toolbar work with worksheets or graphs.

15.3.1 Masking Data in Worksheets

Masking of worksheet data excludes masked data from analysis operations. When plotted, masked data points display in the mask color.

<table>
<thead>
<tr>
<th>Action</th>
<th>Toolbar Button</th>
<th>Shortcut Command</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mask data</td>
<td>![Mask Icon]</td>
<td><strong>Mask: Apply</strong></td>
<td>Mask the selected data range. Masked data will display in the mask color.</td>
</tr>
<tr>
<td>Unmask data</td>
<td>![Mask Icon]</td>
<td><strong>Mask: Remove</strong></td>
<td>Unmask the selected data range. Unmasked points are included in analysis operations and plot “normally”.</td>
</tr>
<tr>
<td>Change mask color</td>
<td>![Mask Icon]</td>
<td><strong>Mask: Change Color</strong></td>
<td>Change the mask color of the masked data range.</td>
</tr>
<tr>
<td>Action</td>
<td>Toolbar Button</td>
<td>Shortcut Command</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disable masking</td>
<td><img src="Divider.png" alt="divider" /></td>
<td>Mask: Disable Masking</td>
<td>Toggle the mask on or off for all masked data in the worksheet.</td>
</tr>
</tbody>
</table>

### 15.3.2 Masking Data in Graphs

With your graph window active:

1. Choose **Data: Mask Data Points** from the main menu or click the **Mask Points on Active Plot** button or **Mask Points on All Plots** button on the **Tools** toolbar. This activates the **Regional Mask Tool**.

2. To mask a single point, double click on the point.

3. To mask a region of points, similar to **Regional Data Selector**, press the `space` bar to toggle among masking by row index, rectangular region or by freehand region. then draw a rectangle or freehand region to mask data in that region.

Note that the cursor changes as you:

- Press `space` bar to toggle masking data points by row index number, rectangular region or freehand region.

- Choose the **Mask Points on the Active Plot** tool vs. the **Mask Points on All Plots of Active Layer** tool (Tools toolbar).

<table>
<thead>
<tr>
<th>Mask Points on Active Plot</th>
<th>Mask Points on All Plots of Active Layer</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt="icon" /></td>
<td><img src="icon.png" alt="icon" /></td>
<td>Mask data points by row index number. All data points between the lowest and highest selected index numbers are masked regardless of whether they lie inside your rectangle.</td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
<td><img src="icon.png" alt="icon" /></td>
<td>Mask data points by rectangular region. Only the data points inside the rectangle that you drag out, will be masked.</td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
<td><img src="icon.png" alt="icon" /></td>
<td>Mask data points by freehand region. Only the data points inside the region that you drag out, will be masked.</td>
</tr>
</tbody>
</table>

To remove the mask from data points in the graph window:

1. Choose either the **Unmask Points on the Active Plot** tool or the **Unmask Points on All Plots of Active Layer** tool on the Tools toolbar.
2. Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then drag to unmask your data points.

There are some useful buttons on Mask toolbar such as

- **Change mask color button** to avoid using same color as data plot as mask color.
- **Hide/Show masked points** to hide masked points on the screen, printout and exported graph.
- **Disable/Enable Masking** button to quickly toggle the mask on or off without removing the masked points.

### 15.4 Drawing or Moving, or Deleting Data Points in the Graph

This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D scatter plots.

1. Activate the graph window.
2. Click on the **Draw Data Tool**.
3. Make sure that the correct graph layer is active and place the cursor on the graph.
4. Double-click to create data points. The **Data Display** tool opens (if not already open) and displays the X and Y values for each created data point.
5. When you have finished adding data points, click on another tool (on the **Tools** toolbar) to exit drawing mode.

When you use the **Draw Data** tool, you simultaneously create a hidden worksheet named **Drawn** (worksheets are automatically enumerated, with \( n = 1, 2, 3, 4, \text{ etc.} \)).

#### 15.4.1 Opening the hidden Drawn Worksheet

Right-click on the data plot and select **Go to Drawn** from the shortcut menu or in Plot Details dialog, with data plot selected on left panel, click the **Workbook** button.

A **Drawn** workbook will appear with A(X) and B(Y) columns with coordinate values of your drawn data plot.

#### 15.4.2 Deleting a Data Point

You can delete a data point in the graph:

1. Select **Data: Remove Bad Data Points**.
2. Double-click on the data point, or click to select the data point and press **ENTER** key.
3. Click the Pointer button on the Tools toolbar or press ESC to exit Remove Points mode.

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell for the Y value will be cleared and shown as missing value.

15.4.3 Moving a Data Point

You can move a data point in the graph:

1. Select Data: Move Data Points.
2. Click on the point for which you want to change X and Y coordinates. Drag the point or use the arrow keys to move it.
3. Click the Pointer button on the Tools toolbar or press ESC key to exit the Move Data Points mode.

The data point is moved from both the data plot and the worksheet cell.

15.5 Mathematics

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume calculations.

15.5.1 Basic Math

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Simple Column Math</td>
<td>Perform basic calculations on worksheet columns or XY data plots</td>
<td>Analysis:Mathematics (workbook, graph)</td>
</tr>
<tr>
<td>• Normalize Columns/Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Average Multiple Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Differentiate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Differentiate Gadget</td>
<td>Perform differentiation over a region of interest in a graph</td>
<td>Gadgets:Differentiate... (graph)</td>
</tr>
<tr>
<td>• Set Column Values</td>
<td>Use formulae to set/transform worksheet column values</td>
<td>Analysis:Mathematics (workbook)</td>
</tr>
<tr>
<td>Tool Name</td>
<td>Description</td>
<td>Menu Entry</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>Inverse</td>
<td>Generate pseudo inverse of a matrix</td>
<td>Analysis:Mathematics (matrix)</td>
</tr>
<tr>
<td>Median Filter</td>
<td>Apply median/special/custom filter to a matrix</td>
<td>Analysis:Mathematics (matrix)</td>
</tr>
<tr>
<td>Special Filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Filter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 15.5.2 Interpolation

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolate Gadget</td>
<td>Perform interpolation over a region of interest</td>
<td>Gadgets:Interpolate... (graph)</td>
</tr>
<tr>
<td>Interpolate-Extrapolate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XYZ Trace Interpolation(3D Graph)</td>
<td>Perform interpolation-extrapolation on a group of XY data.</td>
<td>Analysis:Mathematics (workbook, graph)</td>
</tr>
<tr>
<td>Trace Interpolation(2D Graph)</td>
<td>Perform periodic interpolation on XYZ worksheet data.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Perform interpolation on cycle or periodic curves</td>
<td></td>
</tr>
<tr>
<td>Interpolate-Extrapolate Y from X</td>
<td>Perform interpolation-extrapolation on a group of XY data to find Y at given X values.</td>
<td>Analysis:Mathematics (workbook)</td>
</tr>
<tr>
<td>3D Interpolation</td>
<td>Perform interpolation with a 3D function on XYZ dataset.</td>
<td></td>
</tr>
<tr>
<td>2D Interpolate-Extrapolate</td>
<td>Perform 2D interpolation-extrapolation for a matrix</td>
<td>Analysis:Mathematics (matrix, graph from matrix)</td>
</tr>
</tbody>
</table>
15.5.3 Area/Volume Calculation

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Description</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Integrate Gadget</td>
<td>• Perform integration over a region of interest in a 2D Graph</td>
<td>Gadgets:Integrate... (graph)</td>
</tr>
<tr>
<td>• Integrate(2D Graph)</td>
<td>• Perform integration on input data</td>
<td></td>
</tr>
<tr>
<td>• Polygon Area(2D Graph)</td>
<td>• Calculate the area of enclosed plot regions</td>
<td></td>
</tr>
<tr>
<td>• XYZ Surface Area (3D Graph) (Pro Only)</td>
<td>• Calculate the area of the XYZ surface</td>
<td></td>
</tr>
<tr>
<td>• 2D Volume Integrate (Pro Only)</td>
<td>• Calculate the volume beneath the matrix surface from zero plane</td>
<td></td>
</tr>
<tr>
<td>• Matrix Surface Area (Pro Only)</td>
<td>• Calculate the area of the matrix surface</td>
<td></td>
</tr>
</tbody>
</table>

15.6 Curve Fitting

15.6.1 Linear and Polynomial Fit

Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. The menu entries of these tools are listed in the table below. All are available for both workbook or plotted data.

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Linear Fit</td>
<td>Analysis:Fitting:Linear Fit or Gadgets:Quick Fit (graph)</td>
</tr>
<tr>
<td>• Fit Linear with X Error (Pro Only)</td>
<td>Analysis:Fitting:Fit Linear with X Error</td>
</tr>
<tr>
<td>• Multiple Linear Regression</td>
<td>Analysis:Fitting:Multiple Linear Regression</td>
</tr>
</tbody>
</table>
You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some tools are available only in OriginPro.

The table below summarizes available nonlinear curve fitting tools:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Features</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Quick Fit Gadget</td>
<td>• Fit a region of interest in a graph interactively</td>
<td>Gadgets:Quick Fit (graph) or Gadgets:Quick Sigmoidal Fit (graph)</td>
</tr>
<tr>
<td>• Nonlinear Curve Fitting</td>
<td>• Fit with built-in or user-defined fitting functions</td>
<td>Analysis:Fitting:Nonlinear Curve Fit (workbook, graph)</td>
</tr>
<tr>
<td>• Implicit Curve Fitting (Pro Only)</td>
<td>• Fit with implicit functions</td>
<td>Analysis:Fitting:Nonlinear Implicit Curve Fit (workbook, graph)</td>
</tr>
<tr>
<td></td>
<td>• Orthogonal Distance Regression (ODR) algorithm</td>
<td></td>
</tr>
<tr>
<td>Tool Name</td>
<td>Features</td>
<td>Menu Entry</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Surface Fit (Pro Only)</td>
<td>• Fit data from a matrix or worksheet XYZ columns</td>
<td>Analysis:Fitting:Nonlinear Surface Fit (workbook, graph) or Analysis:Fitting:Nonlinear Matrix Fit (matrix)</td>
</tr>
<tr>
<td>• Fitting Function Builder</td>
<td>• Create or edit user-defined fitting functions</td>
<td>Tools:Fitting Function Builder</td>
</tr>
<tr>
<td>• Fitting Function Organizer</td>
<td>• Manage fitting functions by categories</td>
<td>Tools:Fitting Function Organizer</td>
</tr>
<tr>
<td>• Fitting Function Organizer</td>
<td>• Move or share functions between categories</td>
<td></td>
</tr>
<tr>
<td>• Simulate</td>
<td>• Simulate a curve from a given function</td>
<td>Analysis:Fitting:Simulate Curve</td>
</tr>
<tr>
<td>• Simulate</td>
<td>• Simulate a surface from a given function (Pro Only)</td>
<td>Analysis:Fitting:Simulate Surface</td>
</tr>
<tr>
<td>• Fit Comparison (Pro Only)</td>
<td>• Compare fit results from two datasets using one function function</td>
<td>Analysis:Fitting:Compare Datasets</td>
</tr>
<tr>
<td>• Fit Comparison (Pro Only)</td>
<td>• Compare fitting results for one dataset using two fitting functions</td>
<td>Analysis:Fitting:Compare Models (workbook, graph)</td>
</tr>
<tr>
<td>• Fit and Rank Functions (Pro Only)</td>
<td>• Compare fit results of two or more functions for a single dataset</td>
<td>Analysis:Fitting:Rank Models (workbook, graph)</td>
</tr>
</tbody>
</table>
15.7 Peak Analysis

Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.

The table below summarizes various tools available for peak analysis:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Features</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick Peaks Gadget</strong></td>
<td>• Perform peak analysis over a region of interest</td>
<td><strong>Gadget:Quick Peaks</strong> (graph)</td>
</tr>
<tr>
<td></td>
<td>• Create baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Subtract baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Integrate peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit peaks</td>
<td></td>
</tr>
<tr>
<td><strong>Multiple Peak Fit</strong></td>
<td>• Pick multiple peaks</td>
<td><strong>Analysis:Peaks and Baseline:Multiple Peak Fit</strong> (graph, workbook)</td>
</tr>
<tr>
<td></td>
<td>• Fit peaks</td>
<td></td>
</tr>
<tr>
<td><strong>Peak Analyzer</strong></td>
<td>• Create baseline</td>
<td><strong>Analysis:Peaks and Baseline:Peak Analyzer</strong> (graph, workbook)</td>
</tr>
<tr>
<td></td>
<td>• Subtract baseline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Integrate peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit multi-peak datasets (Pro Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Fit baseline (Pro Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Find hidden peaks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Compute many peak characteristics (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>
### Tool Name
- Batch Peak Analysis

#### Features
- Use a theme file created using Peak Analyzer tool
- Perform batch peak analysis on multiple datasets

#### Menu Entry
- Analysis:Peaks and Baseline:Batch Peak Analysis Using Theme (graph, workbook)

## 15.8 Signal Processing

Origin provides signal processing tools for many tasks, including producing signal transforms, smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.

You may refer to the tables below for the signal processing tools and their menu entry.

### 15.8.1 Signal Transforms

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT Gadget</td>
<td>Gadgets:FFT... (graph)</td>
</tr>
<tr>
<td>Fast Fourier Transform (FFT)</td>
<td>Analysis:Signal Processing:FFT (workbook)</td>
</tr>
<tr>
<td>Inverse Fast Fourier Transform (IFFT)</td>
<td></td>
</tr>
<tr>
<td>2D FFT (Pro Only)</td>
<td>Analysis:Signal Processing:FFT (matrix)</td>
</tr>
<tr>
<td>2D IFFT (Pro Only)</td>
<td></td>
</tr>
<tr>
<td>Short-time Fourier Transform (STFT) (Pro Only)</td>
<td>Analysis:Signal Processing:STFT (workbook)</td>
</tr>
<tr>
<td>Hilbert Transform (Pro Only)</td>
<td>Analysis:Signal Processing:Hilbert Transform (workbook)</td>
</tr>
<tr>
<td>Image Profiling</td>
<td>Plot:Image:Image Profiles (matrix) or Plott:Contour:Contour Profiles (worksheet, XYZ data)</td>
</tr>
</tbody>
</table>
15.8.2 Filtering

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• FFT Filter</td>
<td>Analysis:Signal Processing:FFT Filters (workbook)</td>
</tr>
<tr>
<td>• 2D FFT Filter (Pro Only)</td>
<td>Analysis:Signal Processing:2D FFT Filters (matrix)</td>
</tr>
<tr>
<td>• IIR Filter Design (Pro Only)</td>
<td>Analysis:Signal Processing:IIR Filter (workbook)</td>
</tr>
</tbody>
</table>

15.8.3 Smoothing

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Smooth</td>
<td>Analysis:Signal Processing:Smooth (workbook, matrix)</td>
</tr>
</tbody>
</table>

15.8.4 Correlation

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Correlation</td>
<td>Analysis:Signal Processing:Correlation (workbook)</td>
</tr>
<tr>
<td>• 2D Correlation (Pro Only)</td>
<td>Analysis:Signal Processing:2D Correlation (matrix)</td>
</tr>
</tbody>
</table>
15.8.5 Convolution

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convolution</td>
<td>Analysis:Signal Processing:Convolution (workbook)</td>
</tr>
</tbody>
</table>

15.8.6 Wavelet Analysis (Pro Only)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Wavelet Transform</td>
<td>Analysis:Signal Processing:Wavelet Analysis (workbook)</td>
</tr>
<tr>
<td>Discrete Wavelet Transform (Decomposition)</td>
<td></td>
</tr>
<tr>
<td>Inverse Discrete Wavelet Transform (Reconstruction)</td>
<td></td>
</tr>
<tr>
<td>Multi-Scale Wavelet Decomposition</td>
<td></td>
</tr>
<tr>
<td>Smoothing</td>
<td></td>
</tr>
<tr>
<td>Noise Removal</td>
<td></td>
</tr>
<tr>
<td>2D Wavelet Decomposition</td>
<td>Analysis:Signal Processing:Wavelet Analysis (matrix)</td>
</tr>
<tr>
<td>2D Wavelet Reconstruction</td>
<td></td>
</tr>
</tbody>
</table>

15.8.7 Other Advanced Tools (Pro Only)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rise Time Gadget</td>
<td>Gadget:Rise Time (graph)</td>
</tr>
<tr>
<td>Decimation</td>
<td>Analysis:Signal Processing:Decimation (workbook)</td>
</tr>
<tr>
<td>Tools</td>
<td>Menu Entry</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Coherence</td>
<td>Analysis:Signal Processing:Coherence</td>
</tr>
<tr>
<td></td>
<td>(workbook)</td>
</tr>
<tr>
<td>Envelope Curves</td>
<td>Analysis:Signal Processing:Envelope</td>
</tr>
<tr>
<td></td>
<td>(workbook)</td>
</tr>
</tbody>
</table>

15.9 Image Processing

Origin provides a collection of tools for basic image processing. These tools are accessible from the Image menu when a matrix book is active. The tools are organized in the following sub-menus:

- Image:Adjustments
- Image:Arithmetic Transforms
- Image:Conversion
- Image:Geometric Transforms
- Image:Spatial Filters

15.10 Topics for Further Reading

- [Analysis Dialog Boxes: Specifying Your Input Data](#)
- [Outputting Analysis Results](#)
- [Recalculation of Analysis Results](#)
- [Generating Analysis Report Sheets](#)
- [Performing Math Operations on Datasets](#)
- [Linear/Polynomial Regression](#)
- [Nonlinear Curve Fitting](#)
- [Peak Analysis using Origin](#)
- [Signal Processing](#)
- [Image Processing and Analysis](#)
16.1 Basic Statistics

Origin provides several tools and methods to compute basic statistics on data from either the worksheet or from a graph.

16.1.1 Basic Statistics on Worksheet

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Menu entry with worksheet active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics on Columns</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>Statistics on Rows</td>
<td></td>
</tr>
<tr>
<td>Cross Tabulation (Pro Only)</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Frequencies/Counts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Counts</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>2D Frequency Counts/Binning</td>
<td></td>
</tr>
<tr>
<td>Discrete Frequency</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Distribution</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Normality Test</td>
<td>Statistics:Descriptive Statistics</td>
</tr>
<tr>
<td>Distribution Fit (Pro Only)</td>
<td></td>
</tr>
</tbody>
</table>
16.1.2 Descriptive Statistics on Graph

Origin provides a couple of gadgets to explore and summarize data plotted in graphs.

<table>
<thead>
<tr>
<th>Descriptive Statistics</th>
<th>Menu entry with graph active</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Cluster Gadget (Pro Only)</td>
<td>Gadgets:Cluster...</td>
</tr>
<tr>
<td>• Statistics Gadget</td>
<td>Gadgets:Statistics...</td>
</tr>
</tbody>
</table>

16.1.3 Statistics on Selected Range

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data plot(s) in a graph.

Status Bar

Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and you can use the CTRL key to select non-contiguous groups of cells.

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar. Right click on the status bar to customize what quantities to display.
Command or Script Window

Statistics, Report to Script/Command Window

1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in a graph.

2. Open the Command Window or the Script Window from the Windows menu, and type one of these commands, then press ENTER:

```stats
moments
quantiles```

With the Command Window, the results are typed out below the command line. With the Script Window, you will need to issue an additional command to return your results:

```stats;
stats.=`
16.2 Statistical Graphs

Origin provides several statistical graph types. All graphs can be easily customized and saved as a template for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Box Chart, Grouped Box Chart, Marginal Box Charts</td>
<td></td>
</tr>
<tr>
<td>• Histogram, Histogram with Probabilities, Marginal Histograms, Stacked Histograms</td>
<td></td>
</tr>
<tr>
<td>• 2D Kernel Density</td>
<td></td>
</tr>
<tr>
<td>• QC (X bar R) Chart</td>
<td></td>
</tr>
<tr>
<td>• Pareto Chart</td>
<td></td>
</tr>
<tr>
<td>• Scatter Matrix Plot</td>
<td></td>
</tr>
<tr>
<td>• Probability Plots</td>
<td></td>
</tr>
<tr>
<td>• Q-Q Plots</td>
<td>Plot:Statistics</td>
</tr>
</tbody>
</table>

Some statistical graphs are only available within the Plots branch of the statistical analysis dialogs.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Means Plot</td>
<td>Statistics: ANOVA: One-Way ANOVA</td>
</tr>
<tr>
<td>• Means Comparison Plot</td>
<td>Statistics: ANOVA: One-Way Repeated Measure ANOVA (Pro Only)</td>
</tr>
<tr>
<td>• Survival Curve</td>
<td></td>
</tr>
<tr>
<td>• One Minus Survival Curve</td>
<td>Statistics: Survival Analysis: Kaplan-Meier Estimator (Pro Only)</td>
</tr>
<tr>
<td>• Hazard Curve</td>
<td></td>
</tr>
<tr>
<td>• Log Survival Curve</td>
<td></td>
</tr>
</tbody>
</table>
### 16.3 Comparing One, Two or More Groups

Origin provides parametric and non-parametric tests to compare one, two, three or more groups.

#### 16.3.1 Parametric Hypothesis Tests

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Sample t-Test</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• Two-Sample t-Test</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• Pair-Sample t-Test</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• One-Sample Test for Variance (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• Two-Sample Test for Variance (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• One-Sample Proportion Test (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• Two-Sample Proportion Test (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• Two-Sample t-Test on Rows (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
<tr>
<td>• Pair-Sample t-Test on Rows (Pro Only)</td>
<td>Statistics: Hypothesis Testing</td>
</tr>
</tbody>
</table>
## 16.3.2 ANOVA

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td>• Two-Way ANOVA</td>
<td></td>
</tr>
<tr>
<td><strong>NEW</strong> Three-Way ANOVA</td>
<td>Statistics: ANOVA</td>
</tr>
<tr>
<td>• One-Way Repeated-Measures ANOVA (Pro Only)</td>
<td></td>
</tr>
<tr>
<td>• Two-Way Repeated-Measures ANOVA (Pro Only)</td>
<td>(Supports both Balanced and Unbalanced data)</td>
</tr>
</tbody>
</table>

### 16.3.3 Non-parametric Tests

These non-parametric tests are available only in OriginPro

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>• One-Sample Wilcoxon Signed Rank Test</td>
<td></td>
</tr>
<tr>
<td>• Paired-Sample Wilcoxon Signed Rank Test</td>
<td></td>
</tr>
<tr>
<td>• Paired-Sample Sign Test</td>
<td></td>
</tr>
<tr>
<td>• Mann-Whitney Test</td>
<td></td>
</tr>
<tr>
<td>• Two-Sample Kolmogorov-Smirnov Test</td>
<td>Statistics:Nonparametric Tests</td>
</tr>
<tr>
<td>• Kruskal-Wallis ANOVA</td>
<td></td>
</tr>
<tr>
<td>• Moods Median Test</td>
<td></td>
</tr>
<tr>
<td>• Friedman ANOVA</td>
<td></td>
</tr>
</tbody>
</table>
Statistics

Notes:

Multiple nonparametric tests can be run simultaneously. (Accessible from the Statistics:Nonparametric Tests menu) Available options are:

- **(NPH) K Independent Samples**: Kruskal-Wallis ANOVA and Mood's Median Test
- **(NPH) Paired Samples**: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test
- **(NPH) Two Independent Samples**: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov Test

16.4 Advanced Statistics

Several additional tools are available in OriginPro.

16.4.1 Multivariate Analysis

Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from your data.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Principal Component Analysis</td>
<td></td>
</tr>
<tr>
<td>K-Means Cluster</td>
<td></td>
</tr>
<tr>
<td>Hierarchical Cluster</td>
<td></td>
</tr>
<tr>
<td>Discriminant Analysis</td>
<td>Statistics:Multivariate Analysis</td>
</tr>
<tr>
<td>Canonical Discriminant Analysis</td>
<td></td>
</tr>
<tr>
<td>Partial Least Squares</td>
<td></td>
</tr>
</tbody>
</table>

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the Statistics:Multivariate Analysis:Discriminant Analysis:Canonical Discriminant Analysis(System) menu.

16.4.2 Survival Analysis

OriginPro includes widely used survival tests to quantify survivorship in a population.
### 16.4.3 Power and Sample Size

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in designing experiments. Origin can compute the power of the experiment for a given sample size and can also compute the required sample size for given power values.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-Proportion Test</td>
<td></td>
</tr>
<tr>
<td>Two-Proportion Test</td>
<td></td>
</tr>
<tr>
<td>One-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>Two-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>Paired-Sample t-Test</td>
<td></td>
</tr>
<tr>
<td>One-Variance Test</td>
<td>Statistics: Power and Sample Size</td>
</tr>
<tr>
<td>Two-Variance Test</td>
<td></td>
</tr>
<tr>
<td>One-Way ANOVA</td>
<td></td>
</tr>
</tbody>
</table>

### 16.4.4 ROC Curve

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two methods that are used to discriminate between diseased and healthy cases.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROC Curve</td>
<td>Statistics: ROC Curve</td>
</tr>
</tbody>
</table>
16.5 Topics for Further Reading

- Statistics on Worksheet Columns
- Statistics on Worksheet Rows
- Descriptive Statistics
- Statistics Charts, General
- Appendix: Statistical Graph Types by Template
- Normality Testing
- Distribution Fit
- Parametric Hypothesis Testing
- ANOVA
- Nonparametric Tests
- Multivariate Analysis
- Survival Analysis
- ROC Curves
- Power and Sample Size Tests
- LabTalk Supported X-Functions: Statistics
17 How to Handle Repetitive Tasks

17.1 Recalculation

All Analysis and most data processing dialog boxes in Origin include a Recalculate control. This control allows you to tie the output of the operation to the source data such that any changes to the source data can trigger an update of the output. This allows you to analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.

Three options are available for the Recalculate control:

- **None**: No lock is displayed in the output.
- **Manual**: Changes to the input data will not result in an update of the output.
• An **auto** green lock is displayed in the output columns and graphs that contain plots of the output data.

• The output will be automatically updated when input data is changed.

• You can also recall the dialog to make changes to the analysis settings.

---

<table>
<thead>
<tr>
<th>Manual</th>
</tr>
</thead>
</table>

• A **manual** green lock is displayed in output columns and graphs that contain plots of the output data.

• The lock will turn yellow in color when input data is changed. You can manually trigger an update for each operation, or for all such pending operations in the project.

• You can also recall the dialog to make changes to the analysis settings.

---

A left-click on the lock displays a menu that provides multiple options including changing analysis parameters, opening source data sheet, switching to result sheets, and controlling the status of the operation such as switching from manual update to auto update.

### 17.2 Dialog Themes

Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file. Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different settings.

Last used dialog box settings are automatically saved as a `<last used>` Theme. Origin also allows you to save your custom settings as the `<default>` Theme. The default Theme, last used Theme, and any named Theme that you have saved, can all be accessed from the theme fly-out menu that opens from the dialog box. These same Themes are also available from the main menu item associated with the analysis dialog box.
How to Handle Repetitive Tasks

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.

Tutorial: Saving and Re-using a Dialog Theme

1. Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder.
2. Highlight column B and select Analysis: Fitting: Linear Fit...
3. In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit Options) and set the Fix Intercept at edit box to 0.
4. Click the button next to the Dialog Theme control and select Save as ... In the Theme Name box, enter Zero Intercept and press OK. Press OK again to close the Linear Fit dialog box and perform the analysis. FitLinear1 and FitLinearCurve1 result sheets are added to the workbook.
5. Return to the source data and highlight column C. Select Analysis: Fitting: Linear Fit from the menu. You will see a fly-out menu with multiple Theme options including the Zero Intercept Theme you saved in the previous step.
6. Select your saved Theme. The analysis is automatically performed on Column C using the settings saved in the Theme. Note that the dialog box does not open.

- Hold the SHIFT key while clicking on your Theme in the main menu and the associated dialog box will open with settings from the selected Theme loaded into the dialog box.
- The default analysis theme is called System Default. To load it, click the fly-
out menu in the analysis dialog and choose **System Default**.

- Click the fly-out menu in an analysis dialog and choose **Delete** to delete themes you have created, including a customized <default> theme.
- The customized <default> themes for all analysis dialogs are saved in Defaults.xml under User Files folder. Deleting will restore system default settings to all analysis dialogs.

### 17.3 Project and Workbook Templates

#### 17.3.1 The Project as Template

The Origin project file can be used as a template for carrying out repetitive graphing and analysis tasks. Create the desired graphs and/or analysis results from data in your workbook(s) and save the project. You then simply replace the workbook data, to automatically update graphs and results.

When saving the project, you have the following options:

1. Use the **File: Save Project without Data** menu item. This will clear all data before saving the project.
2. Use the **File: Duplicate Project without Data** menu item. This will create a copy of the existing project where all the data will be cleared before saving.

You can, of course, save the current project with data, but the above two options may prove useful when working with very large datasets as they will reduce project file size.

#### 17.3.2 The Workbook as Template

You can save a workbook as a template for repetitive graphing and/or analysis tasks. The workbook can contain worksheets with data, floating or embedded graphs and notes windows.

If the workbook contains analysis operations, the **File: Save Workbook as Analysis Template...** menu command can be used to save the workbook. All data columns that are used in the analysis operations in the workbook will be cleared before saving. Data that are not associated with analysis operations will not be cleared. Workbooks saved in this manner can be accessed quickly from **File: Recent Books** on the main menu.

**Tutorial: Creating an Analysis Template**

1. Start with a new workbook and import the file `Samples\Curve Fitting\Sensor01.dat`.
2. Select column B and use the **Analysis: Fitting: Linear Fit** and open the **Linear Fit** dialog.
3. Change the **Recalculate** drop-down to **Auto**.
4. Check the **Fix Intercept** check box and enter 0 in the **Fix Intercept at** edit box.
5. Click **OK** to close the dialog and perform the linear regression.

6. Switch to the **FitLinear1** report sheet to view results including plots of the best-fit line and residuals.

7. Now switch back to the original data sheet and import the file **Samples\Curve Fitting\Sensor02.dat**. The analysis results will be automatically updated with this new data. You can continue to use the workbook for other data. Or right click the workbook title and choose **Duplicate without Data** to create a new workbook with linear fitting operation saved in it. Then import new data in new workbook and thus save a project with multiple such workbooks if desired.

8. With the workbook active, select the menu **File: Save Workbook as Analysis Template...** and in the dialog that opens, give a name such as **Linear Fit of Sensor Data** and click **Save**.

9. Choose **File: Recent Books** menu item and select the template that was saved in the previous step. The workbook will open and the data sheet will be empty.

10. Import the file **Samples\Curve Fitting\Sensor3.dat** into the empty data sheet (1st sheet). The analysis results will update upon import of the new data.

The workbook template can even contain custom report sheets and a summary sheet. Thus, you can create an individual report for each file. The advantage of the workbook-as-template method is that the **Batch Processing** tool can be used to process multiple files or datasets and create a final summary report for all files that are processed as part of the batch analysis. View the **Batch Plotting** and **Batch Analysis** sections of this chapter for examples of using the workbook as a template when handling repetitive tasks.

### 17.4 Batch Plotting

Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two sections outline how to create multiple graphs from (1) data that is already in worksheets, and (2) multiple data files. In addition to these two procedures, batch plotting can also be performed programmatically using LabTalk script or Origin C.

#### 17.4.1 Duplicating Graphs with Data from Other Books/Sheets/Columns

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot the graph, you can have Origin clone that graph via **Window: Duplicate (Batch Plotting)** menu with new data. There are two cases:

- If you have plotted a graph with a single data and customized it, and want to clone the graph with other data in the same worksheet: Choose **Window: Duplicate (Batch Plotting): Duplicate with New Columns** menu. Pick other data (columns) you want to plot. Each data with be plotted as a new graph.

- If you have plotted a graph with data in one worksheet or workbook and customized it, and want to clone the graph with other worksheet or workbook with similar data structure: Choose **Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Books** menu. Origin will
list all worksheets or workbooks with similar data structure. Pick worksheet or workbook you want to plot. Each worksheet or workbook will be plotted as a new graph.

**Tutorial: Duplicating a graph with data from other sheets**

1. Press the New Project button on the Standard toolbar.

2. Press the Import Wizard button on the same toolbar. This opens the Import Wizard dialog box.

3. Click the browse button to the right of the File box. Browse to the Import and Export folder and select the files S15-125-03.dat, S21-235-07.dat, and S32-014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog box, press Finish. The files are imported into three separate workbooks.

4. Drag and select all three Y columns in one of the workbooks, then select the menu item Plot: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one shared X axis. Make any desired customizations to the graph.

5. Right-click on the title bar of the graph window then select Duplicate (Batch Plotting): Duplicate with New Sheets/Books... shortcut menu.

6. In the dialog box that opens select the other two worksheets then press OK to close the dialog. Two more graphs are created with data from the other two worksheets.

**17.4.2 The Workbook as a Template for Processing Multiple Files**

If you want to plot graphs with many data files but doesn't want to have all data file imported into workbook first, you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your workbook and save the workbook as a template. Using this template you can process multiple files, creating a workbook for each file and its corresponding graph.

**Tutorial: Creating graphs from multiple data files**

1. With a new workbook active, choose File: Import Single ASCII and import the file Sensor01.dat from the Samples\Curve Fitting subfolder of the Origin installation folder.

2. Highlight column B and create a line+symbol graph of the data.

3. Double click on the X axis to open the Axis dialog. Make sure Scale tab is active. Select both Horizontal and Vertical on the left panel and set Rescale to be Auto. This is to make sure graph scale will update automatically based on data.

4. In the workbook, right-click on the worksheet tab and select Add Graph as Sheet, then select the graph created above. This will add a new workbook sheet containing an embedded graph.

5. Switch to the data sheet, double-click on the tab rename the sheet as Data.

6. Select the Worksheet: Clear Worksheet menu item to clear the data in this
sheet. Note that this step is optional. Clearing the data will reduce the size of the template saved in the next step. Note that you should clear only the data sheet, and not the other sheets such as those with embedded graphs.

7. Select the File: Save Window As... menu item, assign a name such as Sensor Data and Graph and press Save.

8. Now we can use this template to process multiple files. Select the File: Batch Processing... menu item.

9. In the dialog box that opens set the Batch Processing Mode to Load Analysis Template, then set the Analysis Template control to point to your saved template.

10. Set Data Source to Import from Files and select the three files Sensor01.dat, Sensor02.dat, and Sensor03.dat from the Samples\Curve Fitting subfolder.

11. Set the Data Sheet to Data and set Result Sheet to <none>.

12. Press OK to close the dialog box. You should get three workbooks with the data imported into the first sheet and the graphs updated in the 2nd sheet. To further edit any of the graphs, double-click on the graph to pop up an editable page.

If processing of your data requires some custom import settings, you can save those settings to the data sheet from the Import and Export dialog box (Save to Sheet, available from the Dialog Theme menu). Settings thus saved to the sheet will be used for import when batch processing of multiple files using the workbook as a template.

17.5 Batch Analysis

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.

17.5.1 Analyzing Multiple Datasets in Dialogs

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets. Report sheets created by these dialog boxes include a summary table listing the parameter values for each dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an external sheet for further processing.

Tutorial: Fitting Multiple Datasets

1. Open a new workbook and import the file Samples\Curve Fitting\Multiple Gaussians.dat from the Origin installation folder.

2. Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4.

3. Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve
Fit... menu item to open the NLFit dialog box.

4. Select Gauss from the Function drop-down list, then press the Fit button to perform fitting and close the dialog box.

5. Switch to the FitNL1 report sheet. You will see a table named Summary which lists the fit parameters and fit statistics for each dataset.

<table>
<thead>
<tr>
<th></th>
<th>y0</th>
<th>xc</th>
<th>w</th>
<th>A</th>
<th>sigma</th>
<th>FWHM</th>
<th>Height</th>
<th>Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak 1</td>
<td>1.933</td>
<td>3.165</td>
<td>24.948</td>
<td>0.247</td>
<td>12.724</td>
<td>0.643</td>
<td>151121</td>
<td>5.803</td>
</tr>
<tr>
<td>Peak 2</td>
<td>4.954</td>
<td>9.057</td>
<td>20.046</td>
<td>0.144</td>
<td>8.621</td>
<td>0.325</td>
<td>49182</td>
<td>1.928</td>
</tr>
<tr>
<td>Peak 3</td>
<td>0.147</td>
<td>2.015</td>
<td>24.973</td>
<td>0.242</td>
<td>12.393</td>
<td>0.620</td>
<td>11116</td>
<td>0.643</td>
</tr>
<tr>
<td>Peak 4</td>
<td>-2.033</td>
<td>3.049</td>
<td>20.075</td>
<td>0.053</td>
<td>4.811</td>
<td>0.112</td>
<td>-51452</td>
<td>1.188</td>
</tr>
</tbody>
</table>

In the NLFit report sheet, click on the downward-pointing arrow button next to the table named Summary and select Create Copy as New Sheet. This will create a copy of the table in which all cells are linked to the report. Any updates/changes to the fit will automatically update the values in this copied sheet. This sheet can then be used to plot or to perform secondary analysis on the fit parameters.

17.5.2 Using Gadgets for Analyzing Multiple Curves

Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets perform a range of functions such as selecting a data range of interest, switching from one dataset to another, and setting various preferences specific to the analysis being carried out.

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings, and generating a table of results across all datasets.

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves

1. Open the project "Samples\Spectroscopy\Absorbance Spectra.opj".

2. With the graph window active, choose Gadgets: Integrate... from the main menu.

3. In the dialog that opens, click the Baseline tab and set the Mode drop-down to Straight Line.

4. Click the Output tab, expand the Output Quantities to node, and check Append to Worksheet. Press OK to close the dialog box.

5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI and resize this object to cover the entire data range plotted in the graph. The integrated area will be displayed as a shaded region.

6. Click the arrow button at the top right of the ROI object, then choose Change Data from the context menu and switch to another plot in the layer. Check that the current baseline setting works for other curves in the layer.
7. Click the arrow button \( \Rightarrow \), select **New Output for All Curves (N)** or directly press N key. Integration is performed on all curves.

8. Click the arrow button \( \Rightarrow \) again and select **Go to Report Worksheet**. Expand the report worksheet to view the integration results from all curves.

17.5.3 Batch Analysis Using an Analysis Template

The **Batch Processing** tool allows you to process multiple files or datasets using an **Analysis Template**. Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook, and save that workbook as an Analysis Template. The tool then uses the Template to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and additionally, to create a summary table with select analysis parameters and other metadata that you have pre-configured in your analysis template.

**Tutorial: Batch Analysis of Multiple Files using an Analysis Template**

1. From the main menu, choose **File: Batch Processing....** This opens the **Batch Processing** dialog box.

2. Set Batch Processing Mode to Load Analysis Template.

3. Press the browse button \( \cdots \) to the right of the **Analysis Template** box and select the file **Sensor Analysis.OGW** located in the **Samples\Batch**
Processing subfolder under your Origin installation folder. This Analysis Template contains multiple sheets set up for linear regression analysis, reporting, and summary tables.

4. Set Data Source to Import From Files, then press the browse button \(\ldots\) to the right of the File List and select the files Sensor01.dat, Sensor02.dat and Sensor03.dat from the Samples\Curve Fitting subfolder under your Origin installation folder.

5. Set Dataset Identifier to File Name, Data Sheet to Data, and Result Sheet to Result, thus selecting the appropriate sheets in the Template.


7. Click OK to close the dialog box. The three files are processed. You will find three books with the data, analysis results, and report for each file, and a fourth book containing the summary table of analysis results from all files.
Saving the initial workbook as an Analysis Template is optional. You can simply save the Origin project (.opj) and next time replace the data in your workbook to update all results and graphs. The **Batch Processing** tool also has an option to repeatedly import files into the active window, allowing you to simply re-use an existing book within a project (which contains all desired analysis and graphs) as an on-the-fly template for the batch analysis.

Beginning with Origin 2016, you can batch generate analysis reports using a custom **MS Word** template, with the option of outputting a **PDF** file for each report. For more information, see this tutorial.

### 17.6 Repeating Analysis on Other Datasets or Data Plots

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the lock associated with the operation. In worksheet columns or reports, clicking the lock will show the menu command **Repeat this for All Y columns**. Selecting this will repeat the analysis on all other Y columns in the source data sheet. In a graph, clicking the lock will show the menu command **Repeat this for All Plots**. Selecting this will repeat the analysis for all other data plots in the graph page, even if the plots are in different layers.

This is particularly useful for such analysis dialog boxes as **smoothing**, or **interpolation**, etc. that support input of only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can be repeated on all other datasets.

**Tutorial: Normalizing Multiple Columns in a Worksheet**

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty workbook.
2. Select column B, then click the menu **Analysis: Signal Processing**: **smooth** and open the dialog box.
3. Accept the defaults and press **OK** to perform smoothing. A new column will be added with the smoothed data.
4. Click on the lock in the output column and select **Repeat this for All Y columns**. Three more columns of smoothed data with same settings will be generated from the data in columns C thru E.

### 17.7 Repeating Analysis Using Data Filters

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This **Data Filter feature** can also be used in conjunction with the **colcopy (column copy) X-Function** to produce multiple graphs from the same source data using different filtering conditions. The filtered data can also be analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.
Selected columns from the source data sheet can be copied to create child sheets where the filter condition stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is updated, all child sheets, associated graphs and analysis results will automatically update using their respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to the parent sheet at any time.

The image below displays the source workbook with data for several makes of automobiles. Two books were created with a subset of columns and a data filter to restrict the data to a particular make of automobile. Linear regression analysis of the filtered data was performed, allowing comparison of the results across the two filters.

**Tutorial: Locking a Filter Condition on Copied Columns**

1. Import the file `Samples\Statistics\Automobile.dat`
2. Click on the Make column, then right-click and select Filter: Add or Remove Filter context menu.
3. Click on the filter icon that was added to the column, and uncheck all makes other than Honda (Choose Select All to clear all and then select Honda). Click OK.
4. Hold down the CTRL key and click and select the Make, Power and Engine Displacement columns. Next, right-click and select the Copy Columns to...
context menu.

5. Accept defaults in the dialog that opens, and click **Ok** to copy the columns. A new worksheet will be added to the workbook.

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the Origin workspace to create a separate workbook.

7. Click on any of the locks in the columns of this copied sheet, and select **Worksheet Filters: Lock**. The filter conditions will be locked to this sheet. If you change the filter condition in the original data sheet, this copied sheet will not be affected.

8. You can modify the filter condition to Toyota and use Copy Columns to to create another worksheet. Plot Power vs Engine Replacement, and do linear fit from such new worksheet to compare between different automobile makes.

### 17.8 Automating Tasks Using Programming

In addition to the above mentioned methods for automating tasks, Automating Origin using the interface, graphing and analysis features can also be accessed programmatically from either the **LabTalk** scripting language or from **Origin C**. Access to Graph Themes and templates, and Analysis Templates can be programmed. You can set up some of the procedure manually by first creating the templates using the graphical user interface, and then write your code to call the templates as needed.

You can get a broad look at what programming options are available in Origin by browsing the Programming Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.

### 17.9 Topics for Further Reading

- [Recalculation of Analysis Results on Data or Parameter Change](#)
- [Saving Analysis Dialog Settings as a Theme](#)
- [The Theme Organizer, Dialog Themes](#)
- [Analysis Templates](#)
- [Batch Processing and Analysis Templates](#)
- [Copy and Paste Operations](#)
- [Using Data Filters to Obtain Different Views of Your Data](#)
- [Analysis Report Sheets and Columns](#)
- [Tutorials: Batch Processing](#)
- [Video: Batch Processing](#)
- [Tutorial: Combine Quick Peaks Gadget with Peak Analyzer](#)
18 Publishing and Export

18.1 Copying and Pasting Graphs to Other Applications

There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word): as a Picture, or as an Origin Graph Object.
1. Click on your Origin graph to activate it, then ...
   - To copy the graph as a picture, choose Edit: Copy Graph as Picture.
   - To copy the graph as a graph object, choose Edit: Copy Page.

2. In your target application choose Paste or press CTRL+V.

When you paste as a picture, the graph is inserted as an image. In MS Word, for instance, double-clicking on the image launches Word's picture-editing tools, but this method does not allow for further graph edits in your Origin software.

When you paste as a graph object, you can later double-click on the object in the target application to launch a new instance of Origin. The graph, and any associated data sheets, will be available for editing. After editing, use Origin's File: Exit and Return to... menu item to update the embedded object, close Origin and return to the target application.

Use the Tools:Options menu item and then go to the Copy Page Settings group in the Page tab to view and modify settings related to copy and paste. For certain applications, you may need to select Advanced and specify a Set Resolution value, to maintain a high-quality image for the embedded object.

Note: For more information, please refer to the:
Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs in Other Applications

18.2 Organizing Your Graphs for Presentation or Export

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder and arranging them there:

- Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph window, to a new Favorites subfolder (visible in Project Explorer).
- When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the corresponding dialog box or (2) set slide order following this procedure.

18.3 Exporting Graphs and Layout Pages to an Image File

To export a graph or a layout page as an image file, select the menu File:Export Graphs. This will open the expGraph dialog box which offers several options to control the export.

Origin supports 15 export file formats:

| Raster Formats | BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF; |
### Vector Formats
| AI, CGM, DXF, EPS, EMF, PDF, WMF |

The `expGraph` dialog offers options for customizing the output size by scaling the height or width of the page, various settings that are specific to the chosen file format, options for naming the output file, and options to perform batch exporting of multiple pages. Customized settings can be saved as a Theme file for repeat use. The last used settings are available from the **File: Recent Exports** menu item.

**Note:** For more information, please refer to the:  
Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or Layout Page to an Image File

Exporting to raster formats such as TIFF and specifying a high resolution (e.g. 600 DPI or above) can produce a very large output file size, depending on the page size. To reduce the file size, consider reducing the size of the page before export. Consult with your publisher to determine the actual width of a print column in your journal.

### 18.4 Sending Graphs to PowerPoint

You can send a batch of Origin graphs to PowerPoint as either pictures or as embedded objects that can be further edited in your Origin software (double-click on the graph in PowerPoint to launch an instance of Origin).

Click the **Send Graphs to PowerPoint** button on the **Standard** toolbar or right-click in Project Explorer and select **Send Graphs to PowerPoint...** from the shortcut menu. This opens a dialog with controls for specifying how your graphs are sent to PowerPoint.

The Send Graphs to PowerPoint feature has been improved for Origin 2016. You can send graphs to an existing PowerPoint file or PowerPoint template, with options to specify on which slide to begin inserting graphs, and whether you want to create a new slide for each graph based on a specified "starting slide", or overlay graphs on an existing sequence of slides in your PowerPoint file.

- Select multiple graphs in **Project Explorer** before opening the dialog, and only the selected graphs will be sent to PowerPoint by default.
- Choose the **Specified** option in the **Select Graph(s)** drop-down list to remove graphs you don't want to send, and change graph order.
- Besides showing the window name or window path as a slide title, you can also specify a custom string that incorporates metadata properties in the slide title.
- When sending graphs to an existing PowerPoint file or template, set **Slide Mode** as **Start New** to create a new slide for extra graph page, using a specified "starting slide."
18.5 Slide Show of Graphs

Origin has a built-in slideshow utility for viewing or presenting your graphs. The slide show can be started in two ways:

- Right-click on any folder in Project Explorer and select Slide Show of Graphs...

or

- Click the Slide Show of Graphs button on the Standard toolbar.

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub folders, etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph window of the currently displayed slide).

Tutorial: Slide Show of Graphs

1. Use the File: Open Sample Projects: 2D and Contour Graphs menu to open the sample project.

2. Click on the Slide Show of Graphs button in the Standard Toolbar.

3. Accept default settings in the dialog that opens, and press OK to start the slide show.

4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides.

18.6 Creating Movies

Origin provides a Video Builder tool, accessible from the Open Video Builder button on the Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame at a time to a video (.AVI) file.

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data and then writing out the graph as a frame in the video, at each step during the computation.

Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation

For specific examples of programmatically created movies, including Origin Projects and code, please visit www.originlab.com/animation.
18.7 Exporting Worksheets and Matrices

18.7.1 Exporting Worksheets

With a worksheet active, the **File: Export** menu item provides the following options:

- **ASCII, NI TDM (TDM, TDMS), and Sound (WAV)**: This option is available only for sheets containing data columns, and is not available when report sheets such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored.

- **As Multipage PDF File**: This option is available only on sheets with data columns, and not for report sheets. Use the **View: Page Break Preview Lines** menu item to view the vertical and horizontal page break lines that determine which columns and rows will be included in each page of the export. Floating or embedded graphs placed in the worksheet will be included in the exported image.

- **As Image File**: This option is available on both data and report sheets. In the dialog that opens, you can select whether to export the entire sheet, visible area, or selection. Image file formats including PDF are supported. Floating or embedded graphs placed in the worksheet will be included in the exported image.

When creating a custom report from a worksheet that combines data, numeric results and graphs, the best option is to export the entire sheet as a PDF file, or export the sheet as a multi-page PDF file.

18.7.2 Exporting a Matrix

Origin matrix data can be exported in these two formats:

- **ASCII**: This will create an ASCII file of the data contained in the active matrix object.
- **Image**: This option will export the image view of the active matrix object, as a raster file.

**Note**: For more information, please refer to the:

Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and Matrices
18.8 Topics for Further Reading

- The **Tools:Options** Page Settings
- Pasting or Embedding Graphs in Other Applications
- Exporting Your Graph or Layout Page to an Image File
- Which Image Format Should I Choose?
- The Export Graph Dialog Box
- Send Graphs to PowerPoint
- Send Graphs to PowerPoint Dialog Box Settings
- View Graphs as a Slide Show
- The Slide Show of Graphs Dialog Box Settings
- Creating Graph Animations
- Printing Graphs, Layout Pages and Analytical Results
- The Print Dialog Box
- The Print Options Dialog Box
- Copying and Pasting Graphs inside Origin
- Inserting Graphs and Images into Worksheet Cells
- Tutorial: Creating a Custom Report Sheet
- Using the Layout Page Window
- Creating a Master Page Layout for Graphs
As you gain experience with Origin, you may want to access Origin features programmatically, add your own custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic programming options available in Origin. For more detailed information, see the following Origin programming-related resources:

- Programming documentation including guides, language references, and examples are available from the Help menu in the product.
- Online programming documentation is available at www.originlab.com/doc.
- You can typically locate online programming pages by performing a web search from your browser using phrases such as: labtalk importing, originc interpolate, or labview origin send data.
- An Origin Programming Forum can be found at www.originlab.com/forum.
- Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your Origin software.
19.1 LabTalk

LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots. LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections in a file, and those individual sections can be executed from the user-interface at the command prompt in the Script Window or Command Window; from buttons added to worksheets and graphs; from included or custom-made toolbar buttons; or from custom menu commands.

The following "mini-tutorial" will demonstrate adding a button object to a worksheet, associating a short LabTalk script with the button, then using the button to execute the script and perform a basic statistical calculation while writing the results to the worksheet.

1. Run Origin and start a new project by clicking the New Project button on the Standard toolbar.
2. Click File: Import: Single ASCII and browse to the file \Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is imported into the active worksheet window.
3. With the worksheet window active, click Format: Worksheet. In the Worksheet Properties dialog, click the Size tab and set Gap from Top to 25, then click OK. A gap is added to worksheet window.
4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added and type "Add Mean Label Row" into the text object. Click outside the text object to exit edit mode.
5. Right-click on the text label and select Programming Control.... Set Script Run After to Button Up. Copy and paste the following script into the text box:

```labtalk
wks.userParam1 = 1;
wks.userParam1$ = "Mean";
for (int ii = 2; ii <= wks.ncols; ii++)
{
    range rr = $(ii);
    Col$(ii)[D1]$ = $(mean(rr),.2*);
}
```
6. Click **OK** to apply settings and close the **Programming Control** dialog box. Note that your text object now looks like a button.

7. Click the button. Note that a new header row labelled "Mean" is added to the worksheet and the mean value of each column of data is written to the Mean row cell above the corresponding column.

**Note:** For more information on LabTalk, Origin's built-in scripting language, please consult your product documentation at [Help: Programming: LabTalk](#). Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.

---

## 19.2 Python

Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports command line execution from the Script Window, or the running of .py files. To access Origin from Python, you can use the supplied **PyOrigin** module.

The current embedded Python in Origin is version 3.3.5 and version 2.7.8.

**Note:** For more information on integrated usage of Origin and Python, refer to the LabTalk Scripting Guide: [Help: Programming: LabTalk > LabTalk Scripting Guide > Working with Python](#). Sample files can be found in the \Samples\Python folder of your Origin software.

---

## 19.3 R

Beginning with Origin 2016, Origin supports running R commands in the Origin environment. You can issue R commands in the Script Window or from the built-in R Console, or you can run .R files. All releases of R are supported.

From Origin, you can connect with R in two ways:

- **R.** Installed on your local computer.
- **Rserve.** Installed on a remote PC.
19.4 Origin C

**Origin C** is a full-featured high-level programming language based on the ANSI C programming language syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and manageability for developing and debugging code of greater scope and complexity.

Origin C also provides access to the **NAG Numerical Library** functions included in your Origin installation. NAG functions provide you with a large selection of algorithms for performing computations ranging from simple statistics and Fourier transforms to linear algebra and multivariate analysis.

**Note:** For more information on Origin C, please refer to the Origin C documentation:

**Help:** Programming: **Origin C**

There you will find usage information, a language reference, developer notes, examples, etc.

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.

19.5 X-Function

An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function. Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-Functions. Once an X-Function has been created, it can be accessed from anywhere in the interface that allows for script execution, such as the script window, toolbar buttons, or custom menu items.
19.6 Automation Server

Origin can be used as an **Automation Server**. Client applications such as National Instruments™ **LabVIEW™**, Microsoft **Excel**, or custom VB/VC/C# applications can exchange data with Origin, and can also send commands to be executed within Origin.

**Note:** For more information on Origin’s Automation Server functionality, refer to the product documentation installed with your Origin software:

**Help:** Programming: **Automation Server**.

There you will find examples and language reference information. Sample files can be found in the \Samples\COM Server and Client folder of your Origin software.

---

19.7 LabVIEW

National Instruments™ **LabVIEW™** is widely used for data collection. For example, many instrument and sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-acquisition analysis and presentation.

Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs in their main LabVIEW application to communicate seamlessly with Origin.

**Note:** For more information on Origin-LabVIEW connectivity, see the product documentation installed with your Origin software:

**Help:** **LabVIEW VI**

Examples and tutorials are provided.
19.8 Orglab

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their frontend software to output data as Origin files.

The Orglab module is available for both 64-bit and 32-bit systems. To find out more about Orglab and to download the Orglab module, go to the Products > Orglab page of www.originlab.com.
# 20 Customizing Origin

## 20.1 Customizing Default Settings

### 20.1.1 Setting Preferences with the Options Dialog Box

The multi-tabbed **Options** dialog box has controls for Origin global settings pertaining to numeric display, file and system paths, text fonts, Origin program opening and closing behaviors, etc.

To open the Options dialog box:

- Choose **Tools: Options** (any Origin window is active)
- If you are working with Excel in Origin choose **Window: Origin Options** (Excel workbook is active)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Controls For</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Axis Tab</strong></td>
<td>• Max number of ticks for numeric and date/time scales</td>
</tr>
<tr>
<td></td>
<td>• Distances from the tick labels to tick marks, axis titles</td>
</tr>
<tr>
<td></td>
<td>• Display of log scales when using scientific notation</td>
</tr>
<tr>
<td><strong>Excel Tab</strong></td>
<td>• Use of default plot assignments</td>
</tr>
<tr>
<td></td>
<td>• Scan datasets for legend text</td>
</tr>
<tr>
<td></td>
<td>• Opening Excel files by drag-and-drop</td>
</tr>
<tr>
<td><strong>File Locations Tab</strong></td>
<td>• Set file paths to track last opened, last saved, last exported file</td>
</tr>
<tr>
<td></td>
<td>• Set default path and file extension for importing different file types</td>
</tr>
<tr>
<td></td>
<td>• Set file types in ASCII import dialogs.</td>
</tr>
<tr>
<td><strong>Graph Tab</strong></td>
<td>• Dash lines definitions, line to symbol gap, user-defined symbols, etc.</td>
</tr>
<tr>
<td></td>
<td>• 2D graph anti-aliasing.</td>
</tr>
<tr>
<td></td>
<td>• Enable in-place editing of linked and embedded graphs</td>
</tr>
<tr>
<td></td>
<td>• Speed mode reminder watermark</td>
</tr>
</tbody>
</table>
## 20.1.2 System Variables Dialog

System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors. Origin’s **Set Systems Variables** dialog box (**Tools: System Variables...**) can be used to view and set system variable values. In the dialog, there is a link named **System Variables List** which opens a web page with a list of all system variables, the default value, and description.

To customize a particular system variable:

1. Type the system variable name in the first column, without the @ symbol. For example, if you wish to make a global change to the **Recalculate** mode of analysis dialog boxes, type: DAM

2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set **Recalculate** to **Auto**, type the value: 1.

3. Add optional comments in the third column and click **OK** to close dialog.

This modified value will be remembered and applied in every Origin session.
You can quickly read or set the value of a writable system variable in the Script Window (Window: Script Window) by typing @systemVariable= as, for example ...

@DAM=

... then pressing ENTER, but note that typing in the Script Window sets the variable value for the current session only.

20.1.3 3D OpenGL Settings Dialog

Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced performance including fast drawing, fast rotation and zoom, transparency, and lighting support.

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware’s support for OpenGL, run Origin and choose Tools: 3D OpenGL Settings... Look under OpenGL Info for information on graphics hardware and the supported version of OpenGL.

If your graphics hardware is older, you may experience compatibility issues with things such as transparency settings and anti-aliasing. The controls under the Settings node in this dialog allow you to do such things as disabling transparency. The dialog box also provides information on disabling OpenGL.

For more information on OpenGL in Origin, see the links under “Topics for Further Reading” at the end of this chapter.

20.2 Customizing Menus

20.2.1 Custom Menu Organizer

If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom Menu Organizer you can...

- Create up to 3 main menus and corresponding sub-menus
- Assign LabTalk scripts and X-Functions to a menu item
- Restrict menu item access to specific window types
- Hide unused built-in menu items, streamlining your Origin workspace

To open the Custom Menu Organizer, choose Tools: Custom Menu Organizer... from the main menu. Then press F1 or click the button in the upper-right hand corner of the dialog box for instructions.

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from the Format: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch from one configuration to another. A Default configuration is also available in the fly-out, to revert to default menu settings. Configuration files can also be shared with colleagues.

20.2.2 Displaying Bitmaps in Menus

You’ll note that for some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap indicates that there is an equivalent toolbar button.
On some systems such as VirtualPC or Terminal Servers, menu bitmaps may cause a long delay when opening menus. To turn off the display of menu command bitmaps:

1. Select **Tools: Options** to open the **Options** dialog box.
2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK.

### 20.3 Customizing Toolbars and Buttons

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.

#### 20.3.1 Displaying, Hiding or Moving Toolbar buttons

- Click the small down arrow at the end of any toolbar and select the **Add or Remove Buttons** context menu. Then select desired sub menu and check/uncheck to show/hide buttons. A **Reset** option is also available.
- Press ALT key and drag a button to any new toolbar location.
- Press ALT key and drag a button to blank Origin workspace to create a new toolbar.
- Press ALT key and drag a button to any window till X shows, then release to delete the toolbar.

#### 20.3.2 Customizing Toolbar Button Appearance

Use controls on the **Options** tab (View: Toolbars) to:

- Show toolbar screen tips and shortcut keys on hover
- Increase toolbar and toolbar button size
- Toggle between "flat" or 3D toolbar buttons

#### 20.3.3 Displaying or Hiding a Toolbar

- Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to dock.
- In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to edge of the Origin workspace to dock.
- In docked mode, drag the left/top end of a toolbar to reposition.
- To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag buttons from the Button Groups tab to add buttons on the new toolbar.
- Use the Reset, Reset All buttons to reset toolbars.
20.3.4 Creating New Toolbars with New Bitmap Images

Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run when click it. Choose View: Toolbars... and create new button group on Button Group tab.

- Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.
- Click any button and click Settings... button to link .ogs (Script) file section with the button.
- Drag the button to Origin workspace to create toolbar button.
- If you are feeling really creative, Origin allows you to define a new button group that uses your own 16 color, 16 x 16 pixel bitmaps.
- Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag and drop the OPX file onto Origin workspace to install the toolbar.

**Note:** To learn more about creating and exporting user-defined toolbars, see:

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars

20.3.5 Add a Custom Button to the Window Title Bar

Origin supports adding a system button to the left of the minimize button on the window title bar. A custom LabTalk script can then be associated with this button.

**Note:** Please view the -tbb option of the LabTalk Page command in the Programming help file:


20.4 Customizing the Status Bar

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other useful information depending upon current action, selection, window, etc.

- Right-click on Status Bar to customize the display.
- Press ALT and drag items along the Status Bar to reorder.

20.5 Customizing the Origin Workspace

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages Log windows.

- Right click on the window title bar to specify dock, hide, auto hide, and other settings.
• When auto-hide is unchecked, double click to float the window.
• Drag the window title to move or dock to a new location.
• Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space.
• Choose View: Toolbars... from main menu. On the Toolbar tab:
  o The Reinitialize button resets menu, toolbar and dockable windows to default settings.
  o The Export button exports the current menu, toolbar and dockable window settings to an .OPX file. Drag and drop the OPX file onto another Origin installation to configure the workspace to match your customized settings.

20.6 Templates and Themes

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to the creation of custom settings for repeat use. You can save your custom settings either as templates or themes, described briefly in the following sections.

Note: For detailed information please refer to Origin Help file, see:
Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)

20.6.1 Templates

The Origin template concept applies to graphs, workbooks, matrix books, and Analysis Templates™. Templates allow you to choose a set of properties or operations and save those for repeat use.

For instance, Origin ships with over 100 built-in graph templates that are used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you can create your own graph, adding more layers, setting scale or dimensional relationships between layers, modifying data plot properties, etc., and then save your customizations as a user-defined graph template (.otp) file by clicking File: Save Template as....

You cannot overwrite built-in templates (graph or otherwise). If you customize a template, then choose Save Template as... and attempt to overwrite the built-in template (by saving the file with the same name), the custom template will be saved to your User Files Folder (UFF). This UFF copy then takes the place of the built-in template and this template will be used when clicking the corresponding menu command or toolbar button. To reconnect a built-in template with these menu commands or toolbar buttons, you will need to delete (or remove) the customized template from your UFF.

An important subset of graph templates are what are called “cloneable” templates. These templates display a “sheep” icon next to the template name or preview image. For more information, see the section on cloneable templates in Graph Template Basics in your Origin Help file.
The template concept extends to workbooks and matrices, as well. You can save workbook or matrix book settings, such as the number of columns and sheets, column plot designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or dimension and coordinate settings, to .otw (workbook template) or .otm (matrix template) files.

Another important Origin template concept is the Analysis Template™. Save data operations -- even complex operations such as curve fitting with resulting custom report sheets -- to an analysis template (.ogw or .opj) for repeat analysis with similar data. Analysis templates are explained in more detail in the Batch Analysis section of How to Handle Repetitive Tasks chapter of this guide.

20.6.2 Themes

An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis dialog can be saved as a Theme.

A Graph Theme could be as simple as an axis tick mark direction setting, or as extensive as a collection of multiple graph object properties.

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take the object properties of one graph and apply them to all the other graphs in the same project.
Right click on plot, layer, object, etc. in graph or right click with nothing selected in graph and choose **Copy Format** context menu to copy format. Depending where you right click, the corresponding selection's format can be copied. Then right-click on corresponding selection or right click in target graph and click **Paste Format** to apply the copied settings to the target selection or graph. You can also choose **Edit: Paste Format...** to paste the Format to multiple target graphs.

The **Theme Organizer** dialog box is available from the **Tools** menu. Use this dialog to organize graph, worksheet, and dialog themes.

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple graph themes in the Theme Organizer dialog, hold down **Ctrl** while selecting the Themes, and then right-click to access the **Combine** context menu. The context menu in the tool provides an option to edit a Theme, allowing the user to add/delete properties to an existing theme. Set a theme as system theme will apply it to future newly created graphs automatically if the graph template allows system theme to override.
The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk as a named Theme file. You can save multiple Theme files for a given dialog box and then recall them from the dialog, as needed. Saving multiple Themes for a dialog box allows you to customize your analysis routines from different experiments, when each requires using a specific (and unique) group of settings.
Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.

20.7 Topics for Further Reading

- The 3D openGL Settings Dialog Box
- Creating Custom Menus
- The Custom Menu Organizer
- Analysis Themes
- How to Manage Multiple Menu Configuration (.OMC) Files
- Managing Collapsible Menus
- The User Files Folder
21 Sharing Origin Files

You may want to customize some aspect of your Origin installation and then share your customizations with other Origin users. Custom settings can be saved in many file types including graph templates (.otp) and themes (.oth), analysis templates (.ogw or .opj), dialog themes, curve fitting functions, import wizard filters, LabTalk script files (.ogs), and X-Functions.

21.1 Drag and Drop Sharing

A quick and easy way to share a file with another user is simply to send it as an email attachment. The recipient can then drag and drop the file into the Origin workspace.

Drag-and-drop is supported for most Origin file types. Origin project (.opj) and graph template (.otp) files automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a dialog opens asking which fitting function category to which you wish to add the new fitting function.
21.2 Sharing Files on Multiple Machines for Single Users

If you are a single user and have installed Origin on multiple machines, you can share your custom settings across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, or even a USB flash drive, and use the same UFF path with each installation.

**Note:** For information on changing the UFF path, see:

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The User Files Folder

21.3 Sharing Files with Other Users in a Network

You can set up and use a group folder to share files among users. Multiple groups are allowed, and each group can have some power user(s) set as the group leader. The group leader can use the **Group Folder Manager** tool to publish custom files for sharing with other group members. When group member launches Origin, the published files will be copied to their Origin automatically and ready to use.

**Note:** For information on group folders, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with Multiple Clients > **Group Folder Manager**

21.4 Packaging Files

Origin provides a **Package Manager** tool for packing multiple files into a single Origin Package (.opx) file. This is a convenient way to distribute custom applications that may contain multiple Origin files, such as templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk scripts before and after installation.

To access the Package Manager, click **Tools**, and then click **Package Manager**...

To install an .opx file, simply drag and drop into the Origin workspace.

**Note:** For information on packaging files, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > **Packaging Multiple Files as OPX**
21.5 The Origin Viewer

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of information contained in Origin Project (OPJ) files and Origin window (OGG, OGW, OGM) files on computers that do not have Origin installed.

- The Origin Viewer is distributed as a single EXE file - no installation needed.
- Project Explorer-like folder view with graph previews on hover, icon or details windows views, X-large icon view option.
- Open a graph in a pop-up window for better viewing.
- Supports for viewing and rotating Origin’s OpenGL 3D graphs.
- Available in 32- and 64-bit versions.

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin, you might direct them to the Origin Viewer page (http://originlab.com/viewer/) where they can find out more and download the EXE.

21.6 Topics for Further Reading

- The User Files Folder
- Attaching Files to the Origin Project
- Package Manager
- Setting Up a Group Folder
- Exporting Custom Button Groups
- Exporting Toolbar Settings
# 22 Origin Toolbars

Presented below is a list of all toolbars and buttons in Origin. Certain toolbar buttons (or entire toolbars) will be inactive (grayed out) if the object they act on is not present in the Origin Project. For instance, the 3D-Rotation Toolbar is only available when a 3D graph is active.

## 22.1 Standard

![Standard Toolbar]

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![folder]</td>
<td>New Project</td>
<td></td>
<td>![folder]</td>
<td>New Folder</td>
<td></td>
</tr>
<tr>
<td>![folder]</td>
<td>New Workbook</td>
<td></td>
<td>![folder]</td>
<td>New Graph</td>
<td></td>
</tr>
<tr>
<td>![folder]</td>
<td>New Matrix</td>
<td></td>
<td>![folder]</td>
<td>New 2D (Function) Plot</td>
<td></td>
</tr>
<tr>
<td>![folder]</td>
<td>New Layout</td>
<td></td>
<td>![folder]</td>
<td>New Notes</td>
<td></td>
</tr>
<tr>
<td>![folder]</td>
<td>Digitize Image</td>
<td></td>
<td>![folder]</td>
<td>Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>![folder]</td>
<td>Open Template</td>
<td></td>
<td>![folder]</td>
<td>Save Project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>![folder]</td>
<td>Save Template</td>
<td></td>
<td>![folder]</td>
<td>Import Wizard</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>![folder]</td>
<td>Import Single ASCII</td>
<td>Ctrl+K</td>
<td>![folder]</td>
<td>Import Multiple ASCII</td>
<td></td>
</tr>
<tr>
<td>![folder]</td>
<td>Import Excel</td>
<td>Ctrl+E</td>
<td>![folder]</td>
<td>Batch Processing</td>
<td></td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Hotkey</td>
<td>Button</td>
<td>Description</td>
<td>Hotkey</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>Recalculate Auto</td>
<td></td>
<td></td>
<td>Recalculate Manual</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom In and Out by Percentage</td>
<td></td>
<td></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slide Show of Graphs</td>
<td></td>
<td></td>
<td>Send Graphs to PowerPoint</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open Video Builder</td>
<td></td>
<td></td>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td></td>
<td>Duplicate</td>
<td></td>
<td></td>
<td>Duplicate with New Sheet/Book</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom Routine</td>
<td></td>
<td></td>
<td>Project Explorer</td>
<td>Alt + 1</td>
</tr>
<tr>
<td></td>
<td>Object Manager</td>
<td>Alt + 8</td>
<td></td>
<td>Results Log</td>
<td>Alt + 2</td>
</tr>
<tr>
<td></td>
<td>Command Window</td>
<td>Alt + 3</td>
<td></td>
<td>Code Builder</td>
<td>Alt + 4</td>
</tr>
<tr>
<td></td>
<td>Add New Columns</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 22.2 Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cut</td>
<td>Ctrl+X</td>
<td></td>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Ctrl+V</td>
<td></td>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
</tbody>
</table>
### 22.3 Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Enable/Disable Anti-Aliasing" /></td>
<td>Enable/Disable Anti-Aliasing</td>
<td></td>
<td><img src="image" alt="Rescale" /></td>
<td>Rescale</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td><img src="image" alt="Exchange the X and Y axes" /></td>
<td>Exchange the X and Y axes</td>
<td></td>
<td><img src="image" alt="Enable/Disable Speed Mode" /></td>
<td>Enable/Disable Speed Mode</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Extract to Layers" /></td>
<td>Extract to Layers</td>
<td></td>
<td><img src="image" alt="Extract to Graphs" /></td>
<td>Extract to Graphs</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Merge" /></td>
<td>Merge</td>
<td></td>
<td><img src="image" alt="Duplicate with New Sheet/Book" /></td>
<td>Duplicate with New Sheet/Book</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Add Bottom-X Left-Y Layer" /></td>
<td>Add Bottom-X Left-Y Layer</td>
<td></td>
<td><img src="image" alt="Add Top-X Layer" /></td>
<td>Add Top-X Layer</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Add Right-Y Layer" /></td>
<td>Add Right-Y Layer</td>
<td></td>
<td><img src="image" alt="Add Top-X Right-Y Layer" /></td>
<td>Add Top-X Right-Y Layer</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Add Inset Graph" /></td>
<td>Add Inset Graph</td>
<td></td>
<td><img src="image" alt="Add Inset Graph With Data" /></td>
<td>Add Inset Graph With Data</td>
<td></td>
</tr>
</tbody>
</table>

### 22.4 2D Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Line" /></td>
<td>Line</td>
<td><img src="image" alt="Horizontal Step" /></td>
<td>Horizontal Step</td>
</tr>
<tr>
<td><img src="image" alt="Vertical Step" /></td>
<td>Vertical Step</td>
<td><img src="image" alt="Spline Connected" /></td>
<td>Spline Connected</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------</td>
<td>--------</td>
<td>----------------------</td>
</tr>
<tr>
<td><img src="image1" alt="Scatter" /></td>
<td>Scatter</td>
<td><img src="image2" alt="Scatter Central" /></td>
<td>Scatter Central</td>
</tr>
<tr>
<td><img src="image3" alt="Column Scatter" /></td>
<td>Column Scatter</td>
<td><img src="image4" alt="Y Error" /></td>
<td>Y Error</td>
</tr>
<tr>
<td><img src="image5" alt="X Y Error" /></td>
<td>X Y Error</td>
<td><img src="image6" alt="Vertical Drop Line" /></td>
<td>Vertical Drop Line</td>
</tr>
<tr>
<td><img src="image7" alt="Bubble" /></td>
<td>Bubble</td>
<td><img src="image8" alt="Color Mapped" /></td>
<td>Color Mapped</td>
</tr>
<tr>
<td><img src="image9" alt="Bubble + Color Mapped" /></td>
<td>Bubble + Color Mapped</td>
<td><img src="image10" alt="Line + Symbol" /></td>
<td>Line + Symbol</td>
</tr>
<tr>
<td><img src="image11" alt="Line Series" /></td>
<td>Line Series</td>
<td><img src="image12" alt="2 Point Segment" /></td>
<td>2 Point Segment</td>
</tr>
<tr>
<td><img src="image13" alt="3 Point Segment" /></td>
<td>3 Point Segment</td>
<td><img src="image14" alt="Column" /></td>
<td>Column</td>
</tr>
<tr>
<td><img src="image15" alt="Column + Label" /></td>
<td>Column + Label</td>
<td><img src="image16" alt="Grouped Column-Indexed Data" /></td>
<td>Grouped Column-Indexed Data</td>
</tr>
<tr>
<td><img src="image17" alt="Bar" /></td>
<td>Bar</td>
<td><img src="image18" alt="Stacked Column" /></td>
<td>Stacked Column</td>
</tr>
<tr>
<td><img src="image19" alt="Stacked Bar" /></td>
<td>Stacked Bar</td>
<td><img src="image20" alt="100% Stacked Column" /></td>
<td>100% Stacked Column</td>
</tr>
<tr>
<td><img src="image21" alt="100% Stacked Bar" /></td>
<td>100% Stacked Bar</td>
<td><img src="image22" alt="Floating Column" /></td>
<td>Floating Column</td>
</tr>
<tr>
<td><img src="image23" alt="Floating Bar" /></td>
<td>Floating Bar</td>
<td><img src="image24" alt="3D Color Pie Chart" /></td>
<td>3D Color Pie Chart</td>
</tr>
<tr>
<td><img src="image25" alt="2D B&amp;W Pie Chart" /></td>
<td>2D B&amp;W Pie Chart</td>
<td><img src="image26" alt="Double Y Axis" /></td>
<td>Double Y Axis</td>
</tr>
<tr>
<td><img src="image27" alt="3Ys Y-YY" /></td>
<td>3Ys Y-YY</td>
<td><img src="image28" alt="3Ys Y-Y-Y" /></td>
<td>3Ys Y-Y-Y</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------</td>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>4Ys Y-YYY</td>
<td><img src="image2.png" alt="Image" /></td>
<td>4Ys YY-YY</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Multiple Y Axes</td>
<td><img src="image4.png" alt="Image" /></td>
<td>Stacked Lines By Y Offsets</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Waterfall</td>
<td><img src="image6.png" alt="Image" /></td>
<td>Waterfall Y: Color Mapping</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>Waterfall Z: Color Mapping</td>
<td><img src="image8.png" alt="Image" /></td>
<td>3D Waterfall</td>
</tr>
<tr>
<td><img src="image9.png" alt="Image" /></td>
<td>3D Waterfall Y: Color Mapping</td>
<td><img src="image10.png" alt="Image" /></td>
<td>3D Waterfall Z: Color Mapping</td>
</tr>
<tr>
<td><img src="image11.png" alt="Image" /></td>
<td>Vertical 2 Panel</td>
<td><img src="image12.png" alt="Image" /></td>
<td>Horizontal 2 Panel</td>
</tr>
<tr>
<td><img src="image13.png" alt="Image" /></td>
<td>4 Panel</td>
<td><img src="image14.png" alt="Image" /></td>
<td>9 Panel</td>
</tr>
<tr>
<td><img src="image15.png" alt="Image" /></td>
<td>Stack</td>
<td><img src="image16.png" alt="Image" /></td>
<td>Multiple Panels by Label</td>
</tr>
<tr>
<td><img src="image17.png" alt="Image" /></td>
<td>Box Chart</td>
<td><img src="image18.png" alt="Image" /></td>
<td>Grouped Box Charts-Indexed Data</td>
</tr>
<tr>
<td><img src="image19.png" alt="Image" /></td>
<td>Grouped Box Charts-Raw Data</td>
<td><img src="image20.png" alt="Image" /></td>
<td>Interval Plot</td>
</tr>
<tr>
<td><img src="image21.png" alt="Image" /></td>
<td>Histogram</td>
<td><img src="image22.png" alt="Image" /></td>
<td>Histogram + Probabilities</td>
</tr>
<tr>
<td><img src="image23.png" alt="Image" /></td>
<td>Stacked Histograms</td>
<td><img src="image24.png" alt="Image" /></td>
<td>Marginal Histograms</td>
</tr>
<tr>
<td><img src="image25.png" alt="Image" /></td>
<td>Marginal Boxes</td>
<td><img src="image26.png" alt="Image" /></td>
<td>2D Kernel Density</td>
</tr>
<tr>
<td><img src="image27.png" alt="Image" /></td>
<td>QC(X-bar R) Chart</td>
<td><img src="image28.png" alt="Image" /></td>
<td>Pareto Chart-Binned Data</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------</td>
<td>--------</td>
<td>-------------------</td>
</tr>
<tr>
<td><img src="image" alt="Pareto Chart" /></td>
<td>Pareto Chart-Raw Data</td>
<td><img src="image" alt="Scatter Matrix" /></td>
<td>Scatter Matrix</td>
</tr>
<tr>
<td><img src="image" alt="Probability Plot" /></td>
<td>Probability Plot</td>
<td><img src="image" alt="Q-Q Plot" /></td>
<td>Q-Q Plot</td>
</tr>
<tr>
<td><img src="image" alt="Area" /></td>
<td>Area</td>
<td><img src="image" alt="Stack Area" /></td>
<td>Stack Area</td>
</tr>
<tr>
<td><img src="image" alt="Fill Area" /></td>
<td>Fill Area</td>
<td><img src="image" alt="Zoom" /></td>
<td>Zoom</td>
</tr>
<tr>
<td><img src="image" alt="Polar theta(X) r(Y)" /></td>
<td>Polar theta(X) r(Y)</td>
<td><img src="image" alt="Polar r(X) theta(Y)" /></td>
<td>Polar r(X) theta(Y)</td>
</tr>
<tr>
<td><img src="image" alt="Wind Rose-Binned Data" /></td>
<td>Wind Rose-Binned Data</td>
<td><img src="image" alt="Wind Rose-Raw Data" /></td>
<td>Wind Rose-Raw Data</td>
</tr>
<tr>
<td><img src="image" alt="Ternary" /></td>
<td>Ternary</td>
<td><img src="image" alt="Piper" /></td>
<td>Piper</td>
</tr>
<tr>
<td><img src="image" alt="Smith Chart" /></td>
<td>Smith Chart</td>
<td><img src="image" alt="Radar" /></td>
<td>Radar</td>
</tr>
<tr>
<td><img src="image" alt="Vector XYAM" /></td>
<td>Vector XYAM</td>
<td><img src="image" alt="Vector XYXY" /></td>
<td>Vector XYXY</td>
</tr>
<tr>
<td><img src="image" alt="High-Low-Close" /></td>
<td>High-Low-Close</td>
<td><img src="image" alt="Japanese Candlestick" /></td>
<td>Japanese Candlestick</td>
</tr>
<tr>
<td><img src="image" alt="OHLC Bar Chart" /></td>
<td>OHLC Bar Chart</td>
<td><img src="image" alt="OHLC-Volume" /></td>
<td>OHLC-Volume</td>
</tr>
<tr>
<td><img src="image" alt="Line (Stock)" /></td>
<td>Line (Stock)</td>
<td><img src="image" alt="Template Library" /></td>
<td>Template Library</td>
</tr>
</tbody>
</table>
## 22.5 Add Object to Graph

### Add Object to Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌡️</td>
<td>Add Color Scale</td>
<td></td>
<td>📋</td>
<td>Reconstruct Legend</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>⭐️</td>
<td>Add Asterisk Bracket</td>
<td></td>
<td>📊</td>
<td>Add XY Scale</td>
<td></td>
</tr>
<tr>
<td>⌚️</td>
<td>Date &amp; Time</td>
<td></td>
<td>📈</td>
<td>Project Path</td>
<td></td>
</tr>
<tr>
<td>📊</td>
<td>New Link Table</td>
<td></td>
<td>📊</td>
<td>Add Bubble Scale</td>
<td></td>
</tr>
</tbody>
</table>

## 22.6 3D and Contour Graph

### 3D and Contour Graphs

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌡️</td>
<td>3D Scatter Plot</td>
<td>🌡️</td>
<td>3D Trajectory</td>
</tr>
<tr>
<td>🌡️</td>
<td>3D Scatter + Error Bar</td>
<td>🌡️</td>
<td>3D Vector XYZ XYZ</td>
</tr>
<tr>
<td>🌡️</td>
<td>3D Vector XYZ dXdYdZ</td>
<td>🌡️</td>
<td>3D Bars</td>
</tr>
<tr>
<td>🌡️</td>
<td>XYY 3D Bars</td>
<td>🌡️</td>
<td>3D Ribbons</td>
</tr>
<tr>
<td>🌡️</td>
<td>3D Walls</td>
<td>🌡️</td>
<td>3D Waterfall</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------------------</td>
<td>--------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>3D Waterfall Y: Color Mapping</td>
<td></td>
<td>3D Waterfall Z: Color Mapping</td>
</tr>
<tr>
<td></td>
<td>3D Color Fill Surface</td>
<td></td>
<td>Multiple Color Fill Surfaces</td>
</tr>
<tr>
<td></td>
<td>3D X Constant with Base</td>
<td></td>
<td>3D Y Constant with Base</td>
</tr>
<tr>
<td></td>
<td>3D Colormap Surface</td>
<td></td>
<td>Multiple Colormap Surfaces</td>
</tr>
<tr>
<td></td>
<td>3D Color Fill Surface with Error Bar</td>
<td></td>
<td>3D Colormap Surface with Error Bar</td>
</tr>
<tr>
<td></td>
<td>3D Wire Frame</td>
<td></td>
<td>3D Wire Surface</td>
</tr>
<tr>
<td></td>
<td>3D Colormap Surface with Projection</td>
<td></td>
<td>3D Ternary Colormap Surface</td>
</tr>
<tr>
<td></td>
<td>Contour - Color fill</td>
<td></td>
<td>Contour - B/W Lines + Labels</td>
</tr>
<tr>
<td></td>
<td>Gray Scale Map</td>
<td></td>
<td>Contour Profiles</td>
</tr>
<tr>
<td></td>
<td>Polar Contour theta(X) r(Y)</td>
<td></td>
<td>Polar Contour r(X) theta(Y)</td>
</tr>
<tr>
<td></td>
<td>Ternary Contour</td>
<td></td>
<td>Image Plot</td>
</tr>
<tr>
<td></td>
<td>Image Profiles</td>
<td></td>
<td>Heat Map</td>
</tr>
</tbody>
</table>
22.7 3D Rotation

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![button]</td>
<td>Rotate counterclockwise</td>
<td>![button]</td>
<td>Rotate clockwise</td>
</tr>
<tr>
<td>![button]</td>
<td>Tilt left</td>
<td>![button]</td>
<td>Tilt right</td>
</tr>
<tr>
<td>![button]</td>
<td>Tilt down</td>
<td>![button]</td>
<td>Tilt up</td>
</tr>
<tr>
<td>![button]</td>
<td>Increase perspective</td>
<td>![button]</td>
<td>Decrease perspective</td>
</tr>
<tr>
<td>![button]</td>
<td>Fit frame to layer</td>
<td>![button]</td>
<td>Reset Rotation</td>
</tr>
<tr>
<td>![button]</td>
<td>Reset</td>
<td>![button]</td>
<td>Rotate on any direction</td>
</tr>
<tr>
<td>![button]</td>
<td>Rotation Angle</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

22.8 Worksheet Data

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![button]</td>
<td>Statistics on Column(s)</td>
<td></td>
<td>![button]</td>
<td>Statistics on Row(s)</td>
<td></td>
</tr>
<tr>
<td>![button]</td>
<td>Sort</td>
<td></td>
<td>![button]</td>
<td>Set Column Values</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 22.9 Column

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![X]</td>
<td>Set as X</td>
<td></td>
<td>![Y]</td>
<td>Set as Y</td>
</tr>
<tr>
<td>![Z]</td>
<td>Set as Z</td>
<td></td>
<td>![!]</td>
<td>Set as Y Error Bars</td>
</tr>
<tr>
<td>![abc]</td>
<td>Set as Labels</td>
<td></td>
<td>![G]</td>
<td>Set as Grouping</td>
</tr>
<tr>
<td>![G]</td>
<td>Set as Grouping</td>
<td></td>
<td>![S]</td>
<td>Set as Subject</td>
</tr>
<tr>
<td>![←]</td>
<td>Move to First</td>
<td></td>
<td>![→]</td>
<td>Move Right</td>
</tr>
<tr>
<td>![→]</td>
<td>Move Right</td>
<td></td>
<td>![↑↓]</td>
<td>Move to Last</td>
</tr>
<tr>
<td>![↑↓]</td>
<td>Swap Columns</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Additional Features**

- Uniform random numbers
- Normal random numbers
- Add/Remove Data Filter
- Enable/Disable Data Filter
- Reapply Data Filter

**Origins User Guide**

- Set All Column Values
- Ctrl+F5

**Row number**

- Normal random numbers
- Add/Remove Data Filter
- Enable/Disable Data Filter
- Reapply Data Filter
### 22.10 Layout

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Add Graph" /></td>
<td>Add Graph</td>
<td><img src="image2" alt="Add Worksheet" /></td>
<td>Add Worksheet</td>
</tr>
</tbody>
</table>

### 22.11 Mask

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Mask Range" /></td>
<td>Mask Range</td>
<td><img src="image4" alt="Unmask Range" /></td>
<td>Unmask Range</td>
</tr>
<tr>
<td><img src="image5" alt="Change mask color" /></td>
<td>Change mask color</td>
<td><img src="image6" alt="Hide/Show masked points" /></td>
<td>Hide/Show masked points</td>
</tr>
<tr>
<td><img src="image7" alt="Swap mask" /></td>
<td>Swap mask</td>
<td><img src="image8" alt="Disable/Enable masking" /></td>
<td>Disable/Enable masking</td>
</tr>
</tbody>
</table>

### 22.12 Tools

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image9" alt="Pointer" /></td>
<td>Pointer</td>
<td></td>
<td><img src="image10" alt="Scale In" /></td>
<td>Scale In</td>
<td></td>
</tr>
<tr>
<td><img src="image11" alt="Scale Out" /></td>
<td>Scale Out</td>
<td></td>
<td><img src="image12" alt="Screen Reader" /></td>
<td>Screen Reader</td>
<td></td>
</tr>
</tbody>
</table>

Origin Toolbars
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Reader" /></td>
<td>Reader</td>
<td></td>
<td><img src="image" alt="Annotation" /></td>
<td>Annotation</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Data Cursor" /></td>
<td>Data Cursor</td>
<td></td>
<td><img src="image" alt="Data Selector" /></td>
<td>Data Selector</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Selection on Active Plot" /></td>
<td>Selection on Active Plot</td>
<td></td>
<td><img src="image" alt="Selection on All Plots" /></td>
<td>Selection on All Plots</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Mask Points on Active Plot" /></td>
<td>Mask Points on Active Plot</td>
<td></td>
<td><img src="image" alt="Mask Points on All Plots" /></td>
<td>Mask Points on All Plots</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Unmask Points on Active Plot" /></td>
<td>Unmask Points on Active Plot</td>
<td></td>
<td><img src="image" alt="Unmask Points on All Plots" /></td>
<td>Unmask Points on All Plots</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Draw Data" /></td>
<td>Draw Data</td>
<td><img src="image" alt="T" /></td>
<td><img src="image" alt="Text Tool" /></td>
<td>Text Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Arrow Tool" /></td>
<td>Arrow Tool</td>
<td><img src="image" alt="Curved Arrow Tool" /></td>
<td><img src="image" alt="Polyline Tool" /></td>
<td>Arrow Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Line Tool" /></td>
<td>Line Tool</td>
<td><img src="image" alt="Rectangle Tool" /></td>
<td><img src="image" alt="Region Tool" /></td>
<td>Line Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Freehand Draw Tool" /></td>
<td>Freehand Draw Tool</td>
<td><img src="image" alt="Rectangle Tool" /></td>
<td><img src="image" alt="Region Tool" /></td>
<td>Freehand Draw Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Circle Tool" /></td>
<td>Circle Tool</td>
<td><img src="image" alt="Polygon Tool" /></td>
<td><img src="image" alt="Zoom-Panning Tool" /></td>
<td>Circle Tool</td>
<td>Hold &quot;A&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Region Tool" /></td>
<td>Region Tool</td>
<td><img src="image" alt="Zoom-Panning Tool" /></td>
<td>Hold &quot;A&quot;</td>
<td>Region Tool</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Insert Equation" /></td>
<td>Insert Equation</td>
<td><img src="image" alt="Insert Word Object" /></td>
<td><img src="image" alt="Insert Word Object" /></td>
<td>Insert Equation</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Insert Excel Object" /></td>
<td>Insert Excel Object</td>
<td><img src="image" alt="Insert Object" /></td>
<td><img src="image" alt="Insert Object" /></td>
<td>Insert Excel Object</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Rescale Tool" /></td>
<td>Rescale Tool</td>
<td><img src="image" alt="Rotate Tool" /></td>
<td><img src="image" alt="Rotate Tool" /></td>
<td>Rescale Tool</td>
<td>Hold &quot;R&quot;</td>
</tr>
</tbody>
</table>
### 22.13 Object Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert Graph" /></td>
<td>Insert Graph</td>
<td></td>
<td><img src="image" alt="Insert Worksheet" /></td>
<td>Insert Worksheet</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Object Edit" /></td>
<td><strong>22.13 Object Edit</strong></td>
<td><img src="image" alt="Object Edit" /></td>
<td></td>
<td><img src="image" alt="Object Edit" /></td>
<td><img src="image" alt="Object Edit" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Left" /></td>
<td>Left</td>
<td><img src="image" alt="Right" /></td>
<td>Right</td>
</tr>
<tr>
<td><img src="image" alt="Top" /></td>
<td>Top</td>
<td><img src="image" alt="Bottom" /></td>
<td>Bottom</td>
</tr>
<tr>
<td><img src="image" alt="Vertical" /></td>
<td>Vertical</td>
<td><img src="image" alt="Horizontal" /></td>
<td>Horizontal</td>
</tr>
<tr>
<td><img src="image" alt="Uniform Width" /></td>
<td>Uniform Width</td>
<td><img src="image" alt="Uniform Height" /></td>
<td>Uniform Height</td>
</tr>
<tr>
<td><img src="image" alt="Front" /></td>
<td>Front</td>
<td><img src="image" alt="Back" /></td>
<td>Back</td>
</tr>
<tr>
<td><img src="image" alt="Front(data)" /></td>
<td>Front(data)</td>
<td><img src="image" alt="Back(data)" /></td>
<td>Back(data)</td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Group</td>
<td><img src="image" alt="Ungroup" /></td>
<td>Ungroup</td>
</tr>
</tbody>
</table>
22.14  Arrow

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Horizontal Alignment</td>
<td>![Icon]</td>
<td>Vertical Alignment</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Widen Head</td>
<td>![Icon]</td>
<td>Narrow Head</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Lengthen Head</td>
<td>![Icon]</td>
<td>Shorten Head</td>
</tr>
</tbody>
</table>

22.15  Style

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Fill Color</td>
<td></td>
<td>![Icon]</td>
<td>Line/Border Color</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>Lighting Control Dialog</td>
<td></td>
<td>![Icon]</td>
<td>Palette</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>Line/Border Style</td>
<td>0.5</td>
<td>![Icon]</td>
<td>Line/Border Width</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>Fill Pattern</td>
<td></td>
<td>![Icon]</td>
<td>Fill Pattern Width</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>Pattern Color</td>
<td></td>
<td>![Icon]</td>
<td>Clear Borders</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>Left Border</td>
<td></td>
<td>![Icon]</td>
<td>Top Border</td>
<td></td>
</tr>
</tbody>
</table>
### 22.16 Format

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Font" /></td>
<td>Default: Arial</td>
<td><img src="image" alt="Font size" /></td>
<td><img src="image" alt="Bold" /></td>
<td>Bold</td>
<td>Ctrl+&quot;B&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td></td>
<td><img src="image" alt="Italic" /></td>
<td></td>
<td>Italic</td>
<td>Ctrl+&quot;I&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Underline" /></td>
<td>Underline</td>
<td>Ctrl+&quot;U&quot;</td>
<td><img src="image" alt="Superscript" /></td>
<td>Superscript</td>
<td>Ctrl+&quot;+&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Subscript" /></td>
<td>Subscript</td>
<td>Ctrl+&quot;=&quot;</td>
<td><img src="image" alt="SuperSubscript" /></td>
<td>SuperSubscript</td>
<td>Ctrl+&quot;.&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Increase Font" /></td>
<td>Increase Font</td>
<td>Ctrl+&quot;&gt;&quot;</td>
<td><img src="image" alt="Decrease Font" /></td>
<td>Decrease Font</td>
<td>Ctrl+&quot;&lt;&quot;</td>
</tr>
<tr>
<td><img src="image" alt="Greek" /></td>
<td>Greek</td>
<td>Ctrl+&quot;G&quot;</td>
<td><img src="image" alt="Left" /></td>
<td>Left</td>
<td></td>
</tr>
</tbody>
</table>
### 22.17 Auto Update

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Center Horizontal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Top</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Center Vertical</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Font Color</td>
<td></td>
</tr>
</tbody>
</table>

#### Block Auto Update

- **Block Auto Update**

### 22.18 Database Access

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open SQL Editor</td>
<td></td>
<td>Open Query Builder</td>
</tr>
<tr>
<td></td>
<td>Load ODQ File</td>
<td></td>
<td>Preview Import</td>
</tr>
<tr>
<td></td>
<td>Import data</td>
<td></td>
<td>Remove SQL</td>
</tr>
</tbody>
</table>
## 22.19 Markers & Locks

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
<th>Button</th>
<th>Description</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Add Data Markers" /></td>
<td>Add Data Markers</td>
<td>Ctrl+Alt+M</td>
<td><img src="image2.png" alt="Clear Data Markers" /></td>
<td>Clear Data Markers</td>
<td>Ctrl+Alt+N</td>
</tr>
<tr>
<td><img src="image3.png" alt="Marker Size" /></td>
<td>Marker Size</td>
<td></td>
<td><img src="image4.png" alt="Marker Hide Show" /></td>
<td>Marker Hide Show</td>
<td></td>
</tr>
<tr>
<td><img src="image5.png" alt="Lock Positions" /></td>
<td>Lock Positions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Index

2  
2D Integration ........................................... 153  
3  
32- and 64-bit ............................................. 4  
3D Graphing, Hardware Compatibility .......... 219  
3D Surface Fitting ....................................... 13  
A  
AB? ............................................................... 43  
ABF .................................................................... 43  
Active Dataset .............................................. 162  
Active Layer ................................................... 90  
Add Plot to Layer ........................................... 97  
Analysis Markers .......................................... 167  
Analysis Reports ........................................... 199  
Analysis Templates ....................................... 57, 199  
Analysis Themes ........................................... 223  
Animating Graphs .......................................... 208  
Annotation Tool ............................................. 145  
ANOVA ............................................................ 186  
Apps Gallery .................................................. 25  
ASCII Data ...................................................... 38  
ASCII Data, Import to Graph ......................... 99  
Auto Recalculate ............................................ 191  
Automating Origin ......................................... 191, 203  
Axis Dialog Box ............................................. 116, 120  
B  
Batch Plotting .................................................. 195  
Batch Processing ............................................. 191  
BDF ................................................................. 43  
Binary 2D Array, Import ................................ 43  
Binary Data ..................................................... 40  
Buttons, Adding Programmable to Origin Windows ............................................. 221  
C  
CDF .................................................................... 43  
CGM .................................................................... 43  
Child Windows ............................................... 27  
Clipboard Data, Importing ......................... 41  
Code Builder .................................................... 31  
Collapsible Menus ......................................... 21  
Column Label Rows, Worksheet ............... 53  
Column Plot Designations ......................... 96  
Column Properties Dialog Box ................. 52  
Column Values, Setting .................................. 61  
Columns, Naming ........................................... 48  
Command Window ......................................... 29  
Concurrent Network ....................................... 3, 5  
Consulting ...................................................... 9  
Convolution ..................................................... 179  
Coordinate Values, Reading/Annotating ...... 153  
Coordinates, Reading/Labeling .................. 148  
Copy/Paste Graphs ......................................... 205  
CSV Files ......................................................... 40  
Curve Fit, Linear and Polynomial .............. 173  
Curve Fit, Nonlinear ...................................... 174  
Curve Fitting .................................................... 153  
Custom Menu Organizer ......................... 219  
Customizing Menus ....................................... 219  
Customizing Origin, Global Settings .......... 217  
Customizing Toolbars and Buttons ............ 220
Graphs, Customizing Data Points .................119
Graphs, Customizing Grouped Plots ............119
Graphs, Distance Between Two Points ..........146
Graphs, Embed in Worksheets ......................57
Graphs, Extract to Graphs .........................131
Graphs, Extract to Layers .........................131
Graphs, Function .....................................88
Graphs, Inset Equation .............................127
Graphs, Inset .........................................134
Graphs, Labeling a Data Point ....................127
Graphs, Layer Contents Dialog Box .............98
Graphs, Layer Customizations .....................116
Graphs, Legend Customization ....................116, 122
Graphs, Linking Axis Scales ......................132
Graphs, Listed by Type ............................105–4
Graphs, Merge .......................................116, 131
Graphs, Panning .....................................140
Graphs, Plot Details ................................115, 117
Graphs, Reading Coordinate Values ............142
Graphs, Reorder Layers ............................132
Graphs, Save Format as Theme ..................116, 117
Graphs, Saving Custom Templates ..............116
Graphs, Scaling Objects ............................129
Graphs, Send to PowerPoint ......................207
Graphs, Slide Show ................................208
Graphs, Speed Mode ................................102
Graphs, Template Library .........................116
Graphs, Templates ..................................135
Graphs, Theme Organizer .........................137
Graphs, Themes .....................................136, 223
Group Folder Manager ...............................228
Grouping Plots .....................................101

H
H5 ..........................................................43
HDF5 ......................................................42, 43
HE ..........................................................43
HEKA .....................................................43
Help Files, Quick Help .............................31
Help Files, Updating ...............................10
Hiding Worksheet Columns .......................65
Hints, Software ......................................30
HPF ..........................................................43
HYP ..........................................................43

I
IBW ..........................................................43
IgorPro ....................................................43
Image Processing ..................................15, 180
Image Profile .........................................153
Image, Import ..........................................43
Images, Matrix .......................................71
Import Wizard .........................................39
Importing, Filter Files (OIF) ......................35
imzML .....................................................43
Inset Graph ............................................134
Installing Origin ......................................3
Integration .............................................153
Interpolation .........................................153

J
JCAMP ......................................................42
JCAMP-DX .............................................43
JCM ..........................................................43
JDX ..........................................................43
JNB ..........................................................43

K
KaleidaGraph ..........................................43
Index

Naming Columns ...........................................48
Naming Matrix Books ....................................70
Naming Matrix Objects ....................................70
Naming Matrix Sheets ....................................70
Naming Workbooks .......................................48
Naming Worksheets .......................................48
National Instruments .....................................43
National Instruments™ LabVIEW™ .......................215
NC ..........................................................43
NetCDF .......................................................43
Networks, Concurrent ...................................5
Networks, Installation ..................................4, 5, 228
Networks, Multi-seat Node-locked ......................3
Networks, Sharing Files ..................................228
New Features ...............................................17
 NI DIAdem ..................................................43
 NI TDM ........................................................43
Non-parametric Statistics ................................186
Numbers in Origin .........................................32

O
Object Linking and Embedding (OLE) ..................205
Object Manager ............................................26, 91, 99
OGG Files ....................................................35
OGM Files ....................................................35
OGS Files ....................................................35
OIF Files ......................................................35
OpenGL .......................................................219, 229
Options Dialog Box .......................................217
OPX Files ....................................................228
Orglab .........................................................216
Origin C .......................................................214
Origin C, IDE ...............................................31
Origin Viewer ...............................................229
Origin Workspace ..........................................21
Origin, Display Language ................................6
Origin, License Deactivation .............................7
Origin, Licensing ..........................................3
Origin, New Features .....................................17
Origin, Registering .......................................5
Origin, Service Releases ................................6
Origin, Sharing Files .....................................227, 228
Origin, System Transfers ................................7
Origin, Uninstalling .....................................7
Origin, Upgrading .........................................3
OriginPro, Features .......................................13
Orthogonal Regression ....................................13
OTP Files .....................................................35
OTW Files ...................................................35, 54

P
Package Manager .........................................228
Packaging Origin Files ...................................228
Page, Graph ...............................................90
Panning Graphs ..........................................140
Parametric Function Plots, 2D and 3D ...............88
pClamp .......................................................42
pCLAMP ......................................................43
Peak Analysis ............................................14, 153, 176
Pivot Tables ...............................................65
Plot Designation .........................................52, 85, 96
Plot Details Dialog Box ................................91, 117
Plot Setup Dialog Box ..................................91, 92, 98, 102
Plots, Exchanging ........................................95
Plotting Virtual Matrix Data .............................86
Plotting Worksheet Data ................................86

PowerPoint ..................................................19
PowerPoint, Exporting to ................................207
Princeton Instruments ............................................43  SAV .................................................................43
Prism ...............................................................43  Screen Reader .....................................................142
Profiling Images ...................................................81  Scripting ............................................................212
Profiling Matrix Data .............................................81  Selecting Data, Graph ...........................................162
Programming Origin ............................................203, 212–11  Selecting Data, Worksheet ....................................159
Programming Origin, LabTalk .................................212  Set Column Values, Worksheet ...............................61
Programming Origin, X-Functions ............................214  Set Matrix Values ...............................................77
Project Explorer ..................................................22  Sharing Files with Multiple Users .............................228
PXP .................................................................43  Sharing Origin Files ..............................................227, 228
Python ..............................................................213  SIE .................................................................43
PZFX ...............................................................43  SigmaPlot ..........................................................43
Q ...........................................................................43  Sigmoidal Fit .......................................................153
QDA .................................................................43  Signal Processing ..................................................15
Query Builder ......................................................44  Signal Processing, Coherence .................................179
R ...........................................................................43  Signal Processing, Correlation .................................178
R213 ......................................................................43  Signal Processing, Decimation .................................179
R Language .........................................................20  Signal Processing, Envelope Curves .......................179
RAW .................................................................43  Signal Processing, Filtering ..................................178
REC .................................................................43  Signal Processing, Rise Time .................................179
Recalculate .........................................................191  Signal Processing, Smoothing ...............................178
Recalculation of Results .......................................191  Signal Processing, Transforms ..............................177
Region of Interest ...............................................71  Slide Show of Graphs ...........................................208
Region of Interest (ROI) ........................................148, 149, 153, 171, 172, 173, 174, 175, 176, 177, 178, 179, 180, 181
Regional Data Selector ..........................................163  Smooth .............................................................178
Re-Importing .......................................................45  Somat ...............................................................43
Repetitive Tasks, Filters for ....................................201  Sorting Worksheet Data .......................................65
Reports, Analysis ..................................................199  Sparklines ..........................................................54
Rescaling Graphs ..................................................140  SPC .................................................................42, 43
Results Log ........................................................32  SPE .................................................................43
Rise Time ............................................................153  SPE .................................................................43
ROC Curve .........................................................188  SPSS ...............................................................43
S ...........................................................................43
Sample Projects ..................................................10  SQL Data ............................................................44
Statistics .........................................................14, 148, 153  Statistics, Basic ..................................................181
Worksheets, Transposing Data..........................65
X
XML ..........................................................43

Z
Zooming Graphs .............................................140